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About this document

This document is a guide to defining, configuring and maintaining service 
data for a Passport node.

The following topics are discussed in this section:

• “Who should read this document and why” (page 15)

• “What you need to know” (page 15)

• “How this document is organized” (page 16)

• “What’s new in this document” (page 17)

• “Text conventions” (page 17)

• “Mouse function reference” (page 18)

• “Common dialogs” (page 19)

• “Using the keyboard and online help” (page 19)

• “Related documents” (page 21)

Who should read this document and why
This document is intended for persons responsible for defining, configuring, 
and maintaining service data for a Passport node. Persons who install and 
engineer the Passport network can also use this guide.

What you need to know
Before you read this document, you need to be familiar with how to log on to 
the Preside Multiservice Data Manager (MDM) workstation and how to work 
with the user interface. An understanding of the Passport network and service 
data ia also helpful.
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How this document is organized
This guide introduces the tools for Configuration for Passport Devices and 
how to start them. Subsequent sections provide information on using the 
various applications and tools. 

241-6001-023 Preside MDM Configuration Management for Passport User 
Guide contains the following sections:

• “Introducing Configuration for Passport Devices” (page 23) briefly 
describes the tools in the Passport Devices Configuration toolset.

• “Starting Configuration for Passport tools” (page 29) describes the steps 
involved in logging on to a Preside Multiservice Data Manager (MDM) 
workstation and accessing a particular application.

• “Software Download and Configuration” (page 37) describes how the 
Software Distribution and Configuration application is used to upgrade, 
configure, and download software to the Passport network.

• “Component Provisioning” (page 83) describes how the Component 
Provisioning application is used to define, edit, and display service data.

• “Network Activation” (page 157) describes how the Network Activation 
tool is used to automate the activation process.

• “Global Data Manager” (page 211) describes how the Passport Global 
Data Manager command line tool is used to propagate global service data 
from a Passport switch to other selected switches and to replace attribute 
values.

• “Using HP OpenView NNM desktop” (page 225) describes how you can 
access the Passport Devices confiugration tools from the HP OpenView 
NNM desktop application.

For information on the nodal and service provisioning tools, see the 
following:

• for the Nodal Provisioning tool, see 241-6001-610 Preside MDM Nodal 
Provisioning User Guide and 241-6001-611 Preside MDM Nodal and 
Service Provisioning Reference Guide

• for Service Provisioning - ATM, see 241-6001-600 Preside MDM 
Service Provisioning for ATM User Guide
241-6001-023   14.3RSUP   
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• for Service Provisioning - CES SVC, see 241-6001-602 Preside MDM 
Service Provisioning for CES SVC User Guide

• for Service Provisioning - Frame Relay, see 241-6001-603 Preside MDM 
Service Provisioning for Frame Relay User Guide

• for Service Provisioning - IP -VPN Global Update, see 241-6001-601 
Preside MDM Service Provisioning for IP VPN Global Update User 
Guide

For information on the Passport/SNMP Service Data Backup/Restore tool, 
see 241-6001-807 Preside MDM Passport/SNMP Devices Backup and 
Restore User Guide.

For information on the Inventory Reports tool, see 241-6001-808 Preside 
MDM Device Inventory Tools User Guide.

For information on the Network Reporting System, see 241-6001-022 
Preside MDM Network Reporting System User Guide.

What’s new in this document
There are no changes in this document for this release.

Text conventions
This document uses the following text conventions: 

• nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or 
text that appears on your screen.

• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.

• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.
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• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.

• <general_term>

Words in angle brackets represent variables which are to be replaced with 
specific values.

• UPPERCASE,lowercase

In Preside Multiservice Data Manager (MDM), uppercase and lowercase 
letters that appear in UNIX commands and parameters must be matched 
exactly. The system matches upper and lowercase characters differently.

• |

This symbol separates items from which you may select one; for 
example, ON|OFF indicates that you may specify ON or OFF. If you do 
not make a choice, a default ON is assumed.

• ...

Three dots in a command indicate that the parameter may be repeated 
more than once in succession.

The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /).

Mouse function reference
When we want you to press and release the mouse button, we refer to it as 
clicking. Depending on the action to be taken, the text will read “click select” 
or “click modify”.

When you access a menu, you need to press and hold the mouse menu button 
down. After you select the menu option, you can release the mouse button. 
The text will read “press menu”.
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The Select and menu mouse buttons also have window manipulation 
functions. See 241-6001-802 Preside MDM User Interface Primer.

Common dialogs
All Passport Devices configuration tools share dialogs that prompt you for 
action in the event of certain errors, questions, and warnings and in the 
processing of certain tasks.

Error dialog
There is an error. Click OK to close the dialog. 

Question dialog
You need to respond before you can proceed. Click Yes to perform the action 
requested. Click No to proceed without performing the action requested. 

Warning dialogs
You need to respond before you can proceed. Click OK to close the dialog. 

Processing dialogs
Click Stop to confirm that you want to stop the task in progress. 

Using the keyboard and online help
The following sections provide help on using the keyboard and the online 
help facilities in Configuration for Passport Devices.

Help on Keys
You can use the keyboard instead of the mouse to perform the default action 
in a dialog, to select a menu function, or to execute a command using a 
command shortcut. 

Performing the default action
Some dialogs have a default (live) action button distinguished from the other 
buttons by the extra box around it. You can perform the default action by 
pressing the Enter key anywhere in the dialog. 
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Selecting a menu function
You can use mnemonics to perform any of the functions available from the 
menu bar. Mnemonics are single characters that uniquely identify a menu 
item. The mnemonic for each menu item is identified by an underscore. 

You can use a mnemonic by pressing the F10 key and then entering the 
mnemonic string for the menu function you want to use. You can press the 
meta key and the mnemonic for the menu you want to access, followed by the 
mnemonic for the specific menu function. 

For example, to invoke the Authenticate (mnemonic A) function on the 
Options (mnemonic O) menu, use either of the following key sequences: 

• F10 O a 

• Meta-O A 

Using command shortcuts
The tool provides the following command shortcuts:

• CTRL-E to exit from the tool 

• Meta-H to display help information for the dialog, menu item, or button 
that the cursor is currently on. When you press Meta-H, the cursor 
changes to a question mark symbol. Move the cursor to the item for 
which you want help. Press the Select button to display help information 
for the item. 

Help on Help
One set of help information describes the anchor window. It gives a brief 
overview of the tool and has subsections that describe key parts of the main 
window. You can view it by pulling down the Help menu and selecting the On 
Window option. 

Help for each menu is also available from the last entry on each menu, 
appropriately labelled Help. 

One set of help information is available for each major dialog of the user 
interface. You can view the help information for a dialog by clicking the Help 
button for that dialog. 
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The Context Help button changes the mouse cursor into a question mark 
symbol. You then slide the cursor over the component for which you want to 
get help, and press the Select mouse button. 

Related documents
See the following documents for related information:

• 241-6001-011 Preside MDM Fault Management User Guide

• 241-6001-012 Preside MDM Configuration Management for DPN User 
Guide

• 241-6001-022 Preside MDM Network Reporting System User Guide

• 241-6001-304 Preside MDM Configuration Management for DPN 
Administrator Guide

• 241-6001-600 Preside MDM Service Provisioning for ATM User Guide

• 241-6001-601 Preside MDM Service Provisioning for IP VPN Global 
Update User Guide

• 241-6001-602 Preside MDM Service Provisioning for CES SVC User 
Guide

• 241-6001-603 Preside MDM Service Provisioning for Frame Relay User 
Guide

• 241-6001-610 Preside MDM Nodal Provisioning User Guide

• 241-6001-611 Preside MDM Nodal and Service Provisioning Reference 
Guide

• 241-6001-807 Preside MDM Passport/SNMP Devices Backup and 
Restore User Guide

• 241-6001-808 Preside MDM Device Inventory Tools User Guide

• 241-5701-270 Passport 7400, 15000, 20000 Software Installation Guide

• NN10600-605 Passport - MDM Network Security: Operations

• 241-5701-050 Passport 7400, 15000, 20000 Commands
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Chapter 1
Introducing Configuration for Passport 
Devices

This section gives a brief overview of Configuration for Passport Devices. In 
this chapter, you can find the following information:

• “Passport Devices configuration tools” (page 23) 

• “Date Convention” (page 28)

Passport Devices configuration tools
Configuration for Passport Devices is a set of tools used to manage Passport 
software and service data. It provides a human-readable presentation of 
Passport service data, which is stored in machine-readable format for 
maximum efficiency. It also provides a simplified logical presentation of 
operating parameters.

See the following for information on the Passport Devices configuration 
toolset submenu for managing Passport software and services.

• “Nodal Provisioning” (page 24)

• “Component Provisioning” (page 24) in

• “Service Provisioning” (page 24)

— “ATM” (page 25)

— “CES SVC” (page 25)

— “Frame Relay” (page 25)

— “IP VPN Global Update” (page 25)
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• “Administration” (page 25)

— “Passport/SNMP Service Data Backup/Restore” (page 26)

• “Software Download and Configuration” (page 26)

— “Network Activation” (page 26)

• “Inventory Reports” (page 26)

• “Network Reporting System” (page 26)

— See “Service Integrity Audit” (page 27)

— “Configuration Reports” (page 27)

— “Configuration Differences” (page 27)

See “Global Data Manager command line tool” (page 27) for information on 
a command line tool that is used with Configuration for Passsport Devices.

See “Connection Manager” (page 27) for information on a server process that 
is used with Configuration for Passport Devices.

Nodal Provisioning
You can use Nodal Provisioning to provision Passport components and 
selected services. For additional information, see 241-6001-610 Preside 
MDM Nodal Provisioning User Guide.

Component Provisioning
You can use Component Provisioning, a forms-based provisioning system, to 
define, edit, and display service data for a Passport node.

See “Component Provisioning” (page 83) for more information.

Service Provisioning
 Service Provisioning contains the following menu items:

• “ATM” (page 25)

• “CES SVC” (page 25)

• “Frame Relay” (page 25)

• “IP VPN Global Update” (page 25)
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ATM
ATM opens the ATM service provisioning application that allows you to 
provision ATM permanent virtual connections, soft permanent virtual 
connections, and selected Frame Relay to ATM connections (FRF.8 standard 
for service interworking (SIWF)). The tool populates the Administration 
Database with circuit data. For additional information, see 241-6001-600 
Preside MDM Service Provisioning for ATM User Guide.

CES SVC
CES SVC opens the CES SVC service provisioning application that allows 
you to provision circuit emulation service over ATM switched virtual circuit 
connections. For additional information, see 241-6001-602 Preside MDM 
Service Provisioning for CES SVC User Guide.

Frame Relay 
Frame Relay opens the Frame Relay service provisioning application that 
allows you to provision Frame Relay permanent virtual circuits between two 
Passport switches. TheAdministration Database is populated with circuit 
data.For additional information, see 241-6001-603 Preside MDM Service 
Provisioning for Frame Relay User Guide.

IP VPN Global Update
IP VPN Global Update opens the IP VPN Global Update service provisioning 
application which allows you to set up and perform global updating of a 
customer IP VPN, by using either a graphical user interface or a command 
line interface. For additional information, see 241-6001-601 Preside MDM 
Service Provisioning for IP VPN Global Update User Guide.

Administration
Administration contains the following items:

• “Passport/SNMP Service Data Backup/Restore” (page 26) 

• “Software Download and Configuration” (page 26)

• “Network Activation” (page 26)
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Passport/SNMP Service Data Backup/Restore
The Passport/SNMP Service Data Backup/Restore tool is a stand-alone tool 
for backing up and restoring the service data on selected devices. You can 
perform full, incremental, and selective backups and restores. See, 
241-6001-807 Preside MDM Passport/SNMP Devices Backup and Restore 
User Guide for additional information

Software Download and Configuration
You can use Software Download and Configuration to configure, download, 
and upgrade software in the Passport network.  You can obtain the software 
from a Software Distribution Site (SDS).

See “Software Download and Configuration” (page 37) for more 
information.

Network Activation
You can use Network Activation (NAT) to simplify and automate the 
activation process for multiple nodes in a network.  For Passport, you can 
activate and commit a View using NAT.

See  “Network Activation” (page 157) for more information.

Inventory Reports
The Inventory Reports item opens the Device Inventory tool. This tool lets 
you report on the hardware and software of selected devices in your network.

 See 241-6001-808 Preside MDM Device Inventory Tools User Guide for 
more information.

Network Reporting System
Network Reporting System contains the following items:

• “Service Integrity Audit” (page 27)

• “Configuration Reports” (page 27)

• “Configuration Differences” (page 27)
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Service Integrity Audit
You can use Service Integrity Audit to populate the Network Reporting 
System (NRS) database for DPN and/or Passport modules, and, optionally, to 
execute the NRS-based Service Integrity checks (NSICs), and to populate the 
Network Configuration Database (NCD).  With Service Integrity Audit you 
retrieve the Passport View Files directly from the modules.

See 241-6001-022 Preside MDM Network Reporting System User Guide for 
more information about the Service Integrity Audit tool. 

Configuration Reports
The Configuration Reports item opens the Configuration Report dialog that 
lets you produce simple configuration hierarchy reports.

See Configuration Report (xnrsdatah) in 241-6001-022 Preside MDM 
Network Reporting System User Guide for more details.

Configuration Differences
The Configuration Differences item opens the Configuration Differences 
dialog which lets you select two sets of configuration data and produce a 
report on the differences between the two configurations.

See Configuration Differences (xnrsdiff) in 241-6001-022 Preside MDM 
Network Reporting System User Guide for more details.

Connection Manager
You use the Connection Manager (CM) to manage your network connections.  
The CM Authentication dialog is displayed when you access any of the the 
tools for Passport Devices configuration.

See “The Connection Manager and authentication” (page 31) for more 
information.

Global Data Manager command line tool
You can use the Global Data Manager (pgdm), a command line tool,  to 
propagate global data components from a Passport switch to other selected 
Passports or to replace the attribute values for the components during 
propagation. In addition, you can use pgdm to replace the attribute values for 
selected Passports in the network.
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By allowing data to be copied and propagated, pgdm enables you to provision 
global data and to replace attribute values globally. Pgdm enables this more 
quickly than with Component Provisioning and with reduced risk of errors 
due to mistakes in keying in service data.

See “Global Data Manager” (page 211) for more information.

Date Convention
In this document you will often see dates in the format yymmdd. Such dates 
are used as parameters in certain line commands or appear in a dialog or as 
part of a file name.

To account for the year 2000 and beyond, Passport Devices configuration 
interprets 000101 as later than 991231. The base year has been chosen as 
1980. This means 800101 precedes 900101 which precedes 000101 which 
precedes 790101. In other words:

if (yy < 80)
   year = 2000 + yy
else
   year = 1900 + yy

This means:

80 => 1980
90 => 1990
99 => 1999
00 => 2000
10 => 2010
79 => 2079.
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Chapter 2
Starting Configuration for Passport tools

This section explains how you can access the Configuration Management 
tools for Passport devices.  In this chapter, you can find the following 
information:

• “Capability privileges” (page 29)

• “Opening a Configuration tool” (page 29)

• “Closing a Configuration tool” (page 30)

• “Starting the Configuration tools from a UNIX shell” (page 30)

• “The Connection Manager and authentication” (page 31)

• “Enabling log files” (page 35)

• “Using the keyboard” (page 35)

Capability privileges
To access Passport Devices Configuration tools, you need to have the correct 
capability privileges. 

For more information on capability privileges, refer to the chapter on security 
in NN10600-605 Passport - MDM Network Security: Operations.

Opening a Configuration tool
1 In the Preside MDM window, select Configuration -> Passport Devices 

The Passport Devices Configuration toolset submenu is displayed.

2 Select the tool you want to use.
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The tool’s main window is displayed. If the Authentication dialog is 
displayed over the main window, see “The Connection Manager and 
authentication” (page 31) for more details.

Closing a Configuration tool
1 From the File menu in the title bar of the tool window, choose Exit.

The tool’s main window closes.

Starting the Configuration tools from a UNIX shell 
You can access command line applications by using the command line syntax 
from a UNIX shell. 

Accessing UNIX
1 In the Preside MDM window, select System -> Utilities -> UNIX access.

The UNIX window is displayed.

2 Enter the command for the tool you want displayed.

For Software Download and Configuration the command is
/opt/MagellanNMS/bin/fsdui

For Component Provisioning the command is
/opt/MagellanMNS/bin/pui -falcon
For Passport/SNMP Devices Backup and Restore the command is
/opt/MagellanNMD/bin/nsui

For Service Integrity Audit the command is
/opt/MagellanNMS/bin/sisautui

For Network Activation the command is
/opt/MagellanNMS/bin/natui [-NAF <NAF_filename>]

The tool’s main window appears. If the Authentication dialog is displayed 
over the main window, see “The Connection Manager and authentication” 
(page 31) for more details.

See 241-6001-802 Preside MDM User Interface Primer for more information 
about the Preside Multiservice Data Manager (MDM) workstation interface.
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The Connection Manager and authentication
The Connection Manager (CM) is a server process residing on the Preside 
Multiservice Data Manager (MDM) workstation. The CM manages all the 
network connections that are created for your session. The CM displays the 
Authentication dialog when you access any of the Configuration tools. 

Note: For CM set-up and administrator functions, see 241-6001-011 
Preside MDM Fault Management User Guide.

Authentication dialog
The Authentication dialog displays a list of network destinations and their 
connection states. Valid network destinations for Passport are Passport 
groups. You can select a Passport group from the destination list and enter a 
valid userid and password. Error messages are displayed in the message area. 
Upon successful network logon, the Authentication dialog automatically 
closes.

When you log off from the Preside Multiservice Data Manager (MDM), all 
network connections associated with your userid are shut down automatically 
by the CM. The CM allows only the tool that opened the network connection 
to close (disconnect) the connection. Accordingly, when you log off from 
your MDM session, the CM  shuts down all the active network connections 
belonging to your userid.

See the figure “Authentication dialog” (page 32).
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Figure 1
Authentication dialog

The Authentication dialog allows you to log on to a network destination, with 
a valid userid and password. This dialog provides the following information: 

• Server Host displays the server host name. All network communications 
are performed through this host. 

• Destination list lists all the network destinations that are available from 
the current server host. The destination is either a destination mnemonic 
name for the DPN network or a group name for the Passport network. 
Select a destination to set the Destination field and populate the User Id 
list.  Double-click on the Destination list to set the destination and 
perform the authentication (you need to supply a userid and password 
first). The destination state is Authenticated if authentication data is 
available for the destination. 
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• User Id list lists all previously authenticated userids associated with the 
selected destination. It allows you to reuse authentication data. Select a 
userid to set the User Id and Password fields. Double-click on the userid 
to set the User Id and Password fields and perform the authentication 
action. 

• Destination allows you to manually enter the destination in this field or 
select one from the Destination list. 

• User Id allows you to manually enter the userid in this field or select one 
from the User Id list. 

• Password allows you to manually enter the password in this field or select 
one, along with a userid, from the User Id list. 

• Message displays messages related to the current authentication request. 

• Authenticate performs the authentication. The dialog closes upon 
successful completion. Otherwise, an error message is displayed in the 
Message area. You can  choose to alter parameters and try again or to 
cancel the request. 

• Cancel closes the dialog without performing an authentication request. 

See “Selecting a Passport group” (page 33) for information on completing the 
Authentication dialog.

Performing authentication
The following procedure shows how you perform authentication by logging 
on to the network through a Passport group.

Selecting a Passport group
1 In the Authentication dialog, enter the Destination manually or select one 

from the Destination list.  The destination must be a Passport group.

The selected destination is displayed in the Destination area.

2 Enter your userid and password.

3 Click Authenticate or press the return key.

If the authentication fails, an error message is displayed. Otherwise, the 
Authentication dialog closes and the main window of the tool is displayed.
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If you click Cancel for the “Software Download and Configuration” or 
“Component Provisioning”, see “Authentication warning dialog” 
(page 34).

Authentication warning dialog
The Authentication warning dialog is displayed when you cancel the 
authentication process for the Configuration tools “Software Download and 
Configuration” and “Component Provisioning”. It indicates that the tool 
cannot communicate with the network until authentication is successful.

See the figure “Authentication warning dialog” (page 34).

Figure 2
Authentication warning dialog

Click Yes to re-display the Authentication dialog. 

If you click No, the Configuration application session is terminated. 

Performing re-authentication
During a session it may become necessary to change the Passport group you 
are working with. You do this by performing the authentication process again.  
When re-authentication takes place, the current connection is closed. 

Redisplay the Authentication dialog by clicking Authenticate from the 
Security menu of the Configuration tool you are working in.  From there, 
follow the process described in  “Selecting a Passport group” (page 33). 
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Enabling log files
A log file contains processing and error messages that are produced by the 
application. Logging can be enabled by means of the graphical user interface, 
command line, or command file.

If the -log option is specified in the command file or on the command line, the 
output is directed to the log file and to stdout/stderr. The same messages are 
displayed in both. If the log file already exists, the new data is appended to the 
file. If the log file does not exist, a new one is created.

If two or more applications are running concurrently, the log file may be 
locked by one of the applications. The other applications wait and retry the 
lock later. If the maximum number of lock retries is exceeded, the application 
is aborted. 

For more information on command line syntax and the number of lock retries 
permitted, see the individual tool sections in this guide.

Using the keyboard
For all Passport Devices configuration tools, you can use the keyboard instead 
of the mouse to perform the default action in a dialog, select a menu item, or 
execute a command by using an accelerator. 

Performing the default action
Dialogs have a default action button that can be distinguished from other 
buttons in the dialog by the highlight box around it. The default action is 
performed when you press the Return key while keyboard focus (the cursor) 
is in the dialog. 

Menu items
Mnemonics are single characters that uniquely identify a particular menu 
item. Mnemonics can be used to perform any function on the menu bar. The 
single character that selects a given menu item is shown by an underscore 
under that letter in the name of the menu item. 
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You can use mnemonics by pressing the F10 key, entering the mnemonic for 
the menu, and then entering the mnemonic for the entry you want to use; or 
by pressing the meta key with the mnemonic for the menu you want to access, 
followed by the mnemonic for the specific menu item. 

For example, to use the Authenticate (mnemonic A) item in the Security 
(mnemonic S) menu, use either of the following key sequences: 

• F10 S A 

• META+S A

Command accelerators
The Configuration tools provide the following accelerators: 

• Ctrl+E closes the tool. 

• Shift+Help changes the cursor into a pointer in the shape of a question 
mark. You can access specific help for a window object by placing the 
cursor over the object and pressing Select.
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Software Download and Configuration

This section describes the Software Download and Configuration tool and the 
procedures for using it. In this chapter, you can find the following 
information:

• “The Software Download and Configuration tool” (page 37)

• “About Passport software” (page 38)

• “Software Download and Configuration main window” (page 40)

• “Software Download and Configuration dialogs” (page 47)

• “Software Download and Configuration procedures” (page 56)

The Software Download and Configuration tool
Software Download and Configuration allows you to configure, download, 
and upgrade software in the Passport network. You can use 241-5701-270 
Passport 7400, 15000, 20000 Software Installation Guide, as a  reference 
when performing the procedures in this chapter. This document discusses the 
concepts and components associated with configuring a Passport network and 
provides information on transferring software onto the Software Distribution 
Site (SDS).

The Passport Software Download and Configuration tool resides on an 
Preside Multiservice Data Manager (MDM) workstation. It uses the 
Connection Manager (CM) services to establish the connection to the 
Passport system; it uses services provided by other processes to modify the 
service data view and to send commands to the Passport.
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See also...

• “About Passport software” (page 38)

• “Software Download and Configuration main window” (page 40)

• “Software Download and Configuration dialogs” (page 47)

• “Software Download and Configuration procedures” (page 56)

About Passport software
A Passport module can hold up to 16 processor cards. Each processor card is 
identified by its slot number. To load software for Passport processor cards, 
define the feature (service) and version supported on each processor card in 
the service data view.

The application version list (AVL) is a provisionable attribute of the Passport 
software component. The AVL contains a list of application versions installed 
(or to be installed) on a Passport module. Only one logical processor type 
(LPT) is associated with the control processor (CP) and the name CP is 
reserved for this LPT. A logical processor (LP) represents the entire body of 
software to be run on a processor card. Because an LP is a logical entity, it can 
be mapped to any processor card according to your configuration. An LP can 
be mapped to one processor card as the main (active) card for supporting a 
service, and to a standby card for backup should the main card fail. See 
241-5701-270 Passport 7400, 15000, 20000 Software Installation Guide for 
more information on installing Passport software.

The following is a summary of provisionable attributes related to the software 
configuration of an LPT, an LP, and a Card. See 241-7501-210, Passport 
Components for more information on provisionable attributes.

LPT
The attributes are as follows:

• Feature List: A list of features (services) loaded (or to be loaded) on the 
processor.

• System Configuration: Configuration parameters on start-up.

• Comment Text: An arbitrary string that can be used to describe the LPT.
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LP
The attributes are as follows:

• Main Card: The main processor card to which this LP is assigned.

• Spare Card: The backup processor card (if a spare processor card is 
available) to which this LP is assigned.

• Logical Processor Type: This is the LPT that specifies which software 
this LP will run.

• Customer Identifier: The Passport Customer Identifier of the LP.

Card
There is only one provisionable attribute:

• CardType: Indicates the type of card expected to match the hardware.

The figure “Relationships among cards, LPs, and LPTs” (page 40) shows the 
relationships among processor cards, LPs, and LPTs.
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Figure 3
Relationships among cards, LPs, and LPTs

Software Download and Configuration main window
See the following sections for information on the parts of the Software 
Download and Configuration main window:

• “Menu bar” (page 41)

• “SDS data area” (page 43)

• “Target EM data area” (page 44)

• “Messages area” (page 47)

See the figure “Software Download and Configuration main window” 
(page 41).
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Figure 4
Software Download and Configuration main window

Menu bar
The menu bar is located at the top of the Software Download and 
Configuration main window. See the following sections for information on 
the menu bar entries:

• “File menu” (page 42)

• “Edit menu” (page 42)
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• “Options menu” (page 42)

• “Security menu” (page 43)

File menu
The Exit command closes all windows. You receive a warning if the 
configuration data is altered but not saved. 

Edit menu
The Edit menu gives you access to the following dialogs: 

• Add LPT  Opens the Add LPT dialog. This command is enabled when a 
yoiu have established a SDS connection and the view is uploaded. 

• Add LP  Opens the Add LP dialog. This command is enabled when a you 
have established an SDS connection and the view is uploaded.

Options menu
The Options menu gives you access to the following dialogs: 

• Run Command File  displays the Command File dialog. Use this dialog 
to run an existing command file. This function is enabled if the 
authentication is completed. 

• Enable Download Address Selection lets you choose a different defined 
address. By default, the LAN address of the SDS is used to download 
software. When the download AVs or save view function is invoked, an 
SDS Address Selection dialog is displayed to retrieve the SDS address. 
The defined address can be kept in a configuration file that contains many 
entries with the following format: 

<SDS LAN address> <Passport IP address> <IP/XVC 
address>

The configuration file is named fsdcfg.data and stored under the /opt/
MagellanNMS/data directory. 

• Disable Download Address Selection uses the LAN address of the SDS 
to download the software. 

You can toggle between the Enable and Disable options by clicking the 
current option. 
241-6001-023   14.3RSUP   



Chapter 3 Software Download and Configuration   43
• Enable Force Download AVs forces a download of the software even if it 
already exists on the Passport disk.

• Disable Force Download AVs performs a check to determine if the 
software to be downloaded already exists on the Passport disk. If it does 
exist, the download is not performed. 

You can toggle between the Enable and Disable options by clicking the 
current option.

Security menu
Authenticate  displays the Authentication dialog. You use this dialog to enter 
the authentication information that gives you access to the target Passport. 

SDS data area
The SDS data area contains the “Available AVs on SDS list” (page 43). The 
AV name is a concatenation of the application name and its version level 
(separated by an underscore character). For example, trunks_AB04v.

To retrieve this list, click the “Show SDS AVs button” (page 43). 

Available AVs on SDS list
This is a list of available application versions (AVs) on the Software 
Distribution Site (SDS). It is a multi-select list, and each list item is the name 
of an AV. The AV name is a concatenation of the application name and its 
version level (separated by an underscore character). 

List item functions:

• Update AVL lets you update the selected AVs. 

• Show Patch List displays all of the available patches on the SDS for the 
selected AVs.

Show SDS AVs button
Click this button to retrieve a list of available AVs on the SDS disk. 

A dialog is displayed, requesting the information necessary to log on to the 
SDS. 
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Target EM data area
This section contains details on the target EM (enterprise module).  An EM is 
a Passport module.

See also...

• “Target EM name field” (page 44)

• “Show Modules button” (page 44)

• “AVL (application version list)” (page 44)

• “LPT (logical processor type) list” (page 45)

• “LP (logical processor) list” (page 45)

• “Sparing Connection button” (page 46)

• “Cards” (page 46)

• “Download AVs button” (page 46)

• “Get View button” (page 46)

• “Verify button” (page 47)

• “Save View button” (page 47)

Target EM name field
Enter the Passport name in this field, or invoke the Show Modules... function 
to get a list of the Passport names. 

Show Modules button
Click this button to get a list of Passport modules accessible in the current 
Passport group. This button is enabled if authentication is completed.

See also...

• “Passport Module List dialog” (page 48).

 AVL (application version list) 
The AVL is a single-select list. It holds the versions of each application that 
can run on the Passport module. Each list item contains the name of an 
application version (AV), which is a concatenation of the application name 
and its version level (separated by an underscore character). 
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List item functions: 

• Show Compatible AVs displays a list of all AVs that are compatible with 
the selected AV in the AVL. The AVs in this dialog can be selected and 
added to the AVL. 

• Show Patch List displays a dialog that lists the following patches: all of 
the available patches on the SDS for the selected AV, and all of the 
provisioned patches in the view file that you loaded. From this dialog you 
can display another dialog that lists any prerequisite patches for the 
patches you are going to provision. These dialogs let you provision the 
prerequisite and selected patches in the view file.

• Delete deletes the selected AV from the AVL. 

LPT (logical processor type) list
The LPT list is a single-select list, where each list item holds the name of a 
logical processor type (LPT) that specifies the characteristic of the software 
that needs to be loaded on a processor card. 

Note: Only one LPT is associated with the CP, and the LPT name CP is 
reserved for this LPT. 

List item functions: 

• Add LPT adds a new LPT. 

• Delete deletes the selected LPT. 

• Edit modifies the selected LPT.

• View lets you view the selected LPT but not edit it. 

 LP (logical processor) list
The LP list is a single-select list where each list item holds a logical processor 
number. 

List item functions: 

• Add LP adds a new LP. 

• Delete deletes the selected LP. 
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• Edit enables you to modify the selected LP. 

• View lets you view the selected LP but not edit it.

Sparing Connection button
Click this button to display a dialog that allows you to set one-for-n sparing 
connections. This button is not available for Passport releases prior to 5.0.

See also...

• “Sparing Connections dialog” (page 51)

Cards
You can use this area to display and modify the cards of an uploaded Passport 
view. The CP slots in this area are set according to the type of Passport you 
are configuring, for instance, first slot and last slot for the Passport 7000 series 
and slots 0 and 1 for the Passport 15000. 

This area is enabled when the configuration data is uploaded. Use the 
associated data selector to select the CardType. 

Download AVs button
Click this button to download selected AVs from the SDS to the target 
Passport module. This button is enabled when the Available AVs on SDS list 
and Target EM name field are both not empty. You need to select at least one 
AV from the Available AVs on SDS list. Optionally, you can specify an SDS 
IP address that can be used for software downloading by selecting the Enable 
Download Address Selection entry from the Options menu. 

Get View button
Click this button to load a specific provisioning data file that contains the 
software configuration data into the editing view from the target Passport 
module. The software configuration data consists of the  software/application 
version list (AVL), the logical processor type (LPT), the logical processor 
(LP), and the cards. 

A dialog is displayed to obtain parameters used for loading the view. 

See also ...

• “Get View Parameters dialog” (page 52)
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Verify button
Click this button to perform semantic checks for the configuration data. This 
button is enabled if the configuration data is uploaded. 

Save View button
Click this button to save the modified software configuration data back to the 
target Passport module. 

A dialog is displayed to obtain parameters used for saving the software 
configuration data. 

See also...

• “Save View Parameters dialog” (page 53)

Messages area
Messages generated by Software Download and Configuration in the course 
of its operations are displayed in this area. The text field is scrollable so that 
you can read previous messages. 

Software Download and Configuration dialogs
See the following sections for information on Software Download and 
Configuration dialogs:

• “Passport Module List dialog” (page 48)

• “Patch List dialog from the Available AVs on SDS” (page 48)

• “Patch List dialog from the AVL” (page 48)

• “Prerequisite Patch List dialog” (page 49)

• “Logical Processor Type dialog” (page 49)

• “Logical Processor dialog” (page 50)

• “Sparing Connections dialog” (page 51)

• “Get View Parameters dialog” (page 52)

• “Save View Parameters dialog” (page 53)

• “SDS Address Selection dialog” (page 54)

• “SDS Authentication dialog” (page 54)
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• “Processor Targets dialog” (page 55)

• “Command File dialog” (page 55)

Passport Module List dialog
The Passport Module List dialog is displayed when you click the Show 
Modules button. It is used to display a list of Passport modules accessible 
from the current Passport group. It consists of:

• Filter data entry field that allows you to condense the list of Passport 
modules.

• List of accessible Passport modules.

• Target EM field that displays the Passport module you select from the list.

The buttons are:

• OK places the name of the Target EM in the Target EM name field on the 
main window.

• Cancel closes the dialog.

Patch List dialog from the Available AVs on SDS
This dialog lists all the available patches on the SDS for all of the AVs you 
selected on the Available AVs on SDS list. This dialog is for display purposes 
only.

Patch List dialog from the AVL
From this dialog you can provision selected patches. The column Patches 
from SDS lists all the available patches on the SDS for the AV you selected on 
the AVL (application version list).

The column Provision Patch List lists by default all the patches that are 
provisioned in the view file you uploaded. The patches listed under Provision 
Patch List are the patches that you can provision. You can provision a patch 
more than once. 

Press the mouse menu button under Patches from SDS to display the option 
Add to Provision Patch List. This option copies the selected patch to the 
Provision Patch List column, where you can provision it.
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Press the mouse menu button under Provision Patch List to display the 
options Show Prerequiste patches and Delete. Show Prerequisite patches 
displays the Prerequite Patch List dialog, which lists the patches you need to 
provision before you can provision the selected patch in the Provision Patch 
List. Delete deletes the selected patch from the Provision Patch List.

The buttons are:

• Accept Provision List provisions the patches in the Provision Patch List. 
The patches are activated when the view file is activated.

• Cancel closes the dialog without provisioning the patches.

Prerequisite Patch List dialog
This dialog lists all the patches you need to provision before provisioning the 
patches you selected in the Patch List dialog from the AVL. 

The buttons are:

• Provision All provisions all the prerequisite patches. The patches are 
activated when the view file is activated.

• Cancel closes the dialog without provisioning the patches.

Logical Processor Type dialog
The Logical Processor Type dialog is used to create a new logical processor 
type (LPT) or modify an existing one, and consists of:

LPT Name: The LPT name. Only one LPT is associated with 
the CP, and the LPT name CP is reserved for this 
LPT. 

System Configuration: The Passport system requires some configuration 
parameters on start-up. The combinations of 
possible settings are predefined and each possible 
setting has a name associated with it. Select the 
System Configuration combination by using the 
data selector. 
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Logical Processor dialog
The Logical Processor dialog is used to create a new logical processor (LP) 
or modify an existing one, and consists of:  

Comment Text: An arbitrary string that can be used to enter a 
comment on the LPT.

LPT Features list: Consists of a list of features that you need to  load 
on the processor.

Available Features list: Consists of a list of available features you can be 
select and add to the LPT Features list.

Referenced LPs: A read-only list that shows which logical 
processors (LP) are currently referencing this LPT.

OK button: You can use this button to add the LPT in the LPT 
list and close the dialog if all of the mandatory 
fields are not empty.

Show Features button: Displays the available features in the Available 
Features list.

Cancel button: You can use this button to discard the changes and 
close the dialog.

Verify button: Performs the LPT semantic checks. Errors, 
warnings, and informational messages are 
displayed in the Messages area.

LP Number: Use the data selector to select the LP number. 

The LP's Passport 
Customer Identifier, 
which is compatible 
with DPN, DPN-100 
NetMan, and Basic 
CIDs. 

Customer Identifier:
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Sparing Connections dialog
The Sparing Connections dialog allows you to set sparing connections using 
one-for-n sparing. One-for-n sparing enables you to protect multiple main 
function processors (FPs) with a single spare FP. For more information on this 
feature, see 241-5701-600 Passport 7400, 15000, 20000 Configuration 
Guide.

The dialog allows you to assign one spare for up to four main cards. There is 
an entry for each of the 16 card slots you may have in a Passport shelf. You 
can set sparing connections on any slots except those reserved for control 
processors (CPs). You cannot perform one-for-n sparing on CPs.

Main Card: The preferred processor card onto which you need to 
assign this LP.

Spare Card: The spare processor card onto which you need to 
assign this LP.
LP/0 needs to reference only the first card or last card 
for Passport 7000 series, and only cards 0 or 1 for the 
Passport 15000. Both need to have CardType CP. 
Main and Spare card numbers need to be different. 
Main and Spare CardTypes must match. 

Referenced LPT: The LPT name that determines which software this LP 
runs. You can use the data selector to select the LPT 
name.
LP/0 needs to reference LPT/CP.

Cancel button: You can use this action button to discard the changes 
and close the dialog. 

OK button: You can use this action button to add the LP in the LP 
list and close the dialog. 

Verify button: Performs the LP semantic checks. Errors, warnings, 
and informational messages are displayed in the 
Messages area. 
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Pressing the menu button, while the arrow is on the arrow symbol to the right 
of a slot, displays a list of options that allows you to designate the card as a 
spare or one of the four main cards. The option notApplicable means you 
cannot use one-for-n sparing for this card.

The buttons are:

• OK keeps your changes and closes the dialog.

• Verify runs semantic checks. Errors, warnings, and informational 
messages are displayed in the Messages area.

• Cancel discards your changes and closes the dialog. 

Get View Parameters dialog
These parameters are used in loading the software configuration data into the 
editing view, which contains the software/application version list (AVL), the 
logical processor type (LPT), the logical processor (LP), and the cards. 

The mode indicates the search mode that the tool uses to find the name of the 
provisioning data file. You can select one of the following modes: 

User Specified: Enables you  to specify if a particular provisioning data file 
is to be loaded. You need to specify the file name in the 
data entry field.

Keyed: Enables you to specify that a key is used to search for the 
provisioning data file to be uploaded. You need to specify 
a key in the data entry field; it can be made up of letters, 
digits, and underscores. The key cannot begin with an 
underscore and cannot exceed six characters. 

Dated: Enables you to specify that a date key is used to search for 
the provisioning data file to be loaded. You need to specify 
a valid date in the format yymmdd in the data entry field. 
See “Date Convention” (page 28) for more information on 
the date format. 
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The buttons are:

• OK loads the specified provisioning data file from the Passport module. 

• Cancel closes the dialog. 

Save View Parameters dialog
Enter the save mode in this area. The parameters are used when saving the 
provisioning data file. 

Save view mode indicates the mode that the tool uses to name the newly 
modified provisioning data file. You may select one of the following: 

Committed: Loads the committed provisioning data file on the 
Passport. No data entry field is associated with this mode. 

Current: Loads the current view on the Passport. No data entry field 
is associated with this mode. 

Edit: Loads the edit view on the Passport. No data entry field is 
associated with this mode. 

User Specified: Enables you to specify the name that the provisioning 
data file is saved as. You need to specify the file name 
in the data entry field. 

Keyed: Enables you to specify the key to be used to name the 
new provisioning data file to be saved. You need to 
specify a key in the data entry field; it can be made up 
of letters, digits, and underscores. The key cannot begin 
with an underscore, and cannot exceed six characters. 

Dated: Enables you to specify that a date key is used to search 
for the provisioning data file to be saved. You need to 
specify a valid date in the format yymmdd  in the data 
entry field. See “Date Convention” (page 28) for more 
information on the date format.
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The options are:

• Perform MDM-Semantic Checks performs semantic checks before 
sending a request to save the provisioning data file. 

• Perform On-Switch Semantic Checks requests the target Passport to 
perform the semantic checks before saving the provisioning data file. 

The buttons are:

• OK saves the modified configuration data back to the target Passport 
module. 

• Cancel closes the dialog. 

SDS Address Selection dialog
The Internet protocol (IP) address of the SDS can be configured with a 
different value than the LAN address of the SDS. The address defined in this 
dialog is used by the target Passport to get the software from the SDS. If the 
downloading of software is successfully completed, and if this defined 
address is different from the LAN address of the SDS, then it is saved in the 
configuration file. 

SDS Authentication dialog
The SDS Authentication dialog requests the information required to log on to 
the Software Distribution Site (SDS). It also retrieves the application versions 
(AVs) that will be displayed on the Available AVs on SDS list. It consists of:

• Host data entry field

• User ID data entry field

• Password data entry field

• Application version data entry field that allows wild cards
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The buttons are:

• Skip MDM Validation button lets you bypass the Preside Multiservice 
Data Manager (MDM) validation of the Passport software. Enabling this 
button limits the provisioning capabilities of the tool so that all 
provisioning options, except provisioning a change in the AV application 
version, are disabled. 

When you enable Skip MDM Validation, the Verify button, the Cards 
area in the main window and all LPT and LP functions, except View, are 
disabled

• OK  logs on and retrieves a list of available AVs. 

• Cancel closes the dialog. 

• Help accesses the on-line help

Processor Targets dialog
The Processor Targets dialog is displayed when you click the Download AVs 
button on the Software Download and Configuration main window. Use this 
dialog to select the type of CPU or CPUs (central processing unit), i960 or 
ppc, for the sofware you download. The OK button starts the software 
download process. The Cancel button cancels the software download process.

Command File dialog
The Command File dialog is used to specify and run a command file and it 
consists of: 

IP Address: This Software Distribution Site (SDS) 
information is used by the Passport to log on to 
the SDS.

User ID: This SDS information is used by the Passport 
to log on to the SDS.

Password: This SDS information is used by the Passport 
to log on to the SDS.
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Software Download and Configuration procedures
See the following sections for information on the Software Download and 
Configuration procedures:

• “Configuring the Software Distribution Site address” (page 57)

• “Configuring the Passport module” (page 58)

• “Performing authentication” (page 59)

• “Specifying a target Passport” (page 59)

• “Listing Application Versions on SDS” (page 60)

• “Getting a view” (page 61)

• “Updating an application version list” (page 62)

• “Provisioning a software patch” (page 63)

• “Editing a logical processor type (LPT)” (page 65)

• “Editing a logical processor (LP)” (page 67)

• “Performing one-for-n sparing” (page 69)

Command File Name: Enter the name of the command file in this 
field (Include the path if the file is not in your 
home directory).

Log to file button: Check this item to turn logging off. Logging is 
on by default. 

Log File Name: This field appears if the log option is turned 
on. Enter the name of the file to which log 
messages are written. Include the path if the 
file is to be stored in a directory other than 
your home directory. 

Run Command File button: Click this button to run the specified command 
file.

Cancel button: Click this button to close the dialog. The 
command file is not executed.
241-6001-023   14.3RSUP   



Chapter 3 Software Download and Configuration   57
• “Editing a processor card” (page 70)

• “Saving the modified view” (page 71)

• “Downloading software” (page 73)

• “Upgrading software from a GUI” (page 74)

• “Using a command file” (page 75)

• “Using the command line interface” (page 77)

• “Using log files” (page 75)

Configuring the Software Distribution Site address
Note: The software for Passport 7000, Passport 15000, and Passport 
20000 may be available from the same Software Distribution Site (one IP 
address) as long as different user IDs, with different SDS home 
directories are configured for each.

The LAN address of the Software Distribution Site (SDS) is used to retrieve 
the application control files. To download the software, Software Distribution 
requests the Passport download process to retrieve software from the SDS 
using the address provided by Software Distribution. Under normal 
configuration, the SDS LAN address is used by both Software Distribution 
and the Passport download process.

The SDS can also be configured to communicate with the Passport using an 
address that is different from its own LAN address, that is, the SDS has 
multiple virtual circuits (VCs). The Passport is unable to reach the SDS if the 
SDS LAN address, which is provided by Software Distribution by default, is 
used.

In this configuration, you need to  provide the address of the SDS that is used 
to communicate with the Passport (referred hereafter as SDS-Passport 
address), not the SDS LAN address. This can be done by using the “Enable 
Download Address Selection” menu and an optional user-defined 
configuration file.
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The SDS-Passport address can be predefined in an editable configuration file 
called /opt/MagellanNMS/data/fsdcfg.data. Each line in the file specifies SDS 
addresses and associated Passport address.The file has the following format:

<SDS LAN address> <Passport address> 
<SDS-Passport address>

where:

<SDS LAN address> is the SDS address.

<Passport address> is the Passport address.

<SDS-Passport address> is the address used by the SDS to 
communicate with the Passport.

You need to specify the address in IP format (for example, 123.1.1.1).

When the Enable Download Address Selection option is set on and the 
Download AVs or Save View options are selected, a dialog is displayed 
requesting the SDS-Passport address. By default, the SDS LAN address is 
shown as the SDS-Passport address if the SDS-Passport address is not defined 
in the configuration file. The SDS-Passport address display can be changed; 
the configuration file is updated with new address information after the 
operation is successfully performed.

When the Enable Download Address Selection option is not selected, and the 
Download AVs or Save View option is selected, the SDS LAN address is used.

See also...

• “SDS Address Selection dialog” (page 54)

• “SDS Authentication dialog” (page 54)

Configuring the Passport module
The following steps must be performed to configure a Passport module:

1 Specify a Passport Group.

See “Performing authentication” (page 59).
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2 Specify a target Passport.

See “Specifying a target Passport” (page 59).

3 Retrieve a list of available AVs on the SDS.

See “Listing Application Versions on SDS” (page 60).

4 Upload a view.

See “Getting a view” (page 61).

5 Add required application versions (AV) into the AVL area.

See “Updating an application version list” (page 62).

6 Provision any required software patches.

See “Provisioning a software patch” (page 63).

7 Configure the LPTs, LPs, and cards.

See “Editing a logical processor type (LPT)” (page 65),
“Editing a logical processor (LP)” (page 67),
and “Editing a processor card” (page 70).

8 Save the modified view.

See “Saving the modified view” (page 71).

Performing authentication
When the Software Download and Configuration application is started, the 
Connection Manager (CM) is invoked. The Passport group containing the 
target Passport node needs to be identified and authenticated before the 
session can continue. See “Selecting a Passport group” (page 33) for more 
information.

Specifying a target Passport
You need to specify a target Passport before you perform any configuration or 
download functions. There are two methods of specifying a target Passport.

1 Enter the Passport name in the Target EM area in the main window.

OR

Click Show Modules  in the main window.
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The Passport Module List dialog is displayed.

A list of modules associated with the Passport group specified in the 
authentication window is displayed.

2 To condense the list of module names, enter a filter in the Filter data entry 
field.

3 Click Filter.

A list of modules containing the data specified in the filter is displayed.

4 Select the module.

The selected module name is displayed in the Target EM data entry field.

5 Click OK.

This dialog is closed and the selected module name is displayed in the 
Target EM area.

Listing Application Versions on SDS
To configure or download software, you need to retrieve a list of available 
AVs on the Software Distribution Site (SDS). After the main window is 
displayed and authentication is successfully completed, perform the 
following steps to retrieve a list of AVs available on the SDS.

1 Click Show SDS AVs on the main window.
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The Authentication dialog is displayed, requesting the information 
necessary to log in to the Software Distribution Site (SDS).

2 Enter the Host, User ID, and Password of the SDS. 

3 You can use the Application Version data entry field to specify search 
criteria for the AVs. This customizes the AVs listed in the Available AVs on 
SDS area in the main window.

4 Click OK.

An FTP connection to the SDS is established and the application version 
control files are retrieved. An FTP connection is established even if the 
SDS is on the same workstation. The application names and their version 
numbers are displayed in the Available AVs on SDS area in the main 
window.

Note: You can bypass the MDM Validation of the Passport software by 
enabling the Skip MDM Validation button. If you do this, your 
provisioning capability is limited to provisioning a change in the AV 
application version.

Getting a view
The Get View Parameters dialog is used to specify the search mode that the 
Software Distribution and Configuration application uses to find the name of 
the service data view.

1 Specify the Target EM on the main window using one of the two methods 
described in “Specifying a target Passport” (page 59).
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2 Click Get View... .

The Get View Parameters dialog is displayed.

3 Specify upload view parameters by selecting the appropriate radio button 
and filling in the data entry field where applicable.

4 Click OK.

The tool establishes a provisioning session with the Passport and tries to 
retrieve the data for the AVLs, LPTs, LPs, and cards specified in the 
service data.

Note:  You can configure AVLs, LPTs, LPs, and cards only when they are 
displayed in the Available AVs on SDS area.

The View File Name is displayed under the Passport Name.

Updating an application version list
After the Available AVs on SDS list is retrieved and a view is uploaded, 
perform the following steps to update an application version list (AVL).

1 Select the appropriate AVs from the Available AVs on SDS list.

2 Press the mouse menu button in the Available AVs on SDS area in the 
main window and choose Update AVL.

The selected AV name is displayed in the AVL area of the main window.

OR

3 Select an AV in the AVL area.
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4 Press menu in the AVL area and choose Show Compatible AVs.

A dialog displays a list of all AVs compatible with the AV selected in the 
AVL.

5 Select one or more AVs from the list.

6 Click Update AVL.

The selected AV names are displayed in the AVL area of the main window.

Provisioning a software patch
1 Specify a target Passport. See “Specifying a target Passport” (page 59).

2 Retrieve a list of available AVs on the SDS. See “Listing Application 
Versions on SDS” (page 60).

3 Retrieve the required view file. See “Getting a view” (page 61).

4 Make sure the appropriate AVs are listed in the AVL (application version 
list). See “Updating an application version list” (page 62) if you need to 
add any AVs to the AVL.

5 In the AVL, select the AV with the patch to be provisioned.

6 Press the mouse menu button in the AVL and select Show Patch List. 
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The Patch List dialog from the AVL opens.

7 For any patch listed under Patches from SDS that you want to provision, 
select it, press the mouse menu button, and select Add to Provision Patch 
List.

8 For any patch listed under Provision Patch List that you do not want to 
provision, select it, press the mouse menu button and select Delete.

9 To check if an entry in the Provision Patch List has any prerequisite 
patches, select it, press the mouse menu button, and select Show 
Prerequiste patches. The Prerequisite Patch List dialog opens.
241-6001-023   14.3RSUP   



Chapter 3 Software Download and Configuration   65
10 If there are any entries listed in the Prerequisite Patch List dialog, click 
Provision All to provision them in the view file and close the dialog. The 
entries are added to the Provision Patch List in the Patch List dialog from 
the AVL.

11 Click Accept Provision List to provision the patches in the view file and 
close the dialog.

12 Repeat steps 5 to 11 for every AV that requires a patch. The patches are 
activated when the view file is activated.

Editing a logical processor type (LPT)
You can perform the following steps (create, modify, or delete) to a logical 
processor type (LPT). 

Before you edit a logical processor type, ensure that you have done the 
following:

• connected to the Software Distribution site

•  obtained a view from the Passport node that you are planning to upgrade

• selected the features (AV)s that you want to upgrade and updated them. 
See, “Updating an application version list” (page 62)

Creating a new LPT
1 Press menu in the LPT area header in the main window and choose Add 

LPT.

OR

From the Edit menu on the menu bar, choose Add LPT...
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The Logical Processor Type dialog is displayed.

2 Specify the LPT Name, Configuration, and Comment Text.

To view the options available for System Configuration, press the data 
selector and choose one of the listed options.

3 To display the list of available features, click Show Features. 

4 Select the features required, press menu, and choose Add to LPT.

The features are now listed in the LPT Features area.

5 Click Verify.

All errors, warnings, and informational messages are displayed in the 
Messages area in the LPT dialog.

6 Select OK to close the dialog.

The new LPT is displayed in the LPT area of the main window.
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Note:  You can still add an LPT if the semantic checks fail. When you add 
an LPT, an “X” box is displayed beside the LPT in the LPT area to indicate 
that an error has occurred.

All errors, warnings, and informational messages are displayed in the 
Messages area in the main window.

Modifying an existing LPT
1 Select the LPT that you want to modify.

2 Press menu in the LPT area and choose Edit.

The Logical Processor Type dialog is displayed.

Note:  The Reference LP, Main Card, and Spare Card associated with the 
LPT are listed in the dialog in read-only format.

3 Modify the LPT Name, Configuration, Comment Text, or Features of the 
selected LPT.

To view the options available for Configuration, press the associated data 
selector and choose one of the listed options.

4 Click Verify.

All errors, warnings, and informational messages are displayed in the 
Messages area in the LPT dialog.

5 Click OK to save the changes and close the dialog.

Note:  An “X” box is displayed beside the LPT in the LPT area to indicate 
that an error has occurred.

All errors, warnings, and informational messages are displayed in the 
Messages area in the main window.

Deleting an LPT
1 Select the LPT that you want to delete. 

2 Press menu in the LPT area and choose Delete.

The selected LPT is removed from the LPT area.

Editing a logical processor (LP)
You can perform the following steps (create, modify, or delete) to a logical 
processor (LP). Before you edit a logical processor, ensure that you have done 
the following: 

• connected to the Software Distribution site
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•  obtained a view from the Passport node that you are planning to upgrade

• selected the features (AV)s that you want to upgrade and updated them. 
See, “Updating an application version list” (page 62)

Creating a new LP
1 Before you create an LP, ensure that you have defined the processor card. 

See “Editing a processor card” (page 70).

2 Press menu in the LP area header in the main window and choose New 
LP.

OR

From the Edit menu on the menu bar, choose Add LP.

The Logical Processor dialog is displayed.

3 Specify the LP Number, Customer Identifier, Main Card, Spare Card, and 
Referenced LPT.

For a list of available options, press the data selector associated with each 
field and choose one of the listed options.

4 Click Verify.

All errors, warnings, and informational messages are displayed in the 
Messages area on the LP dialog.
241-6001-023   14.3RSUP   



Chapter 3 Software Download and Configuration   69
5 Select OK to save the changes and close the dialog.

The new LP is displayed in the LP area of the main window.

Note:  An “X” box is displayed beside the LP in the LP area to indicate that 
an error has occurred.

All errors, warnings, and informational messages are displayed in the 
Messages area in the main window.

Modifying an existing LP
1 Select the LP that you want to modify. 

2 Press menu in the LP area and choose Edit.

The Logical Processor dialog is displayed.

3 Modify the LP Number, Customer Identifier, Main Card, Spare Card, or 
Referenced LPT Name.

To view the available options, press the data selector associated with 
each field and choose one of the listed options.

4 Click Verify.

All errors, warnings, and informational messages are displayed in the 
Messages area in the LP dialog.

5 Click OK to save the changes and close the dialog.

Note:  An “X” box is displayed beside the LP in the LP area to indicate that 
an error has occurred.

All errors, warnings, and informational messages are displayed in the 
Messages area in the main window.

Deleting an LP
1 Select the LP that you want to delete. 

2 Press menu in the LP area and choose Delete.

The LP is removed from the LP area.

Performing one-for-n sparing
You can perform one-for-n sparing on Passport releases beginning with 5.0. 
For more information, see 241-5701-600 Passport 7400, 15000, 20000 
Configuration Guide. 

1 Click Sparing Connection.
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The Sparing Connections dialog opens.

2 Designate the required card by pressing the menu button when the arrow 
is on the arrow symbol to the right of the card.

A list of options is displayed.

3 Set the card to be a spare or one of four main cards.

4 Click Verify to perform semantic checks.

All errors, warnings, and informational messages are displayed in the 
Messages area.

5 Click OK to save your changes and close the dialog.

Editing a processor card
You can perform the following steps to define a new processor card and to 
specify the type of service card, for example, V35.

Defining a new processor card
1 Set the CardType of the processor card by using the data selector 

associated with a card number.

2 Create a new LP to run the selected LPT software on the processor card.

3 Create a new LPT if a suitable LPT does not already exist.

4 Click Verify.
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All errors, warnings, and informational messages are displayed in the 
Messages area in the main window.

Changing the software load of  a processor card
You can use different methods to change the software load on a processor card 
as follows:

• Create a new LPT with the new software, and map the existing processor 
card and LP to this new LPT.

• Locate an LPT within the Passport node that contains the software you 
require, and map the existing processor card and LP to this LPT. See  
“About Passport software” (page 38) for the mapping between LPTs, 
LPs, and cards.

• Change the software associated with an LPT to include the new software, 
and map the existing processor card and LP to this LPT.

Saving the modified view
The Save View dialog allows you to specify the mode the tool uses to name 
the newly modified view. You can use two check boxes in this dialog to 
specify where the semantic checks are performed. 

You can perform semantic checks from the graphical user interface for the 
AVL, LPT, LP, and cards. The semantic checks ensure that no inconsistencies 
exist with the components specified. 

When you select Perform MDM Semantic Checks, only the components 
related to software (AVL, LPT, LP, and cards) are checked. When you select 
Perform On-Switch Semantic Checks, all components are checked to ensure 
the view can be activated. By default, the semantic checks are performed on 
both the Preside Multiservice Data Manager (MDM) workstation and the 
Passport when the view is saved.

1 Click Save View from the main window.

The Save View Parameters dialog is displayed.

2 Semantic checks are performed on the Preside Multiservice Data 
Manager (MDM) and on-switch by default. If you do not require semantic 
checks, deselect the check boxes.
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The Full check and Stop on error boxes are enabled if the Passport 
module file supports the Check changed and stopOnError options.       

To perform semantic checking on the changed components only, deselect 
the Full Check  button.    

To get all semantic errors, deselect the Stop On Error button. 

3 Specify the save view parameters by selecting the Option mode you wish 
to save the view as. The save options are:

• Ascii to save the view in an ASCII format.

• Portable to save the complete view in a portable format.         

Note:  Saving the view in Ascii format may take a long time, and it also 
takes more time to load the ASCII file.

4 Fill in the View File Name field, if applicable.

If the Enable Address Selection option is selected from the Options menu, 
the SDS IP Address is displayed in this dialog.

5 Click OK.

When the save is complete, a message is displayed in the Messages 
area.

After you select OK, the tool performs the following tasks before the view is 
actually saved:

• Performs semantic checks for software configuration components 
(AVLs, LPTs, LPs, and cards) if the Perform MDM Semantic Checks 
option has been selected.

• Opens a new session to the target Passport.

• Retrieves a list of AVs available on the Passport disk.

• Triggers the target Passport download process to transfer the AVs 
specified in the AVL that do not exist on the Passport disk.

• Requests the target Passport to add data for new components or replace 
data for modified components.

• Requests the target Passport to perform semantic checks for the whole 
provisioning view if the Perform On-Switch Semantic Checks option is 
selected.

• Requests the target Passport to save the view.
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Downloading software
Passport software is partitioned into applications. A particular version of an 
application is called an application version (AV). All Passport software is 
stored on the Software Distribution Site (SDS) in a hierarchical directory 
structure that has a directory for each AV. No automatic recovery mechanism 
is provided if the download fails; it needs to be restarted.

By default, the SDS LAN address is used to download software. To download 
to a different address, select the Enable Download Address Selection from the 
Options menu. 

You can use the following procedure if you require the software on the 
Passport node but don’t want to configure it, or if a view has been previously 
saved but the software is not yet downloaded to the node. 

1 Enter the Target EM name in the main window.

2 Click Show SDS AVs.

The Authentication dialog is displayed requesting the information 
necessary to log in to the Software Distribution Site (SDS).

3 Enter the Host, User ID, and Password of the SDS.

4 Click OK.

An FTP connection to the SDS is established and the application version 
files are identified. The application names and their version numbers are 
displayed in the Available AVs on SDS area.

5 Select the appropriate AVs from the Available AVs on SDS area.

6 Click Download AVs.
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The Processor Targets dialog opens.

7 Select the type or types of CPU for the software you will download.

Note: To cancel the download, click Cancel.

8 Click OK.

A list of available AVs on the Passport disk is retrieved. The tool then 
triggers the target Passport download process to transfer the AVs that are 
specified but do not already exist on the Passport disk.

All errors, warnings, and informational messages are displayed in the 
Messages area in the main window and indicate when the download 
process is complete.

Upgrading software from a GUI
You can use the graphical user interface (GUI) to replace a version of the 
application and download the new software. If the new version of an 
application does not introduce any new features, you can upgrade the 
software version directly using the command line. If you need to upgrade 
several modules, use the command file input. See “Using a command file” 
(page 75) for the correct file syntax.

You can also use the command line to upgrade the software version and 
download the required software directly. See “Using the command line 
interface” (page 77) for the correct command syntax.

1 Retrieve a list of available AVs on the SDS.

See “Listing Application Versions on SDS” (page 60).
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2 Get the current or commited view.

See “Getting a view” (page 61).

3 Add the required AVs into the AVL area.

See “Updating an application version list” (page 62).

4 If the new software introduces new features, configure the LPTs, LP, and 
cards as required.

See “Creating a new LPT” (page 65), “Creating a new LP” (page 68), and 
“Defining a new processor card” (page 70).

5 Save the modified view.

See “Saving the modified view” (page 71).

Using log files
A log file contains processing and error messages that are produced by the 
command line process. Logging can be enabled by means of the graphical 
user interface, command line, or command file.

If the -log option is specified in the command file or on the command line, the 
output is directed to the log file and to stdout/stderr. The same messages are 
displayed in both. If the log file already exists, the new data is appended to the 
file. If the file does not exist, a new one is created.

If two or more applications are running concurrently, the log file may be 
locked by one of the applications. The other applications wait and retry the 
lock after five seconds. If the maximum number of lock retries exceeds 180, 
the application is aborted.

Using a command file
You can use a command file to specify the required parameters for a 
command. This file may be located on any mounted file system on the 
workstation, which allows the application and the file to reside on different 
machines. The command file uses keywords that match those supported on 
the command line interface (for example, target, av, loadview, and saveview); 
but the authentication information, command file, and logfile options cannot 
be specified in the command file. If parameters other than those mentioned 
are specified, they are ignored. Separators can be spaces or tabs; if the first 
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column of a new line is a #, the line is treated as a comment. The command 
file can also be invoked from the graphical user interface. See “Running a 
command file from the GUI” (page 76) for more information.

Example
The following is an example of a command file:

#Start of command file
-target moonbase1 NODER16 NODER17
-av trunk_AA000 base_AA000

The following is an example of a command line that uses the parameters 
specified in a command file. Note that the authentication information is 
provided on the command line and is not included in the command file.

fsdl -auth group1 user pass
-sds 47.236.0.24 ftpuser ftppasswd -f <cmdfile_name>

See also...

• “Command File dialog” (page 55)

Running a command file from the GUI
1 Create a command file using a UNIX editor such as vi. 

See the previous example for an example of a command file.

2 From the Options menu choose Run Command File.

The Command File dialog is displayed.

3 Enter the SDS IP Address, User ID, and Password of the SDS.
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4 Enter the Command File Name.

5 Deselect Log to File if logging is not required.

6 Click Run Command File.

A command line process is invoked to execute the command file. All 
errors, warnings, and informational messages produced by this command 
are displayed in the Messages area of the main window.

Using the command line interface
The command line interface is useful for software upgrading if the new 
application version does not introduce new features. It also enables you to 
read the required parameters from a command file. If several modules are to 
be upgraded, use and execute the command file input in a batch mode.

The command line interface allows you to perform the following actions in 
batch mode:

• download AVs

• replace the AV name specified in the AVL

• access one or more modules to perform the above operations.

To display online help for this command, use the -h option on the command 
line.

Enter the following command syntax as one continuous command.

Command line with a command file
/opt/MagellanNMS/bin/fsdl -auth <passport_group_name>

<capability_id> <passwd>

-sds <sds_ipaddress>|<sds_name> <sds_userid> 

<sds_passwd> -f <command_file_name>

[-loadview <loadmode> [<view_file_name>|<key>| <date>]]

[-saveview <savemode> <view_file_name>|<key>]

[-patchlist <patch1>...]

[-opts [stopOnErr] [checkchanged] [portable | ascii]

[-log [<log_file_name>]]

[-dlforce]
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Command line without a command file
/opt/MagellanNMS/bin/fsdl -auth <passport_group_name>

<capability_id> <passwd>

-sds <sds_ipaddress>|<sds_name> <sds_userid>

<sds_passwd>

-target <passport_name> ... -av <appl_version> ...

[-loadview <loadmode> [<view_file_name>|<key>| <date>]]

[-saveview <savemode> <view_file_name>|<key>]

[-patchlist <patch1>...]

[-prtarget <i960> <ppc>]

[-opts [stopOnErr] [checkchanged] [portable | ascii]

[-log [<log_file_name>]]

[-dlforce]

Note: The following minimum character are required for their respective  
keywords:

COMMITTED  COM
CURRENT  CUR
USER_SPECIFIED  U
KEYED  K
DATED  D
EDIT  E

where:

-auth <passport_group_name> <capability_id> <passwd> are 
the parameters used to log on to a Passport group to which the target Passport 
belongs. The parameter are:

<passport_group_name> Mnemonic of the group to log on to.
<capability_id> Capability id to log on with.
<passwd> Password for the capability id.

-av <appl_version>... is the application version(s) to be downloaded 
from the SDS to the target Passport disk. Valid name has the format 
<application>_<version>.
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-dlforce downloads the specified AVs without checking the existence of 
the AVs.

-f <command_file_name> is the command file used to identify the target 
name(s), application version, and view name to load or save. The following 
command line parameters are ignored if the -f option is specified: -target, -av, 
-loadview, -saveview, and -patchlist.

-h displays help on command syntax and use. This option is the first or only 
parameter you can specify on the command line.

-loadview <loadmode> [<view_file_name>|<key>|<date>]

<loadmode> indicates the mode to be used for uploading a view. Valid 
values are: USER_SPECIFIED(U)/KEYED(K)/DATED(D)/
CURRENT(CUR)/
COMMITTED(COM)/EDIT(E) where:

USER_SPECIFIED (U) treats the <view_file_name> as a completed view 
name.
KEYED (K) means that the <key> can be composed of letters, digits, and 
underscores. The key cannot begin with an underscore and cannot exceed six 
characters in length.
DATED (D) is a valid <date> in the format yymmdd. See “Date Convention” 
(page 28) for more information on the date format.
CURRENT(CUR), COMMITTED (COM)or EDIT(E) have no parameters.

-log [<log_file_name>] when specified in the command file or on the 
command line, directs the output to the log file and to stdout/stderr. The same 
messages are displayed in both. If the log file already exists, the new data is 
appended to the file; if the file does not exist, a new one is created. If no file 
name is specified, then fsdl.log is used by default.

If two or more applications are running concurrently, the log file can be 
locked by one of the applications. The other applications wait and retry the 
lock after five seconds. If the maximum number of lock retries exceeds 180, 
the application is aborted.

-opts [stopOnErr] [checkchanged] [portable | ascii] are 
options are associated with the saveview option:      
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stopOnEr aborts the check immediately upon finding the first error.
checkchanged performs the check only on modified components. 
portable saves the modified view in a portable format.
ascii saves the modified view in an ASCII format.

-patchlist <patch1>... lets you specify the patch or patches to 
provision in the view file. The patches are activated when the view file is 
activated. Only use the patchlist parameter with the loadview and saveview 
parameters.

[-prtarget <i960> <ppc>] lets you download software for the two 
different CPUs (central processing units) that can be on the Passport. You can 
select one or both CPU types.

-saveview <savemode> <view_file_name>|<key> specifies the new 
view name to be downloaded. There are three modes that can be specified: 
USER_SPECIFIED (U), KEYED (K) or DATED (D). The CURRENT, EDIT 
and COMMITTED options are not valid for the savemode.

-sds <sds_ipaddress>|<sds_name> <sds_userid> <sds_passwd> 
are the parameters used to log on to the Software Distribution Site (SDS). 

The parameters are:

<sds_ipaddress> SDS IP address.
<sds_name> Site name.
<sds_userid> Userid to log on with.
<sds_password> Password for the userid.

-target <passport_name>... is the Target EM name. You can specify 
more than one at a time.
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Example
The following example is used to download trunk_AA0040 and 
base_AA0040 from SDS (address = 47.209.133.219, userid = ftpuser, 
password = ftppasswd) to the TOR1 Passport node. It also updates the AVL 
specified in the committed view and saves the modified view under myview 
view. Processing or error messages are logged to a file called mylog.

/opt/MagellanNMS/bin/fsdl -auth group1 group1ID 
group1passwd -sds 47.236.0.21 ftpuser ftppasswd 
-target TOR1 -av trunk_AA0040 base_AA0040 
-loadview COM -saveview U myview -log mylog
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Chapter 4
Component Provisioning

This section describes the Component Provisioning tool and contains 
procedures for using it. In this chapter, you can find the following 
information:

• “The Component Provisioning Tool” (page 84)

• “Opening the Component Provisioning tool” (page 85)

• “Component Provisioning main window” (page 85)

• “Component level procedures” (page 95)

• “Component filter preferences” (page 100)

• “Editing and viewing service data” (page 114)

• “Data entry lists” (page 120)

• “Downloading service data” (page 126)

• “Templates” (page 128)

• “Custom Forms” (page 131)

• “Form Editor” (page 133)

• “User preferences” (page 141)

• “Working with context” (page 149)

• “Packet Control Facility (PCF) filter files” (page 150)

• “Passport propagate command” (page 153)
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The Component Provisioning Tool
Component Provisioning is used to define, edit, and display service data for 
Passport nodes. You can choose how you want component information 
displayed.

You can use one of two views when provisioning a Passport node:

• The current view contains provisioning data corresponding to the current 
operation of the node. The current view cannot be explicitly provisioned.

• You can provision the edit view. The edit view may be a copy of the 
current view, or it may be another view loaded on this disk. All 
provisioning commands are applied to this view (unless explicitly 
indicated otherwise). When activated, the edit view becomes the current 
view. Components that fail to activate successfully are indicated as such.

If you lose the connection to a Passport node during a provisioning 
session, you can save the edit view in progress by using the Command 
Console. You can then upload the saved view in the edit view by using 
Component Provisioning. See 241-6001-804 Preside MDM Workstation 
Utilities User Guide, for more information on the Command Console.

See also...

• “Component Provisioning main window” (page 85)

• “Component level procedures” (page 95)

• “Component filter preferences” (page 100)

• “Filter Preferences dialog” (page 101)

• “Filtering Procedures” (page 107)

• “Editing and viewing service data” (page 114)

• “Data entry lists” (page 120)

• “Downloading service data” (page 126)

• “Templates” (page 128)

• “Custom Forms” (page 131)

• “Form Editor” (page 133)
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• “User preferences” (page 141)

• “Working with context” (page 149)

• “Packet Control Facility (PCF) filter files” (page 150)

• “Passport propagate command” (page 153)

• “Passport global data manager tool” (page 156)

Opening the Component Provisioning tool
Note: The user needs to have access to FTP.

To provision service data on a Passport node, you need to successfully 
authenticate to a Passport group that contains the desired Passport node. If 
you want to provision service data on a Passport node that does not belong to 
the group, you need to authenticate again. See “Selecting a Passport group” 
(page 33) for more information.

Component Provisioning main window
See the following sections for information on the parts of the Component 
Provisioning main window:

• “Menu bar” (page 87)

• “Component area” (page 88)

• “Subcomponents area” (page 91)

• “Messages area” (page 95)

For an illustration of the Component Provisioning window, see the figure 
“Component Provisioning main window” (page 86).
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Figure 5
Component Provisioning main window
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Menu bar
The menu bar is located at the top of the Component Provisioning main 
window. See the following sections for information on the menu bar entries: 

• “File menu” (page 87)

• “Options menu” (page 87)

• “Security menu” (page 88)

File menu
The File menu commands are as follows:

• Clear All Module Data. discards all current working data for the current 
view. Any changes not downloaded are lost. However, if any changes are 
made, a confirmation dialog is displayed before the actual command is 
performed. 

• Stop Module Logging  stops the propagation logging of provisioning 
actions into a file. The logging is started if Propagation Logging is 
selected in the Upload Preferences dialog. 

• Download Module Data downloads all service data to the location 
specified in the Download Preferences dialog. Module data is cleared 
from the tool after a successful download. 

• Exit exits Component Provisioning. 

Options menu
The Options menu commands are as follows:

• Change Upload Preferences displays a dialog that allows you to 
customize the user preferences for uploading service data views. 

Use the Preload No option when small service updates are made to a 
large service data view.

• Change Download Preferences displays a dialog that allows you to 
customize the user preferences for downloading service data views.

• Change Filter Preferences displays a dialog that lets you create filters to 
manage the number of displayed components.

• Change Template Preferences displays a dialog that allows you to 
customize the user preferences for loading and deleting templates.
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• Change Custom Form Preference  displays a dialog that allows you to 
customize the user preferences for custom form selection. 

• Save Preferences saves the current user preferences to the file 
ProvisioningUser.cfg in the user's home directory. 

Security menu
Authenticate displays the Authentication dialog. You use this dialog to enter 
the authentication information that gives you access to the Passport.

Component area
The Component area is located just below the menu bar. See the following 
sections for information on the parts of the Component area: 

• “Mode option” (page 88) 

• “Filtering option” (page 89)

• “Component data entry field” (page 89) 

• “Expand button” (page 91) 

Mode option
The Mode option allows you to change the mode of a provisioning session to 
one of the following: 

• Edit

The next component provisioning session or service data upload allows 
changes to the service data and downloading the modified view.

• View

You are only able to view the service data, copy desired components, 
create templates, and generate service data reports. You cannot perform 
any service data modifications or downloads in this mode.

Note: If you attempt to change the Application mode during a 
provisioning session, a dialog is displayed asking you to confirm the 
mode change. If you select Continue, the uploaded provisioning data is 
cleared regardless of any possible changes made to that view.
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Filtering option
The Filtering option lets you enable or disable component filters by selecting 
one of the following:

• On 

The On option enables active component filters so that you can use them. 

Note: To be enabled a filter must be active. To determine if a filter is 
active, open the Filter Preferences dialog. Active filters appear in the 
Active Filters list. See “Activating and deactivating filters” (page 113) 
for the procedure to activate a filter.

• Off

When Off is selected, component filters are disabled. The main window 
displays the entire hierarchy of subcomponents for the component that 
you specified in the Component field.

Note: When you open the Component Provisioning tool, the default is 
Filtering: Off. To use the filters, you need to select the On option.

Component data entry field
This area is used to specify the component with which you wish to work. The 
components are identified by a component name followed by a '/', followed 
by a component value. You can specify several hierarchical components at 
one time. For example: 

EM/abcd 
identifies a module with a mnemonic of 'abcd'. 

The Component data entry field supports the following commands:

• Edit  creates an edit area for the currently selected component. More than 
one edit area can exist simultaneously. 

• View creates an edit area for viewing service data. All editing commands 
that are common to the edit area are disabled when the view command is 
invoked. 
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• Cut Component removes the selected service data component and places 
it in a cut/copy area. This function only operates on components below 
the EM level. 

• Copy Component copies this component and all levels of subcomponents 
below it into a copy area. 

• Paste Component adds the last copied or cut components below the 
currently selected component, if appropriate. See also “Paste Component 
menu entry” (page 91).

• Delete Component deletes a component, such as a Logical Processor, 
from the service data when selected. 

• Add adds a component to the service data instance hierarchy. You can add 
a component that is a subcomponent of the selected component. 

• Add without Forms is similar to Add, however, no edit form is displayed 
and any default values for service data are used.

• Create module creates a new view of the specified module. Edit forms for 
all mandatory subcomponents are displayed. 

• Expand all displays all levels of subcomponents below the selected 
component. 

• Put context generates a component name and sets a Network Model 
context for another application based on the current component name. 
See also “Working with context” (page 149).

• Get context sets the current component name based on the current DPN 
Network Model context. See also “Working with context” (page 149).

• Cut, Copy, Paste, Delete, Select All, and Deselect All are standard 
commands that enable you to manipulate the contents of data entry fields.
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Paste Component menu entry
The Paste Component cascading menu is used to paste the last cut or copied 
component below the current component in the service data hierarchy. You 
can paste the component as is (when doing a move) or with different keys 
(when copying an existing component). 

• Change keys lets you select different key values. As the pasting operation 
proceeds, all components that have key values have a dialog displayed for 
them. The key values may be changed at that time. Examples of key 
values are the cug index for a closed user group (CUG) or the port 
number for a port (PO). 

• Use existing keys uses existing key values. You are not prompted for key 
values. If duplications are encountered, the paste operation is aborted. 

Expand button
The Expand button expands the component you enter and puts the 
subcomponents into the Passport View area of the Subcomponents area. 

See also “Expanding from the Component area” (page 96).

Subcomponents area
The Subcomponents area is located just below the Component area. See the 
following sections for information on the parts of the Subcomponents area: 

• “Component label” (page 91) 

• “Passport View area” (page 91) 

Component label
This line of text is used to specify the view for the Component area.

Passport View area
The Passport View area, located just below the Component label, consists of 
a multiple-line display. You can use this area to view and manipulate the 
subcomponents of the component listed in the Component area. This area 
graphically displays the structure of service data. It can be a valuable aid in 
locating unfamiliar service data. 

Components with attribute/key values that must be available or unique 
throughout the entire network (i.e., network-wide data) have a small icon to 
their left.
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Initially, the components displayed in the Passport View area all have the 
standard background color. When you check for semantic errors, the 
background color changes for each component with an ErrorState of “error” 
or “warning”. “Error” means that major errors are present and the service data 
cannot be activated. “Warning” means that a configuration problem exists.

You can use the following commands to manipulate the hierarchical display 
of service data components in the Passport View area:

• Edit creates an edit area for the currently selected component. More than 
one edit area can exist simultaneously. 

• View creates an edit area for viewing service data. All editing commands 
that are common to the Edit area are disabled when the View command 
is invoked. 

• Cut Component removes the selected service data component and places 
it in a cut/copy area. This function only operates on service data 
components below the EM level. 

• Copy Component for the selected component, copies all levels of 
subcomponents and the service data for these subcomponents into a copy 
area. 

• Paste Component adds the last copied or cut components below the 
currently selected component, if appropriate. See also “Pasting a 
component” (page 99).

• Delete Component deletes a component, such as a Logical Processor, 
from the service data when selected. 

• Add .adds a component to the service data instance hierarchy. You can 
add a component that is a subcomponent of the selected component. 

• Add without forms is similar to Add, however, no edit form is displayed 
and any default values for service data are used.

• Expand displays one level of subcomponent below the selected 
component. 

• Expand all displays all levels of subcomponents existing below the 
selected component. 
241-6001-023   14.3RSUP   



Chapter 4 Component Provisioning   93
• Compress removes displayed subcomponents of the selected component 
from the Subcomponents area. Components are not deleted, but just 
hidden from view. 

• Put context generates a component name and sets a DPN Network Model 
context for another application based on the current component name. 
See also “Working with context” (page 149).

• Templates provides a means to save and reuse portions of service data. 
The commands in the Templates cascade menu are as follows:

See also “Templates” (page 128).

— Create  copies the service data into a user-specified file for use at a 
later time. 

— Delete Component erases the specified service data template file. 
The templates for deletion are displayed within the cascade menu. 

— Use – with forms sequentially displays all editing forms for all 
components contained in the template. The usable templates are 
displayed within the cascade menu. 

— Use – without forms adds the service data, but does not display 
forms. The usable templates are displayed within the cascade menu. 

• Custom Forms allows you to create, change, and delete custom forms. 
The commands in the Custom Forms cascade menu are as follows:

Note: A component’s custom form can be modified by only one user at a 
time. When one user makes modifications to a components’s custom 
form, the Custom Forms command for that component is disabled to 
other users.

See also “Custom Forms” (page 131).

— Create opens the Form Editor with the default form for the specified 
component. You can save the custom form as a workstation custom 
form that is accessible to all users of a workstation; or, you can save 
the custom form as a user custom form that is accessible to an 
individual user.

— Change edits an existing workstation or user custom form for a 
specified component. There are two commands in the Change 
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cascade menu: Workstation Custom Form edits an existing 
workstation custom form; User Custom Form edits an existing user 
custom form.

— Delete deletes an existing workstation or user custom form for the 
specified component. There are two commands in the Delete 
cascade menu: Workstation Custom Form deletes an existing 
workstation custom form; User Custom Form deletes an existing 
user custom form.

• Partial Semantic Check performs a limited check for semantic errors 
under the selected component. Any semantic errors or warnings are 
displayed in the Semantic Check Message dialog. In addition to 
producing error and warning messages, the semantic check can change 
the background color. The background color of components with an 
ErrorState of “error” (or their closest displayed parent) changes to 
errorColor, which is set to the standard MDM color for errors. The 
background color of components with an ErrorState of “warning” (or 
their closest displayed parent) changes to warningColor, which is set to 
the standard MDM color for warnings.

Note: Partial Semantic Check does not perform a full check. When the 
view is downloaded, the switch performs the full semantic check that is 
required before the view can be activated. Partial Semantic Check 
identifies most common errors at the component level and some errors at 
the node level.

• Copy list copies the text of the subcomponents list into a buffer. You can 
then paste the list into a file. 

Download button
The Download button downloads all modified components to the specified 
Passport switch. This download button invokes the same download action as 
the command under the File menu.
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Messages area
The Messages area, located at the bottom the window, displays informative 
messages on the current status of the application. It provides a pop-up menu 
with the following options:

• Copy copies selected text to a buffer. 

• Select all selects all of the text in the message area. 

• Deselect deselects the selected text in the message area. 

Component level procedures
You can use the following procedures to view components:

• “Specifying a component” (page 96)

• “Expanding from the Component area” (page 96)

• “Expanding within the Passport View area” (page 97)

• “Compressing within the Passport View area” (page 97)

Components in the provisioning tool are distinct entities and can be added, 
deleted, cut, copied, and pasted. The difference between cutting and deleting: 
when a component is cut, the text is removed from its original location, but 
remains in the copy buffer so that it can be pasted later. When a component is 
deleted, it is not placed in a buffer and cannot be retrieved.

You can use the following procedures to manipulate components:

• “Adding a component” (page 97)

• “Deleting a component” (page 98)

• “Cutting a component” (page 98)

• “Copying a component” (page 98)

• “Pasting a component” (page 99)

For information on command accelerators you can use, see “Component 
Provisioning command accelerators” (page 100).
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Specifying a component
The Component area of the Component Provisioning main window is used to 
specify an existing Passport component and, optionally, subcomponents. 

1 Click select in the Component area.

2 Enter the component name.

If you do not know what components you can specify, issue the dir 
command from the Command Console. For information on the Command 
Console, see the section, Command Console, in 241-6001-804 Preside 
MDM Workstation Utilities User Guide.

When you specify a component, use the proper prefixes and syntax. EM/
<module_name> identifies the enterprise module.

3 Press Return or click Expand.

When you select Return or Expand, the system attempts to upload the 
service data. A dialog may be displayed requesting the View File Name 
for a particular view of the service data. If you do not know the available 
View File Names, issue the appropriate command from the Command 
Console. For information on operator commands, see 241-5701-050 
Passport 7400, 15000, 20000 Commands. For information on the 
Command Console, see Command Console in 241-6001-804 Preside 
MDM Workstation Utilities User Guide.

If Return is selected, the module is not displayed in expanded form in the 
Passport View area. If the upload fails, an error message is displayed in 
the Messages area.

4 Enter the View file name.

5 Click OK.

The tool establishes a call to the selected Passport module and accesses 
the service data for the selected component.

Expanding from the Component area
After you enter a component name in the Component area, you can expand it 
in the Passport View area by using the Expand button or the Expand all menu 
option. When you use the Expand button, the selected component and its first 
level of subcomponents are displayed in the Passport View area. When you 
use Expand all, the same process occurs as with the Expand button, but all 
levels of the subcomponents are displayed in the Passport View area.
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Note 1:  With both Expand and Expand all, any display currently in the 
Passport View area is replaced. 

Note 2:  Do not use the Expand all option on larger modules because the 
memory and time required to complete this action may be excessive.

Expanding within the Passport View area
You can use the Expand and Expand all options to expand a component 
within the Passport View area.

On an Expand or Expand all operation, the component and its children have 
their background colors change to show which subcomponents have an 
ErrorState of “error” or “warning”.

1 Select the component within the Passport View area that you want to 
expand.

2 Press menu in the Passport View area, and choose Expand or Expand all.

Compressing within the Passport View area
You can use the Compress command from the Passport View area menu to 
hide displayed subcomponents of the selected component.

On a Compress operation, the closest parent of a subcomponent with an 
ErrorState of “error” or “warning” has its background color change to show 
the existence of a subcomponent error or warning.

1 Select the component within the Passport View area that you want to 
compress. 

2 Press menu in the Passport View area and choose Compress.

All subcomponents listed under the selected component are removed 
from the list.

Adding a component
A component can be added from the Component or Passport View areas.

1 Select the component to which you wish to add the subcomponents.

2 Press menu in the Component or Passport View area, and choose Add... 

The Add dialog is displayed containing the subcomponents that can be 
added. Some of the items may be grayed out, indicating that they are 
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already present. The mandatory components are automatically added to 
the selected component.

3 Select the appropriate button and click OK.

During the add operation, you may be presented with a series of key and 
edit dialogs. You need to supply the appropriate information for these 
dialogs to complete the add operation.

Deleting a component
A component can be deleted from the Component or Passport View areas. 

1 Select the component you want to delete.

2 Press menu in the Component or Passport View area, and choose Delete 
Component. 

The deleted component and all of its subcomponents are removed from 
the display. 

Cutting a component
The Cut Component command is used to remove (in fact, delete service data) 
the selected component and its subcomponents. The component and 
subcomponents that are cut are placed in the paste buffer.

1 Enter the module and component name, and follow the steps in 
“Specifying a component” (page 96).

2 Select the component that you want to cut.

3 Press menu in the Component or Passport View area, and choose Cut 
Component. 

The component and subcomponent that are cut are removed from the 
Passport View area if they are visible. 

Copying a component
The Copy Component command is used to place the selected component and 
its subcomponents in the paste buffer.

1 Enter the module and component name, and follow the steps in 
“Specifying a component” (page 96).

2 Select the component that you want to copy.
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3 Press menu in the Component or Passport View area, and choose Copy 
Component. 

Note:  No changes occur to the existing component.

Pasting a component
The Paste Component command is used to add the component in the paste 
buffer to the selected component. The Paste Component command has a 
cascade menu that provides the following options:

• Use Existing Keys prompts for any parameter. The component and its 
subcomponents as they exist in the paste area are added. This is normally 
used for moving a component from one location to another. For example, 
Logical Processor, FrameRelayUni, or UserId.

• Change Keys prompts for the keys of all components and 
subcomponents. This is normally used for creating new components 
identical to existing components but with different keys.

Only one paste buffer exists for each user. When a component is cut or copied, 
the entire paste buffer is over-written with the new component. The paste 
buffer is shared between Component Provisioning instances; therefore, the 
cut/copy/paste component operations are supported among Component 
Provisioning instances for the same user. The Paste Component operation, 
prior to pasting, checks if the component being pasted is valid in the 
hierarchy. If the component is not valid, the operation is terminated with an 
error message. For example, a card cannot be pasted under a 
FrameRelayUnit: nor can a FrameRelayUnit be pasted to a Logical Processor 
service.

The component from the paste buffer can be repeatedly pasted because the 
content of the paste buffer is not altered with the Paste Component operation. 
If errors are encountered during the paste operation, an error message is 
displayed and the paste operation has no effect.

1 Enter the module and the component name, and follow the steps in 
“Specifying a component” (page 96).

2 Select the component that you want to paste.

3 Press menu in the Component or Passport View area, and choose 
Existing Keys or Change Keys from the Paste Component cascade menu. 
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Use Existing Keys from the menu to paste the component with the same 
keys as in the paste area, or use Change Keys from the menu to paste a 
component with user selected keys. If you choose the Change Keys 
option, you are prompted for keys for all components in the paste area in 
a series of separate dialogs.

4 Enter the appropriate key and click OK.

The component and subcomponents pasted are displayed in the 
Passport View area.

Component Provisioning command accelerators
Accelerators are provided for most of the menu items in the pop-up menus. 
All accelerators begin with the control key followed by a single letter. For 
example, the accelerator Ctrl+W downloads the current module data and the 
accelerator Ctrl+E exits the tool. 

For accelerators in the Component data entry field, Passport View list, and 
Changed Component list, you need to first select the appropriate area by 
pressing the first mouse button while the mouse pointer is in the area; 
alternatively use the tab key until the focus is in the desired area. The invoked 
action occurs on the area with the focus. For example, if the focus is in the 
Passport View list, the selected item in the list can be expanded using the 
accelerator Ctrl+I. If the focus is in the Component data entry field, the 
component entered in the field is expanded. 

Component filter preferences
Component filters are created by selecting Change Filter Preferences from the 
Options menu in the main window. This opens the Filter Preferences dialog 
which lets you define the conditions for your filters. Component filters allow 
Passport Component Provisioning to support and manage a large number of 
components. By creating filters you can select the components that you want 
to work on, and therefore, limit the number of components that are displayed. 

A filter consists of one or more conditions applied to one or more component 
classes. Each condition is defined according to the component name and its 
value (or range of values), to which a show or hide action is applied. 
Components are displayed through the Show option if they meet the defined 
criteria. The Hide option blocks the display of the components that match the 
defined criteria. 
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You must activate the filter, using the Filter Preferences dialog, before you can 
use it. Passport Component Provisioning supports multiple active filters. 

Note: When you open Passport Component Provisioning, the default 
filtering option is Off, disabling the active filters. To use filters you must 
select the On option. See “Filtering option” (page 89).

Once you have defined a filter, you can save it to a file so that you can use it 
again. 

Filter Preferences dialog
Filters are created, saved, deleted and modified using the Filter Preferences 
dialog. The Filter Preferences dialog also lets you activate or deactivate a 
filter. 

For information on accessing the Filter Preferences dialog, see the following 
section:

• “Opening the Filter Preferences dialog” (page 102)

For information on the parts of the Filter Preferences dialog, see the following 
sections:

• “Filter lists panel” (page 104)

• “Filter Definition panel” (page 105)

• “Control panel” (page 107)

For procedures to create, save, change and delete filters, see the following 
sections:

• “Creating filters” (page 108)

• “Saving filters” (page 109)

• “Changing filter conditions” (page 110)

• “Changing the order of filters in the Active Filters list” (page 112)

• “Deleting filters” (page 112)

• “Activating and deactivating filters” (page 113)
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Opening the Filter Preferences dialog
1 Open the component provisioning tool, perform the authentication 

procedures and select the Passport module that you want to work on.

2 In the Passport Component Provisioning window, press menu on Options.

3 Select Change Filter Preferences... from the menu. 

The Filter Preferences dialog opens.

See the following sections for information on the parts of the Filter 
Preferences dialog:

• “Filter lists panel” (page 104) 

• “Filter Definition panel” (page 105)

• “Control panel” (page 107) 
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Figure 6
Filter Preferences dialog
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Filter lists panel
The filter lists panel contains the following areas. 

• Active Filters list.  The Active Filters list displays a list of active filters. 
A scroll bar is available on the right side of the list to let you move the 
list up and down to bring different parts into view. Filters listed in the 
Active Filters list are enabled when you select Filtering: On in the main 
window. 

The filters in the Active Filters list when you exit a Passport component 
provisioning session are restored automatically when you start a new 
session. When you open the Filter Preferences dialog, the appear in the 
Active Filters list.

• Inactive Filters list.  The Inactive Filters list displays a list of inactive 
filters. A scroll bar is available on the right side of the window to let you 
move the list up and down to bring different parts of the window into 
view. Filters in the Inactive Filters list are not enabled when you select 
Filtering: On.

Note: You must transfer a filter from the Inactive Filters list to the Active 
Filters list when you want to use it. See “Activating and deactivating 
filters” (page 113).

• Delete buttons. A Delete button appears below both the Active Filters 
and Inactive Filters lists. Selecting a filter and clicking Delete will delete 
the filter from the list. See “Deleting filters” (page 112) for the procedure 
to delete filters from the Active filter or Inactive Filter lists.

• Transfer arrows. Transfer arrows let you move filters between the 
Inactive Filters list and the Active Filters list. See “Activating and 
deactivating filters” (page 113) for the procedure to transfer filters 
between lists.

• Move arrows.  You can move the order of the filters in the Active Filters 
list by using the up and down Move arrows. See “Changing the order of 
filters in the Active Filters list” (page 112).
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Filter Definition panel
You specify the criteria that components must match to be displayed, or 
hidden, in the Passport Component Provisioning window in the Filter 
Definition panel. The Filter Definition panel also contains the controls that let 
you modify the filter and its conditions. It has the following areas:

• Filter Name field. You enter a unique name for your filter in the Filter 
Name field.

• The Filter Definition window. The Filter definition window has three 
fields; Component Class, Value and Option. Data entry fields at the 
bottom of each field let you enter the criteria for the filter:

— Component Class. The Component Class field identifies the class 
name of the components you want to include in your filter. You use 
the data entry field at the bottom of the list when you want to add a 
component class to the filter. 

— Value. The Value field displays the values corresponding to a 
specified component class. You enter the value, or range of values 
valid for the component class, in the data entry field found at the 
bottom of the list. The table “Value formats” (page 105) provides a 
summary of the acceptable formats for numerical component values.

Non-numerical values can be either a single value or an enumeration of non-
numerical valid values for that particular component class. The general 
format is: string[;[string]].

Example
For the collector class, the value could be log;alarm;accounting

Table 1
Value formats

Value Format Example

single numerical #n #7

multiple numerical #n;#n #7;#9

single numerical range #n..m #9..20

multiple numerical range #n..n;#n..m[;#n..m] #9..20;#11..30

mix of mutiplenumerical range #n[..m][;#n[..m]]]* #20..35;#4
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Note: If you do not specify a value in the Value field, the default value is 
“*”. This means that all possible values for a component class will be 
included in the condition.

• Show|Hide option.  You specify either Show or Hide as the operation to 
be performed on the condition.

• Command Buttons.  The Filter Definition panel also has a set of 
command buttons that let you modify the contents of the Filter Definition 
window:

— Add Condition.  Clicking Add Condition adds the condition that 
you have specified in the data entry fields to the filter. The condition 
appears in the Filter Definition window. 

— Change Condition.  Selecting a condition from the Filter Definition 
window, modifying the text in the data entry fields, and clicking 
Change Condition changes the selected condition. The change 
appears in the Filter Definition window.

— Delete Condition.  Selecting a condition from the Filter Definition 
window and clicking Delete Condition deletes the selected condition 
from the filter. The condition is removed from the Filter Definition 
window.

— Delete All Conditions. Clicking Delete All Conditions deletes all 
the conditions for a selected filter. The conditions are removed from 
the Filter Definition window.

• Add User Filter. Clicking Add User Filter adds a filter to the Inactive 
Filters list. The word “user” appears in parenthesis following the filter 
name. The filter is accessible to one specific user.

• Add Workstation Filter. Clicking Add Workstation Filter adds a filter to 
the Inactive Filters list. The filter is accessible to all users of a 
workstation.

• Change Filter. Clicking Change Filter keeps the changes that you have 
made to the selected filter’s conditions.

Note: Making changes to a filter’s conditions, then selecting another 
filter without clicking Change Filter causes the changes to be discarded.
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Control panel
The control panel is located below the Filter Definition panel. It contains the 
buttons that let you save your filters, close your session without saving, and 
access the on-line Help:

• Save to File and Close. Clicking Save to File and Close saves a filter to 
file, and exits the Filter Preferences dialog. Filters in the Active Filters 
list are restored the next time you open the Filter Preferences dialog, and 
appear in the Active Filters list of the dialog. Inactive Filters will appear 
in the Inactive Filters list.

• Save to File. Clicking Save to File saves a filters to file. The Filter 
Preferences dialog remains open. The name of the saved filters appears 
in the Inactive Filters list of the Filter Preferences dialog. 

• Cancel. Clicking Cancel closes the Filter Preferences dialog without 
saving the filters that you have created, deleted or altered during the 
session. 

• Help. Clicking Help accesses the on-line help for the Filter Preferences 
dialog.

Filtering Procedures
You can create, modify and delete filter conditions using the Filter 
Preferences dialog. For additional information, see the following sections:

• “Creating filters” (page 108)

• “Saving filters” (page 109)

• “Changing filter conditions” (page 110)

• “Changing the order of filters in the Active Filters list” (page 112)

• “Deleting filters” (page 112)

After you have created a filter, you have to activate it before you can use it. 
For additional information, see the following section:

• “Activating and deactivating filters” (page 113)
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Creating filters
Use the Filter Preferences dialog to create filters. You establish the conditions 
for a filter by defining the following:

• the class, or classes, of components that you want to work on

• the value or range of values for each class

• the operation to be performed. The options are either Show or Hide.

You can apply more than one condition to a component class and each filter 
can include one or more component classes.

Note: When you define two or more conditions for a component class, 
the order of the condition is important. The order is sequentially applied 
to each component class until a match is made. The first matching 
condition for a class applies. Once a match is made, any subsequent 
reference to that class is ignored.

To create a filter use the Filter Preferences dialog and the following 
procedure:

1 Open the Filter Preferences dialog using the procedure described 
“Opening the Filter Preferences dialog” (page 102).

2 In the Filter Name field, enter a name for the filter that you are creating.

The filter name can be any string of text.

3 Define a filter condition by completing the Component Class, Value and 
Option fields. The component class format is: string [string][*]. For 
example: fruni loadtestsystem pattern*. If you do not enter a value in the 
Value field, the default value (*) is entered in the field.

a. In the Component Class data entry field, enter the component class 
name. 

b. In the Value data entry field, enter a valid value or value range for the 
component class. See “Value formats” (page 105) for examples of 
acceptable formats.

c. From the Show|Hide option button, select the operation you want to 
perform on the condition.

4 Press Add Condition to enter this condition to your filter.
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The information that you have entered for Component Class, Value and 
Option appears in the respective areas in the Filter Definition window. 

5 Repeat steps 3 and 4 for each condition that you want to include in your 
filter.

6 When you have defined all the conditions for your filter, select one of the 
following to add the filter to the Inactive Filters list:

• Add User Filter
The name of the filter appears in the Inactive Filters list with the word 
user appearing in parenthesis beside it. The Filter Name field and the 
Filter definition window are empty. 

• Add Workstation Filter
The filter name appears in the Inactive Filters list. The Filter Name 
field and the Filter definition window are empty.

When you click on the name of a filter in the Inactive Filters list, the name 
of the selected filter appears in the Filter Name field and its conditions 
appear in the Component Class, Value and Option areas of the Filter 
Definition panel.

7 Save your filter. See “Saving filters” (page 109).

Note: An inactive filter is not used when you select the Filtering: On 
option in the Passport Component Provisioning main window. You need 
to activate the filter before you can use it. See “Activating and 
deactivating filters” (page 113) for the procedure to activate a filter.

Saving filters
You have the following options for saving a filter:

• To save the filter to file and exit the Filter Preferences dialog, click Save 
to File and Close.

If unable to save the filter, an error dialog appears with text describing the 
problem. 
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• To save the filter to file without exiting the Filter Preferences dialog, click 
Save to File. The Filter Preferences dialog remains open.

If unable to save the filter, an error dialog appears with text describing the 
problem. 

• To exit the Filter Preferences dialog without saving the filter, click 
Cancel.

Changing filter conditions
See the following sections for additional information on changing your filters:

• “Procedure to modify filter conditions” (page 110)

• “Procedure to delete filter conditions” (page 111)

• “Procedure to change the order of filter conditions” (page 111)

Procedure to modify filter conditions
In the Filter Preferences dialog, use the following procedure to modify filter 
conditions:

1 Open the Filter Preferences dialog using the procedure described 
“Opening the Filter Preferences dialog” (page 102).

2 From the Active Filter or Inactive Filter list, select the filter that you want 
to change.

The filter name appears in the Filter Name field, the conditions for the filter 
appear in the Filter Definition window, and the Change Filter button is 
activated.

3 In the Filter Definition window, click on the condition that you want to 
change.

The defined characteristics of the selected condition appear in the data 
entry fields.

4 Make the desired changes in the data entry fields for Component Class, 
and Value fields, and the Show|Hide option button. 

5 Press Change Condition to enter the changes in the Filter Definition 
window.

The changes that you have made to the condition(s) appear in the 
respective fields of the Filter Definition window.
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6 Press Change Filter to change the filter.

The Filter Name field and the Filter Definition fields are empty. If you click 
on the name of the filter that you have just changed, the changes appear.

7 Save the changes. See “Saving filters” (page 109).

When you open the Filter Preferences dialog again and select the same 
filter, the changes appear.

Procedure to delete filter conditions
In the Filter Preferences dialog, use the following procedure to delete filter 
conditions:

1 Open the Filter Preferences dialog using thtest_plan.pse procedure 
described “Opening the Filter Preferences dialog” (page 102).

2 In the Active Filters or Inactive Filters list, select the name of the filter 
whose conditions you want to delete.

The filter name appears in the Filter Name field and the conditions for the 
filter appear in the Filter Definition window.

3 Select one of the following: 

• To delete all the conditions for the selected filter click Delete All 
Conditions. All the conditions for the selected filter are removed from 
the Filter Definition window.

• To delete one condition, in the Filter Definition window, click on the 
condition that you want to delete and click Delete Condition. The 
selected condition is removed from the Filter Definition window.

4 Click Change Filter to make the changes to the filter.

If you select the same filter again, the changes appear.

5 Save the changes. See “Saving filters” (page 109).

Procedure to change the order of filter conditions
In the Filter Preferences dialog, use the Move arrows and the following 
procedure to change the order of filter conditions:

1 Open the Filter Preferences dialog. See “Opening the Filter Preferences 
dialog” (page 102).

2 Select a filter from the Active Filters or Inactive Filters list.

The conditions for the selected filter appear in the Filter Definition window.
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3 In the Filter Definition window, click on the condition that you want to 
move.

4 Use the arrows at the left of the scroll window to move the filter condition 
in the direction that you want.

The selected filter condition moves to the next row in the direction that 
your have selected. Each click moves the condition another row.

5 Click Change Filter to make the changes in the filter.

6 Save the changes or cancel the session. See “Saving filters” (page 109).

Changing the order of filters in the Active Filters list
You can modify the order of the filters appearing in the Active Filters list, 
using the following procedure:

1 Open the Filter Preferences dialog. See “Opening the Filter Preferences 
dialog” (page 102).

2 Select the filter that you want to move.

3 Press the Move arrow at the left of the Active Filters window in the 
direction that you want to move the filter.

The selected filter moves to the next row, changing places with the filter 
on that row. Each click on the arrow moves the filter to the next row. 

4 Save the changes or cancel the session. See “Saving filters” (page 109).

Deleting filters
You can use the Delete buttons at the bottom of the Active Filters and Inactive 
Filters lists in the Filter Preferences dialog to delete a filter. Use the following 
procedure to delete a filter:

1 Open the Filter Preferences dialog. See “Opening the Filter Preferences 
dialog” (page 102).

2 From the Active Filters or Inactive Filters list, select the filter that you want 
to delete, and proceed as follows:

• To delete a filter from the Active Filters list, click on the name of the 
filter you want to delete in the Active Filters list, and press the Delete 
button at the bottom of the Active Filters list.

• To delete a filter from the Inactive Filters list, click on the name of the 
filter you want to delete in the Inactive Filters list, and press the 
Delete button at the bottom of the Inactive Filters list.
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The selected filter is deleted from the list.

3 Save the changes or cancel the session. See “Saving filters” (page 109).

Activating and deactivating filters
You need to activate a filter before you can use it. See “Activating a filter” 
(page 113). 

You need to deactivate a filter that you do not want to use. See “Deactivating 
a filter” (page 114).

Activating a filter
To activate a filter it must appear in the Active Filters list in the Filter 
Preferences dialog. You can transfer a filter from the Inactive Filters list to the 
Active Filters list, using the Transfer arrow. More than one filter can be active 
at any one time.

The following procedure describes how to activate a filter:

1 Open the Filter Preferences dialog. See “Opening the Filter Preferences 
dialog” (page 102).

2 In the Inactive Filters list, click on the name of the filter that you want to 
activate.

3 Click the left pointing arrow.

The selected filter moves from the Inactive Filters to the Active Filters list.

4 Save the changes. See “Saving filters” (page 109).

When you select the Filtering: On option in the Passport Component 
Provisioning main window (see, “Filtering option” (page 89)), the filters 
that are transferred to the Active Filters list are enabled. 

Filters that are in the Active Filters list when you exit a Passport 
component provisioning session are restored automatically when you 
start a new session. To deactivate the filter, you must transfer it from the 
Active Filters list to the Inactive Filters list in the Filter Preferences dialog. 
For the procedure to deactivate a filter, see “Deactivating a filter” 
(page 114).
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Deactivating a filter
To deactivaFilter Preferences dialogte a filter, you must transfer the filter from 
the Active Filters list to the Inactive Filters list in the Filter Preferences 
dialog, using the Transfer arrow. 

The following procedure describes how to deactivate a filter:

1 Open the Filter Preferences dialog. 

2 In the Active Filters list, click on the name of the filter that you want to 
deactivate.

3 Click the right pointing arrow.

The selected filter moves from the Active Filters to the Inactive Filters list.

4 Save the changes. See “Saving filters” (page 109).

When you select Filtering: On in the Passport Component Provisioning 
main window (see “Filtering option” (page 89)), the filters that appear in 
the Inactive Filters list are not enabled.

Editing and viewing service data
The Edit command allows you to alter service data information. The edit vary, 
depending on the component being edited. If you want to view the service 
data and not make any changes, you can use the View command. The Edit and 
View commands are found in the Component and Subcomponents areas. You 
can open multiple windows when editing and viewing different components.

The Verify action buttons at the bottom of the Edit/View dialog are used to 
check the accuracy of the service data.

See also...

• “Edit/View dialog” (page 114)

• “Edit/View procedures” (page 118)

• “Data entry lists” (page 120)

Edit/View dialog
The Component Provisioning Edit/View dialog, or form, is used to edit, view, 
and verify service data for Passport components. If you need, you can 
concurrently display Edit/View dialogs for multiple components. 
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See “Edit area dialog” (page 116) for an illustration of the Edit/View dialog.

See “Edit/View procedures” (page 118) for information on how to view, edit, 
and verify service data.

The display of Edit/View dialogs can be customized. For information on 
customizing Edit/View forms used during component provisioning, see 
“Custom Forms” (page 131).

See the following sections for information on the parts of the Edit/View 
dialog:

• “Menu bar” (page 117)

• “Component title” (page 117)

• “Service data entry area” (page 117)

• “Messages area” (page 118)

• “Action buttons” (page 118)
Preside MDM Configuration Management for Passport User Guide   14.3RSUP



116   Chapter 4 Component Provisioning
Figure 7
Edit area dialog
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Menu bar
The menu bar contains the options File, Edit, and Options. Most of the 
commands under these options are enabled only when you are working with 
custom forms. The two options that may be enabled in the Edit/View dialog 
are:

• Show hidden, under Options, which displays hidden fields in a lighter-
than-normal color.

• Revert to saved default values, under Edit, which changes the values of 
all fields in the dialog, including hidden fields, back to the saved defaults. 
Revert to saved default values is enabled only when you are using a 
custom form in the Edit/View dialog.

For information on all the menu bar options, see“Form Editor window” 
(page 134).

Component title
The component title displays the full path name of the component that you are 
editing or viewing, and the VIEW bundle file name.

Service data entry area
The service data entry area, located just below the component title, is a 
collection of check buttons and data entry fields that allows you to input 
service data for a specified component.

All Edit/View windows provide a scrollable data area that contains service 
parameters, which are represented by one of the following items: 

• Data entry fields are selected by placing the pointer on the field and 
pressing select. Next, enter the appropriate information. Alternatively, 
you can select an entry from the data selector menu. Do so by moving the 
pointer over the text data selector and pressing menu. Select an entry 
from the range of values. 

• Radio button boxes enable you to turn options on or off. To turn an option 
on or off, place the pointer on the radio button that is directly to the right 
of the option you want and press select.

• Check button boxes are used when there are more than two selections 
available. Select as many options as you like by placing the pointer on 
the check button box and pressing select.
Preside MDM Configuration Management for Passport User Guide   14.3RSUP



118   Chapter 4 Component Provisioning
• Data entry lists are used to change groups of fields and fields with 
dependencies on each other. See “Data entry lists” (page 120).

Messages area
The messages area, located below the service data entry area, displays 
warning and error messages for the Edit/View dialog.

Action buttons
The action buttons, located at the bottom of the Edit/View dialog, are used to 
verify, save, or cancel the service data entries. The following action buttons 
are provided:

• Verify and Save verifies the data first then, if correct, saves the data and 
closes the Edit/View dialog. 

• Verify checks the correctness of the entered data without saving them, 
and leaves the Edit dialog open. 

•  Cancel closes the Edit/View dialog without applying any changes to the 
service data. When you are in View mode, only the Cancel button is 
enabled.

Edit/View procedures
See the following sections for information on the procedures you can use the 
Edit/View dialog to perform:

• “Viewing service data” (page 118)

• “Editing service data” (page 119)

• “Verifying service data” (page 119)

Viewing service data
You can select the View command from the Component and Subcomponents 
areas. When you select View, the Edit area is displayed. This window is 
displayed in read-only mode and changes are not permitted.

1 Enter the module and component name, and follow the steps in 
“Specifying a component” (page 96).

2 Select the component you want to view.

3 Press menu and choose View... 
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The Edit/View area is displayed with the Verify and the Verify and Save 
buttons deactivated.

Editing service data
You can select the Edit command from the Component and Subcomponents, 
areas. When you select Edit, the Edit area is displayed, allowing you to both 
view and make changes to the service data.

1 Enter the module and component name, and follow the steps in 
“Specifying a component” (page 96).

2 Select the component that you want to edit.

3 Press menu and choose Edit... .

Depending on the component, one of the many possible Edit areas is 
displayed.

4 Edit the information as required. 

This is done by entering data and by selecting radio buttons and check 
boxes. 

5 Click Verify to ensure that the changes made to the service data are 
correct.

In this case, the Edit window is not closed.

6 Click Verify and Save in the edit area when you complete the changes to 
the service data.

The changes are verified and the Edit window is closed. The changes can 
now be downloaded to the network component. 

7 To close the Edit/View dialog without saving the changes, click Cancel.

The Edit/View dialog is closed with no changes made.

Verifying service data
You need to verify service data before you can download changes. For more 
information on downloading, see “Downloading service data” (page 126).

1 Enter the module and component name, and follow the steps in 
“Specifying a component” (page 96).

2 Select the component for which you want to verify the service data.

3 Press menu and choose Edit... 

The Edit area displays the service data for the selected component.
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4 Click Verify or Verify and Save to return to the main window.

The sanity of the service data is verified. If the data is incorrect, an error 
is displayed in the Messages area of the Edit dialog. You need to correct 
all errors before saving the changes.

Data entry lists
Data entry lists within an edit form enable you to make changes to groups of 
repeating fields. These lists facility the handling of groups of fields and fields 
with dependencies on each other by grouping lists, data entry fields, and 
action buttons in one area. 

Two types of data entry lists exist: an empty list where all columns are blank; 
and another list where the first or second column has a preset value. In a 
column with a preset value, whether you are adding new information or 
replacing existing information, you perform a Replace. 

A list can have a different number of columns depending on the data type. 
When a data entry list has more than one column, the fields in each column 
are related; one field cannot be added without adding data to the other fields. 
Each group of fields in the list has its own column, title, and data entry field 
directly below the list column. 

Within each data entry list is a Get list information command that displays 
information particular to the list. The Get list information dialog displays the 
following information:

• the number of items currently in the list

• the number of items currently selected in the list

• the maximum number of items allowed in the list

• if the list is a sorted list, the method of sorting

• whether the list is a fixed size list

For an illustration of the Data entry list, see the figure “Data entry list” 
(page 121).
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Figure 8
Data entry list

The figure “Data entry list” (page 121) represents just one of many possible 
lists.

An error icon (X) is displayed beside a data entry field whenever an invalid 
value is entered. However, you can still close the edit form because the data 
entry fields are used only for entering service data; they are not the actual 
service data. 
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Note: If you select Cancel, you will lose any changes made to the 
currently displayed edit form.

The commands that you can issue on the data entry list are grouped in 
different areas as follows: 

• All the commands that operate only on the list portion are located in the 
list title menu. 

• All the commands that need a list item to be selected are located in the 
list item menu. 

• All the commands that do not need a list item to be selected are 
represented as buttons at the bottom of the data entry list. 

List Title menu commands
The List Title menu commands are as follows:

• Get List Info displays a dialog with the following list information: 

— the number of items currently in the list

— the number of items currently selected in the list

— if the list is a sorted list, the method of sorting 

— if the list is a fixed size list

You need to close the dialog before continuing with any editing or other work 
in Component Provisioning. 

List Item menu commands
The List Item menu commands are as follows:

• Add Before adds a new list item before the currently selected item in the 
list. All the data entry fields need to be filled in with valid values. The list 
cannot be sorted or be of fixed size for the Add Before menu item to be 
enabled.

• Copy to entry area takes the selected menu item and places its values in 
the data entry fields below the list. It does not affect the current list item 
in any way. The data entry field values can then be modified and added 
or replaced back into the list. 
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• Delete deletes an item from the list. The list cannot be of fixed size for 
the Delete menu item to be enabled; all currently selected items in the list 
will be deleted. The only way to undo this action is to cancel the current 
edit form and re-edit the same component. 

Note: If you select Cancel, you will lose any changes made to the 
currently displayed edit form.

• Replace inserts a new list item in the position of the topmost currently 
selected item and deletes all currently selected items. All the data entry 
fields need to be filled in with valid values before the Replace menu item 
is enabled.

• Select all selects all list items. 

• Deselect all deselects all currently selected list items. 

List button commands
The List button commands are as follows:

• Add adds data from the data entry fields to the list as a new list item. See 
“List Add” (page 123) for details.

• Find allows you to search data entry fields based on specified search 
criteria. See “List Find” (page 123) for details.

List Add
All data entry fields need to be filled in with valid values before the Add 
button is enabled. Then, when you select the Add button, the data from the 
data entry fields is added to the list as a new list item. 

If the list is a sorted list, the new list item is placed in the proper location 
according to the sort criteria; otherwise, the list item is displayed at the 
bottom of the list. After the list item is added, the data entry fields are erased. 

List Find
The Find button is enabled as soon as any data entry field has a valid value. 
When you select the Find button, all data entry fields with valid values are 
used as search criteria. The first list item, from the search start point and 
matching the values, is selected and scrolled into view. 
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The search start point is determined as follows: 

• If nothing is selected, the search start point is the first item in the list. 

• Otherwise, the search start point is the first selected item in the list. 

You can find all list items matching the current search criteria by pressing the 
Find button repeatedly. 

View Windows
You can use View dialogs to look at service data; however, you cannot change 
the service data parameters. You can start View dialogs by selecting the View 
command from any of the menus in the main provisioning window. 

The action buttons at the bottom of a View window are as follows: 

• Verify and Save is disabled on a View window. 

• Verify is disabled on a View window. 

• Cancel exits the current View window. 

Key Windows
You can use this dialog to enter a key value when adding or pasting new 
components. Examples of key values are the address for a DNA_CUG or the 
cug index for a closed user group (CUG). 

The action buttons at the bottom of a key window are as follows: 

• Cancel cancels the current operation without adding the component. 

• OK verifies that the key value entered is valid and then proceeds with the 
operation. If an invalid key is entered, a dialog is displayed. 

Add Windows
An Add window enables the creation of new subcomponents. You can select 
one of the components presented. Depending on the component selected, one 
or more windows are subsequently displayed. These include either Key 
windows or Edit windows, depending on the type of component that you are 
adding. 
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The action buttons at the bottom of an Add window are as follows: 

• Cancel exits the current window without adding the component. 

• OK, after a desired component is selected from the list, enables you to 
enter the necessary service parameters for the component into one or 
more forms. 

Adding data
To add data to a data entry list, you need to enter the data in the data entry 
area. The Add command adds the data to the list in the correct position. If 
sorting is involved, the new list item is inserted into the list according to the 
specified sort. Otherwise, the new list item is placed at the bottom of the list. 
The following procedure applies only to lists that do not have preset values. 
If you add data to a data entry list that has a preset value in the first or second 
column, you need to perform a Replace and not an Add. See “Replacing data” 
(page 125) for more information. 

1 Enter the new data in the data entry area.

The add operation is possible only when the data is valid, as indicated by 
the enabling or disabling of the Add button.

If no sorting is involved, the Add before button is enabled. Otherwise, the 
new entry is added to the list according to the specified sort.

2 Click Add.

The data is verified. If the data is not valid, an “X” is displayed beside it. 

3 Click Verify and Save to close the dialog.

Replacing data
You can replace data in the list by entering new data in the data entry area as 
follows:

1 Select the line in which you want to replace the data.

The information in the list is copied into the data entry fields.

2 Enter the new data in the data entry area.

3 Click Replace.

The new data is displayed in the list.

4 Click Verify and Save to close the dialog.
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Finding data
You can find existing data by typing the value in one or more of the fields in 
the data entry area. If no matches exist, no selecting occurs. Each find has to 
match the data in the data entry area exactly; no wildcard capabilities exist. 

1 Enter the data that you want to find in the data entry field.

2 Click Find.

The Find command starts searching from the currently selected item, or 
from the top of the list if no selected item exists. The items that are 
matched are scrolled into view in the list area and are automatically 
selected.

Deleting data
You cannot undo fields that were deleted except by cancelling from the edit 
form. 

If the data entry list has a preset value in the first or second column, you 
cannot delete the information. Follow the steps in “Replacing data” 
(page 125); leave all data entry fields blank except the column that contains 
the preset value. 

1 Select one or more items that you want to delete from the list.

2 Press menu and choose Delete.

The data is removed from the list.

Downloading service data
After you edit a subcomponent using the Edit area. the module is not affected 
until the changes are downloaded. 

Note 1:  Downloading the changes to the individual subcomponent of a 
module is not permitted.

Note 2:  If a download fails because the virtual circuit (VC) between the 
Preside Multiservice Data Manager (MDM) workstation and the module 
is broken, you are informed of the situation. You then have to attempt the 
download again after the problem with the module VC is fixed. In this 
situation, the system establishes the VC and downloads the updated 
service data. 
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See also...

• “Download Message dialog” (page 127)

• “Downloading procedure” (page 127)

Download Message dialog
This dialog displays messages generated during the downloading of service 
data. The messages can be errors, warnings, or informational messages. You 
need to correct errors before a download can succeed. If no errors exist, the 
service data is downloaded. Any warnings or informational messages are 
returned after the download is complete. Click the action button to dismiss the 
dialog. 

The commands are as follows:

• Select all selects all the text in the message area. 

• Deselect deselects the selected text in the message area. 

• Copy copies selected text to a buffer.

Downloading procedure
To download changes to a specific Passport switch, follow this procedure:

1 From the File menu, choose Download or click Download in the main 
window. 

The changes for the selected module are downloaded to the Passport 
node.

After you download the service data, you can issue a variety of commands 
(activate, commit, copy, etc.), depending on what you want to do with the 
data. None of these commands are issued in the Component Provisioning 
tool. For information on the available commands and how to issue them, see 
241-5701-050 Passport 7400, 15000, 20000 Commands.
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Templates
Templates are created from existing service data. A template contains a 
snapshot of service data that is saved in a file with a user-specified name. 
When templates are used, a copy of the data is added to the current service 
data. The data in a template can be as small as an individual channel or as 
large as all the service data for an entire shelf. 

The Templates command found in the Passport View menu, provides a 
cascade menu that allows you to create, delete, and use service data templates. 
You can create templates by uploading a view file or adding service data, and 
selecting Create from the Templates cascade menu.

Template Creation dialog
The Template Creation dialog is displayed when you create a service data 
template. The template is created for the component on which the Create 
operation was invoked. By default, the template name is the name of that 
component. However, the name can be changed by entering a different name 
in the Template name data entry field. 

You can create a maximum of 80 templates for any one component type, for 
example, Shelf, Card, Software, Collector, or Logical Processor. After you 
create a template, you can reference it from the component immediately 
above. For example, a template that you create for a Card is available from the 
templating menu on the Shelf component (which is the component 
immediately above the Card). Therefore, although you create a Card template 
from the Card templating menu, you use and delete it from the Shelf 
templating menu. 

Press OK to create the service data template, store it on disk in the directory 
specified in the Template Preferences dialog, and make it available for use. 

Press Cancel to terminate the Create operation and not create a template. 

Note: The template name cannot be blank, contain underscores (_), or 
contain forward slashes (/). The name has to be unique with respect to 
other service data template names. 
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Creating templates
1 Select the component in the Passport View area for which you want to 

create a template.

2 Press menu in the Passport View area and choose Create from the 
Templates cascade menu. 

The Service Data Template Creation dialog is displayed and prompts you 
for a unique location and name.

3 Enter the unique template name.

If no name is specified, the system uses the component as the default, for 
example, Frame Relay.

4 Click OK.

The name of the new template is displayed in the Messages area. To 
verify if this new template is created, press menu on the parent 
component. Choose Use-with forms from the Templates cascade menu. 
The new template is displayed. 

Delete Template dialog
The Delete Template dialog is displayed when you select a template to be 
deleted. The name of the selected template is displayed. 

Press OK to delete the template and to close the dialog. 

Pressing Cancel does not delete the template. The dialog is closed and the 
operation is aborted. 

Note: This dialog is only displayed for a template deletion when the 
Preferences - Templates - Confirm template deletion preference is on. 

Delete Cancel button
This button cancels the deletion of the service data template. 

Delete OK button
This button deletes the specified service data template. 

Deleting templates
Templates that were previously created and are no longer required can be 
removed.
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1 Select the component in the Passport View area from which you want to 
delete a template.

2 Press menu in the Passport View area and choose Delete Component 
from the Templates cascade menu. 

3 Click Delete.

Note:  You have the option of not having the confirmation dialog displayed 
when you use the Delete command. You can access this feature from the 
Options menu by selecting Change Template Preferences, clicking 
Confirm template deletion, and turning the checkbox off. 

The Delete service data template dialog is displayed and prompts you for 
a unique location and name. 

4 Click OK.

Using templates
Using a template creates service data that is a duplicate of the data in the 
template.

1 Select the location of the new service data in the Passport View area.

2 If you want each editing dialog for the new service data displayed and 
available for editing, choose Use-with forms from the Templates cascade 
menu.

3 If you want to be prompted to enter the new value for any key fields, 
choose Use-without forms from the Templates cascade menu. A separate 
dialog is displayed for each key.

Note:  The Use-with forms option is functionally equivalent to choosing 
Use - without forms and, after the operation completes, individually 
editing each new component. 

Template preferences
You can modify template preferences by using the Change Template 
Preferences option in the Options menu. You can perform the following 
options:

• set the directory in which the service data templates are accessed

• disable the Confirm template deletion dialog 
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Template Preferences dialog
This dialog specifies the following two preferences for service data 
templating: 

• The Template directory field specifies from what directory templates are 
saved and accessed. 

• The Confirm template deletion checkbox specifies if a confirmation 
dialog is desired when you delete a template. 

Select Apply to set the preferences for the current provisioning session and 
reload templates from the Template directory. Error messages are written to 
the Messages area of the dialog. Press Close to close the dialog. 

Template directory
The name of the directory from which service data templates are saved and 
accessed. 

Template confirm deletion
If this box is checked, a confirmation dialog is displayed when the Templates-
Delete option is used. Otherwise, the template is immediately deleted without 
any confirmation. 

Template preferences Cancel button
This button ignores any changes made on this dialog and closes the dialog. 

Template preferences OK button
The OK button sets the templating preferences and closes the dialog. These 
preferences are now in place for the duration of the provisioning session. 

In addition, the templates are reloaded from the workstation 'Template 
directory'. A message indicating how many templates are loaded is displayed 
in the Provisioning User Interface message area after the preferences dialog 
is closed.

Custom Forms
Provisioning is made easier and more accurate by using custom forms. You 
can create a custom form for any subcomponent that can be edited or viewed. 
The custom form enables you to simplify the display of the Edit/View form 
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for a subcomponent. In addition, you can use the custom form to set default 
values for a subcomponent’s fields. To create a custom form for a 
subcomponent, use the Form Editor. See “Form Editor” (page 133).

Once created, a custom form replaces the default form in all operations where 
Edit/View forms are used, including: 

• editing

• viewing

• adding 

• templating

Using the Form Editor, you can customize the Edit/View form in the 
following ways:

• hide the display of fields

• change the display order and grouping of fields

• assign your own default values to fields

Hiding the display of fields
You can hide from view the fields that you do not frequently access, greatly 
simplifying the custom form. The option Show hidden allows you to redisplay 
any hidden fields. For more information on how the Form Editor handles 
hidden fields, see “Options menu” (page 137)

Changing the display order and grouping of fields
You can rearrange fields within a custom form. Also, you can define new 
groups, reorder fields within their group, and move fields into other groups.

Assigning your own default values to fields
You can assign default values by setting the values of the fields. When you 
save a custom form, the field values are saved as default values. These default 
values are applied when a custom form is used for any subsequent adding 
operation.
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Form Editor
You create a custom form for a subcomponent by using the Form Editor. 
When opened, the Form Editor displays an Editing Dialog. When you modify 
this Editing Dialog and save the changes, you create a custom form. You can 
save your custom form in one of two ways:

• as a workstation custom form that is accessible to all users of a 
workstation, or 

• as a user custom form that is accessible to one specific user

For details on using the Form Editor, see “Starting the Form Editor” 
(page 133) and “Form Editor window” (page 134).

The following rules apply to any subsequent custom forms, templating, 
editing, viewing, and adding operations:

• A custom form takes precedence over a default form.

• A user custom form takes precedence over a workstation custom form.

• If a custom form is used within a templating operation, it gets any 
relevant service data values for that subcomponent from the template.

You can override this order by establishing custom form preferences. See 
“Custom form preferences” (page 140).

Starting the Form Editor
To create a custom form for a subcomponent, use the Form Editor.

1 From the Component Provisioning main window, specify the desired 
component and subcomponent. 

2 With the mouse pointer in the subcomponent area, press menu to display 
the Subcomponent menu. 

3 From the Subcomponent menu, select Custom Forms. 

A cascading menu is displayed. 

4 From the cascading menu, select Create.

The Form Editor opens an Editing dialog for the specified subcomponent. 
The fields displayed in this dialog vary according to the selected 
subcomponent. 
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5 Make appropriate changes to the Editing dialog.

6 To save your custom form, from the File menu select either Save as 
workstation custom form or Save as user custom form.

Form Editor window
The Form Editor opens and displays an Editing dialog. The content of this 
dialog depends on the selected subcomponents.

See also...

• “File menu” (page 135)

• “Edit menu” (page 136)

• “Options menu” (page 137)

See the figure “The Editing dialog of the Form Editor” (page 135).
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Figure 9
The Editing dialog of the Form Editor

File menu
The Form Editor File menu provides commands that allow you to save 
custom form definitions or close the Form Editor. The File menu contains the 
following commands:

• Save as workstation custom form saves the custom form and permits 
access to the form by any user of the workstation. When saved in this 
way, a workstation custom form is used in place of the component default 
form. Workstation custom forms are stored in the directory /opt/
MagellanNMS/cfg/cfdf/FDF_<version>/, where version is the service 
data level of the Passport.
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• Save as user custom form saves the user custom form and only permits 
access to the form by a specific user. When saved in this way, a user 
custom form is used in place of a workstation custom form or the 
component default form. User custom forms are stored in the directory 
$HOME/MagellanNMS/cfdf/FDF_<version>/, where version is the 
service data level of the Passport.

• Close closes the Form Editor.

Edit menu
The Form Editor Edit menu provides commands to display, hide, and group 
fields. In addition, you can modify and rename groups of fields, as well as set 
fields to their default values.

Most of the Form Editor Edit menu items work on the selected fields and 
groups in the Edit/View form. The selection can be a single field or multiple 
fields. To select a single field, position the pointer over the field label or frame 
and click select. To add fields to a selection, position the pointer over another 
field label or frame and, while holding down the Shift key, click select. To 
toggle a field in or out of a selection, click select over the field label or frame 
while holding down the Control key.

Unlike the menu items that work on fields and groups, Revert to saved default 
values operates on the entire form.

The Edit menu contains the following:

• Hide hides the selected fields. The Form Editor uses one of two modes 
for hidden fields: Hide hidden or Show hidden. If the Form Editor is in 
Hide hidden mode, the selected fields are not displayed on the form. If 
the Form Editor is in Show hidden mode, the selected fields are displayed 
in a lighter-than-normal color. For information on how to change the 
mode, see “Options menu” (page 137).

• Unhide displays the selected field regardless of the hidden mode setting.

• Group  groups selected fields. You can specify a group name for the new 
grouping.

• Delete group deletes the selected group. You can only delete an empty 
group. For information on how to empty a group, see “Moving fields 
within a custom form” (page 138).
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• Change group name  changes the name of the selected group.

• Revert to saved default values changes the values of all the fields in the 
form, including hidden fields, back to their last saved defaults.

Options menu
The Options menu lets you determine how the Form Editor handles hidden 
fields. The Options menu contains the following:

• Show hidden mode displays hidden fields in a lighter-than-normal color. 
Hidden fields are not disabled. You can interact with the hidden fields in 
the normal manner, for example, by changing values in hidden fields.

• Hide hidden mode removes the display of hidden fields so that they do 
not appear on the form.

Modifying an existing custom form
1 From the Component Provisioning main window, specify the desired 

component and subcomponent. 

2 With the mouse pointer in the subcomponent area, press menu to display 
the Subcomponent menu. 

3 From the Subcomponent menu, select Custom Forms. 

A cascading menu is displayed. 

4 From the cascading menu, select Change.

A second cascading menu is displayed.

5 From the second cascading menu, select either the Workstation or User 
Custom Form.

The Form Editor opens an Editing dialog for the specified subcomponent, 
displaying the existing custom form. 

6 Make your modifications.

7 To save your modifications, from the File menu, select the appropriate 
save command.

Deleting a custom form
1 From the Component Provisioning main window, specify the desired 

component and subcomponent. 

2 With the mouse pointer in the subcomponent area, press menu to display 
the Subcomponent menu. 
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3 From the Subcomponent menu, select Custom Forms. 

A cascading menu is displayed. 

4 From the cascading menu, select Delete.

A second cascading menu is displayed.

5 From the second cascading menu, select either the Workstation or User 
Custom Form.

A Question Dialog that asks for verification to delete the custom form is 
displayed.

6 To delete the custom form, click the OK button.

Moving fields within a custom form
There are several types of fields within the Edit/View dialog. The figure 
“Form Editor Field Types” (page 139) illustrates text data selector fields, 
radio button fields, and check button fields. The Form Editor handles check 
button fields differently from other field types. 

You can move fields and groups of fields within a custom form to rearrange 
the display of the form according to your needs. There is, however, one 
restriction: you can move a field or group only within a single form, not 
among different forms.

Before a group can be deleted, it needs to be empty. Move fields out of a group 
to create an empty group. When a group becomes empty, a frame is displayed 
below the group name, outlining the drop location. This allows you to move 
fields back into the group, if necessary, at a later time.

See the figure “Form Editor Field Types” (page 139).
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Figure 10
Form Editor Field Types

Moving fields within a form
1 Move the pointer over the label or frame of the field to be moved. 

2 Press and hold down both the Shift key and the middle mouse button.

3 While holding down the Shift key and the modify mouse button, drag the 
pointer between the two fields of the desired destination.

As you move the pointer across the form, the pointer changes to indicate 
either a valid or invalid drop location. A valid location is indicated by a 
page containing an arrow. An invalid location is indicated by a page 
containing a circle with a line through it.

Radio button field

Check button field

Text data selector field
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4 At a valid destination, release the modify mouse button and then the Shift 
key.

Moving groups within a form
1 Move the pointer over the group name to be moved. 

2 Press and hold down both the Shift key and the modify mouse button.

3 While holding down the Shift key and the modify mouse button, drag the 
pointer to a valid destination.

As you move the pointer across the form, the pointer changes to indicate 
either a valid or invalid drop location. A valid location is indicated by a 
page containing an arrow. An invalid location is indicated by a page 
containing a circle with a line through it.

4 At a valid destination, release the middle mouse button and then the Shift 
key.

Custom form preferences
Two types of custom forms are available: workstation custom forms and user 
custom forms. Workstation custom forms are accessible to all users of a 
workstation; user custom forms are accessible to one specific user. You can 
modify custom form preferences from the Options menu by selecting Change 
Custom Form Preferences. The resulting Custom Form Preferences dialog 
lists two options: workstation custom forms and user custom forms. Specify 
your preferences by selecting or de-selecting these options. Four choices are 
available:

• both options de-selected
When both workstation custom forms and user custom forms are de-
selected, only default forms are used for component provisioning.

• workstation custom forms selected
Workstation custom forms are used in place of default forms.

• user custom forms selected
User custom forms are used in place of default forms.

• both options selected
Both types of custom forms are available, however, user custom forms 
take precedence over workstation custom forms.

To save your custom form preferences to a file, from the Options menu, select 
Save Preferences.
241-6001-023   14.3RSUP   



Chapter 4 Component Provisioning   141
User preferences
You can load user preferences from the ProvisioningUser.cfg file in your 
home directory when a Component Provisioning session is started. The user 
profile saves your preferences from one provisioning session to the next. This 
file is optional. If it does not exist, the system defaults are used.

You can modify preferences and save them to disk by choosing Save 
Preferences from the Options menu. When preferences are saved, the 
previous version is renamed to ProvisioningUser.cfg.old.

Note: Some options in the preference dialogs may be protected, which 
prevents you from modifying them. This situation occurs if your system 
administrator restricts the options available to you.

See also...

• “Upload preferences” (page 141)

• “Download preferences” (page 145)

• “General user preferences dialogs” (page 148)

Upload preferences
You can modify the upload preferences by choosing Change Upload 
Preferences from the Options menu. Views are uploaded when an EM 
(enterprise module), that is not currently updated is entered in the Component 
field. After you set your preferences, they are valid for the duration of the 
provisioning session.

When you connect to a Passport node that is downgraded to a lower software 
level, you can encounter problems in uploading the current view. This 
situation is due to the current view requiring a higher software level. In this 
case, you can upload the edit view instead of the current view.

See also...

• “Upload Preferences dialog” (page 142)
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Upload Preferences dialog
The Upload Preferences dialog lets you specify how you prefer the service 
data views to be uploaded by Component Provisioning. This dialog also lets 
you specify whether you wish to enable preloading of the service data view 
or enable propagation logging. After you set your preferences, they are valid 
for the duration of the provisioning session.

See the figure “Upload Preferences dialog” (page 142).

Figure 11
Upload Preferences dialog

After you set preferences in the dialog, click OK to confirm them and close 
the dialog; or click Cancel to close the dialog without saving any changes.
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See the following sections for information on the preferences that you can set:

• “Mode panel” (page 143).

• “Enable Preload button” (page 144).

• “Propagation Logging button” (page 145).

Mode panel
You can use the Mode panel to specify the method for finding the service data 
view to be uploaded each time an upload occurs. An upload occurs when an 
EM (enterprise module) is entered in the Component field and the service data 
view is not currently uploaded for that EM. You can select one of the 
following: 

• User specified uploads the service data view according to a user-specified 
view name. 

When you select User Specified, you are prompted for the view file name. 
A valid view file name has the format

view_name[.type[.number]]

where:

view_name is an alphanumeric string with 1-31 characters.

type can only be full or part

number is a three-digit number.

If the number is not specified, the latest version of the view file is uploaded.

When you specify the view file name, you do not need to enter the extension. 
If more than one copy of the view file exists, the latest version is uploaded.

• Committed uploads the committed service data view on the selected EM.

• Current uploads the current service data view on the selected EM.

• Edit uploads the edit service data view on the selected EM.

Preloading of the service data view is not performed when this button is 
selected.
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• Keyed uploads the service data view according to a key.

When you select Keyed, you are prompted for the key. A valid key has 
the format <key>nnn.

The service data view with the highest index (nnn) is uploaded. 

• Dated specifies uploading according to a date.

When you select Dated, you are prompted for a date. You can enter a 
valid date or today in the Date field. Entering today substitutes the 
current date at upload time so that you always get the latest service data 
file.

A dated view has the format <yymmdd>nnn, where nnn is an index. See 
“Date Convention” (page 28) for more information on the date format.

Date mode is similar to keyed mode. However, when an exact match does 
not exist, the most recent service data view, relative to the date, is 
uploaded. That is, the dated service data view with the latest date earlier 
than the given date is uploaded.

Enable Preload button
Select Enable Preload to enable preloading of the Passport service data view 
whenever you start a provisioning session. By default, preloading is turned 
on.

If preloading is turned off, when you access a component, Passport Devices 
Configuration needs to send requests to upload the service data view from the 
Passport switch. Processing these requests can take considerable time if the 
view contains many components and you need to access a large number of 
them. 

If preloading is turned on, the service data view is uploaded automatically 
when you start a session. Preloading provides little advantage if the view 
contains only a few components or if you need to access only a few 
components in a large view.
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The preload option is ignored when you set the upload mode preference to 
Edit. This situation occurs because the Passport provisioning stack (fps) 
needs to retrieve data from the Passport editing view located on the Passport 
switch. See “Component level procedures” (page 95). 

Propagation Logging button
Select the Propagation Logging button to create a log file of the changes made 
to Passport service data during a session. You can turn logging on only when 
an upload is done. You can turn logging off any time by using the Stop module 
logging option from the File menu.

Download preferences
You can modify the download preferences by choosing Change Download 
Preferences from the Options menu. Views are downloaded when you select 
Download from the File menu or the main window. After you set your 
preferences, they are valid for the duration of the provisioning session. 

See also...

• “Download Preferences dialog” (page 145) 

Download Preferences dialog
This dialog allows you to specify how you prefer service data views to be 
downloaded by Component Provisioning. Service data views are downloaded 
when you select the Download button. After you set your preferences, they 
are valid for the duration of the provisioning session.

See the figure “Download Preferences dialog” (page 146).
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Figure 12
Download Preferences dialog

See the following sections for information on the preferences that you can set:

• “Mode panel” (page 146)

• “Download Key” (page 147)

• “Download Date” (page 147)

• “Confirm Downloads” (page 147)

Mode panel
Mode indicates the method used to name the new service data view that is 
created each time a download takes place. You can select one of the 
following: 

• User specified enables you to specify the name of the service data view 
that you wish to download. You are prompted for the name of the service 
data view. 

• Keyed enables you to specify a key in the Key field, which is used to 
search for service data views. The service data view that matches the 
pattern and that has the highest index is found, and the next view in the 
sequence is created. Keys can be 1 to 6 alphanumeric characters long. A 
fully numeric download key cannot be less than 3 digits. For example, the 
key 999 is not valid while 99A and 0999 are valid. 
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Note: The Key field is not visible until you select Keyed mode. 

• Dated enables you to specify a date, or today for the current date, in the 
Date field, which is used to search for view files. Using the search string 
<yymmdd>nnn, the service data view with the highest index (nnn) is 
found, and the next view in the sequence is created. See “Date 
Convention” (page 28) for more information on the date format.

Note: The Date field is not visible until you select Dated mode. 

Download Key
The value supplied for this field is used to search for the service data view 
with the format <key>nnn. If a download Key consists of only numeric digits, 
its length needs to be greater than 3 digits. The service data view with the 
highest index is found, and the next view in the sequence is created. The Key 
field is used only when the Download Mode is Keyed. This field is not visible 
until you select Keyed mode. 

Download Date
You can enter a valid date or today in the Date field. Entering today 
substitutes the current date at download time so that you always download a 
new file with the key set to the current date.

The value supplied for this field is used to search for the service data view 
with the format <yymmdd>nnn. The service data view with the highest index 
is found, and the next view in the sequence is created. See “Date Convention” 
(page 28) for more information on the date format. The Date field is used only 
when the Download Mode is Dated. This field is not visible until you select 
Dated mode. 

Confirm Downloads
Confirm Downloads indicates whether or not the Download Confirmation 
dialog is presented for each download. However, if the download parameters 
create any warnings, the Download Confirmation dialog is presented. 

• OK sets the indicated preferences and closes the dialog. These 
preferences are now in place for the duration of the provisioning session. 

• Cancel ignores any changes made on the dialog and closes the dialog. 
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The Mode area lets you indicate the method used to name the new service data 
view that is created each time a download takes place. 

Key and Date fields are visible only when you select the Keyed and Dated 
radio buttons. If you select the User specified option, you are prompted for a 
view name. A valid view name is an alphanumeric string with 1 - 31 
characters.

Two semantic error checking options are Full Check and Stop On Error.

• To perform the checking on the changed components only, deselect the 
Full Check button.

• To get all semantic errors, deselect the Stop On Error button.

Note: If the Passport module does not support these options, a full check 
is performed by default and all errors are reported.

Options for saving are as follows: 

• Ascii saves the view in an ASCII format.

• Portable saves the complete view in a portable format.

Note: Saving the view in ASCII format can take a long time, and it also 
takes more time to load the ASCII file. 

Confirm Downloads displays a dialog when a download is performed. This 
dialog displays any errors or warnings.

General user preferences dialogs
See the following sections for information on general user preferences 
dialogs:

• “User-Specified dialog” (page 149)

• “Question dialog” (page 149)

• “Error dialog” (page 149)
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User-Specified dialog
The User-Specified dialog is presented when uploading or downloading a 
service data view. After you specify the name of the view, this information is 
used to search for or create a service data view. It provides the following 
commands:

• OK proceeds with the operation. 

• Cancel cancels the operation.

Question dialog
The Question dialog presents you with a question. The question can contain 
several lines of text that you can scroll. You can copy and paste the text to 
another window. The Yes button answers the question in the affirmative and 
action is taken in the context of the question. The No button answers in the 
negative.

Error dialog
The Error dialog presents you with error messages. A message can contain 
several lines of text that you can scroll. You can copy and paste the text to 
another window. The OK key acknowledges the error and closes the dialog 
window. 

Working with context
Context enables different applications to communicate a selected part of 
service data. For example, if a given application is working on a specific card, 
it can broadcast the information for that card using the Put context command. 
Other applications can then retrieve the information by using the Get context 
command.

See also...

• “Putting context” (page 149)

• “Getting context” (page 150)

Putting context
The Put context command is used to place a component name in the context 
buffer for another application. The Put context command is available in the 
Component and Subcomponents area menus. If you select a component from 
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one of these area menus, use the Put context command from the area in which 
the component is selected. For more information on Context, see 
241-6001-011 Preside MDM Fault Management User Guide.

1 Select the component that you want to context. 

2 Press menu on that component and choose Put context.

The component name is placed in the context buffer, where it can be 
retrieved by another application.

Getting context
The Get context command from the Component area menu is used to retrieve 
a component from the context buffer. You can use this command after you 
place a component in the context buffer. For example, when using the 
Surveillance tools you might detect a problem with one of the components. If 
you suspect that the problem is a service data problem, you can place the 
component in the context buffer by using the Put context command in the 
Surveillance tool. You can then open Component Provisioning and retrieve 
that component by using the Get context command.

1 Place the cursor in the component area.

2 Press menu and choose Get context.

The component is added to the Component area.

Packet Control Facility (PCF) filter files
The Packet Control Facility (PCF) is a utility for gathering statistics and 
controlling packets passing through a routing facility on a Passport switch. 
PCF filter files can be used to apply rules to packets passing through a router. 
See the figure “PCF filter file edit dialog” (page 151).

A PCF component exists for each filter file. You can add, modify, or delete 
PCF components using Component Provisioning. The PCF filter files are 
transferred from the Passport switch to the Preside Multiservice Data 
Manager (MDM) workstation using FTP. After the filter file is modified, it is 
transferred back to the Passport switch using FTP and deleted from the 
Preside Multiservice Data Manager (MDM) workstation. The IP address of 
the Passport switches has to be directly accessible from the MDM 
workstation through the Host Group Directory Server (HGDS).
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PCF filter files are used for the NetSentry facility, starting at Passport Release 
2.0. For more information, see 241-5701-350 Passport 7400, 8700 Security 
and Access Control Guide.

See also...

• “Add PCF filter file” (page 151)

• “Edit PCF filter file” (page 152)

• “Delete PCF filter file” (page 152)

• “Discard PCF filter file” (page 153)

Figure 13
PCF filter file edit dialog

Add PCF filter file
A PCF component has to exist before you can add a filter file. See “Adding a 
component” (page 97) for more information.
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1 Select the PCF component to which you want to add the PCF filter file.

2 Press menu and choose Edit.

A PCF edit window is displayed.

3 Add the filter file information.

4 Click Verify and Save.

All errors and information messages are displayed in the Messages area.

The new filter file information is downloaded to the Passport switch and 
deleted from the MDM workstation.

Edit PCF filter file
A PCF filter file is edited from a PCF component. The PCF component is 
uploaded from the Passport switch and downloaded after the changes are 
made.

1 From the Passport View area, select the PCF component that you want to 
edit.

2 Press menu and choose Edit.

The PCF Filter edit dialog is displayed.

3 Click Upload.

The PCF filter file information is uploaded from the Passport switch to the 
Preside Multiservice Data Manager (MDM) workstation.

4 Make the necessary changes to the filter file.

5 Click Verify and Save to save the filter file changes.

All errors and information messages are displayed in the Messages area.

The changes are downloaded to the Passport switch and deleted from the 
MDM workstation.

Delete PCF filter file
When you delete a PCF filter file from a PCF component, only the component 
is deleted from the component hierarchy. The PCF filter file remains on the 
Passport switch.

1 From the Passport View area, select the PCF component that you want to 
delete.
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2 Press menu and choose Delete Component.

The component is removed from the dialog box.

Discard PCF filter file
The Discard command is enabled only when you add or modify a new 
component. When you copy a PCF filter file from the Passport to the Preside 
Multiservice Data Manager (MDM) disk for editing, a backup version of this 
file is kept with the filename extension .old. When you use the Discard 
command, the file with the .old file extension is saved back to the Passport 
switch and deleted from the MDM workstation.

1 From the Passport View area, select the PCF component that you want to 
discard.

2 Press menu and choose Discard.

The component is removed from the list.

Note: Cut, Copy, and Paste operations work the same way for PCF 
components. The associated PCF files are uploaded, copied, and 
downloaded back to the switch as necessary. However, the PCF files are 
not deleted from the switch.

Passport propagate command
The Passport propagate (ppropagate) command is a UNIX command line 
application. This application is used for making identical service data 
changes for several views in the same Passport module.

Using the ppropagate command is a two-step process: first, you need to create 
the propagation log file from a Component Provisioning session; second, the 
ppropagate command is used from the UNIX command line.

The propagation log file created in the Component Provisioning session needs 
to contain only one upload and download session. If the log file contains more 
than one, the ppropagate command issues a message and fails.
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When you use the ppropagate command, you are prompted for a Passport 
group password. In this case, the destination and capability id are obtained 
from the propagation log file. The ppropagate command sends all its 
responses to stdout and issues error messages for the following:

• incorrect invocation of the command 

• missing or illegal responses to prompts

• failure to provide a valid Passport group password

• provision of an unsuitable propagation log file

When the ppropagate command has completed, you can exit or provide an 
upload and download mode to propagate more changes. If you continue from 
this point, the log file with the same Passport access information is reused.

The ppropagate command syntax is as follows:

/opt/MagellanNMS/bin/ppropagate [-v] [-h]

Creating a propagation log file
1 In the Preside MDM window, select Configuration -> Passport Devices -> 

Component Provisioning.

The Passport Component Provisioning window opens.

2 From the Options menu, choose Change Upload Preferences.

3 Select Propagation Logging.

4 Supply a filename for the propagation log file.

If no filename is specified, the system creates a default log file with the 
name <module name>.prop.

5 Upload the service data view.

6 Perform the service data changes.

7 Download the changed service data as a new view.

The resulting propagation log file is ready to use with the propagate 
command.

Using the propagate command
1 Open a UNIX xterm.
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2 Invoke the propagate command by entering

/opt/MagellanNMS/bin/ppropagate

3 Enter the propagation log file name.

4 Enter the Passport group password.

5 Specify the upload mode and source upload key.

6 Specify the download mode and target download key.

The propagation log file is applied against the requested view. Any error 
messages and notes resulting from the propagate are displayed on the 
screen.

7 Respond to the prompt that is displayed after downloading: exit; or provide 
an upload and download mode (or accept the default) and repeat step 5.

Example
The following is an example of a successful user-specified upload and keyed 
download.

/opt/MagellanNMS/bin/ppropagate
Enter passport propagation log file = MYNODE.PROP
Passport Group Mnemonic:  MYGROUP
Passport node:  MYNODE
Capability id:  USERID
Enter capability password = <xxxxx>

Enter upload mode [(x) to exit]
[(u)ser (k)eyed (d)ated co(m)mitted (c)urrent (e)dit 
{default: u}] = <cr>
Enter source upload view {default: OLD} = <cr>

Enter download mode [(x) to exit]
[(u)ser (k)eyed (d)ated [default: k}] = <cr>
Enter target download key {default: NEW} = <cr>

NOTE: View “OLD.full.263” uploaded
NOTE: View “NEW06.full.278” downloaded

Enter upload mode [(x) to exit]
[(u)ser (k)eyed (d)ated co(m)mitted (c)urrent (e)dit 
{default: u}] = x
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Passport global data manager tool
The Passport global data manager (pgdm) tool is a UNIX command line 
application. This application is used for propagating global service data from 
one Passport module to other selected Passports, and for replacing attribute 
values globally.

Using the pgdm command is a two-step process: first you need to create two 
input files, the module name file and the component file; second, the pgdm 
command is used from the UNIX command line.

See “Global Data Manager” (page 211) for complete instructions.
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Network Activation

This section describes the Network Activation tool and contains procedures 
for using it. Additional background information is included to help you 
understand how the tool is used. 

You can find the following information on procedures:

• “Starting the Network Activation tool” (page 159)

• “Executing a Network Activation File from the GUI” (page 160)

• “Loading a Network Activation File” (page 163)

• “Modifying Passport Preferences” (page 164)

• “Adding new Network Activation records” (page 165)

• “Modifying a single Network Activation record” (page 166)

• “Modifying several records using the Passport Preference dialog” 
(page 167)

• “Creating or modifying the script lists” (page 168)

• “Clearing all records from the record list” (page 171)

• “Deleting individual records from the record list” (page 172)

• “Saving to a Network Activation File” (page 173)

• “Executing a Network Activation File using the command line” 
(page 174)

• “Using a Cron job” (page 176)
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The information below describes the Network Activation tool:

• “The Network Activation tool” (page 178)

• “Network Activation dialogs” (page 193)

• “Network Activation main window” (page 184)
241-6001-023   14.3RSUP   



Chapter 5 Network Activation   159
Starting the Network Activation tool
Start the Network Activation Tool to load a Network Activation File (NAF) 
or create new Network Activation records, and then execute the NAF. 

Procedure steps
1 In the Preside MDM window, select Configuration -> Passport Devices 

-> Administration -> Network Activation tool.

The Network Activation window opens.
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Executing a Network Activation File from the GUI
Executing a Network Activation File (NAF) from the GUI involves the 
following steps:

• loading a NAF, if you wish to execute records from an existing NAF

• making any required modifications to the NA records

• rearranging records so that they appear in the record list in the desired 
execution order

• selecting the records to execute in the record list

• authenticating with the Passport group that is the target for the View

• clicking on Execute to open the Execute dialog

• setting up parameters for the execution in the Execute dialog

• clicking OK in the execution dialog to execute the records

Blue, yellow, or red records are not executed. If both critical and non-critical 
records are selected, the critical records are always executed sequentially 
before non-critical records. If the activation of a critical View fails, the tool 
will not process the next record.

If records apply to Passports in more than one group, you need to authenticate 
with each group to execute all records. To minimize authentication, use the up 
and down arrows to group records according to the Passport group before you 
execute them.

To execute a NAF using the graphical user interface of the NAT, do the 
following:

1 If you wish to execute an existing NAF, load the NAF into the records list 
as described in “Loading a Network Activation File” (page 163).

Note:  You do not need to load a NAF to execute NA records. You can 
create new records in the record list and execute them, and if desired, 
save them to a NAF later.

2 If desired:

• Add any new records as described in “Adding new Network 
Activation records” (page 165).
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• Modify existing records as described in “Modifying several records 
using the Passport Preference dialog” (page 167).

• Delete undesired records as described in “Clearing all records from 
the record list” (page 171).

3 Re-arrange the execution records into the desired execution order.

To move a record, click on the record to select it, then click the up arrow 
or the down arrow to move the record up or down in the list.

If records apply to Passports that belong to more than one Passport 
group, we recommend you group records according to the Passport 
group.

Note 1:  You can select and move more than one record at a time.

Note 2:  All critical records are executed first, one at a time, followed by 
the non-critical records.

4 Create or modify pre- or post-activation scripts as described in “Creating 
or modifying the script lists” (page 168).

5 In the NAF window, select the records to be executed by clicking on them.

Only select records that belong to Passports in the same Passport group.

The records become highlighted to indicate that they are selected.

6 Select Passport Group Authenticate from the Security menu.

The Passport Group Authentication Dialog opens.“Authentication 
dialog” (page 31).

7 Enter or select the Passport group name, and enter a valid userid and 
password for the group.

8 Click OK to authenticate.

Authentication takes place. If authentication is successful, the dialog 
closes.

9 In the NAF window, click Execute.

The Execution dialog opens.

10 In the Execution dialog, specify:

• the working directory, if desired

• the number of processes to a number other than 1, if required

• the name of a log file to be used for execution information
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For more information, see “Execution dialog” (page 205).

11 Click Execute to begin executing the selected records.

Execution begins and colors of fields and records change as execution 
progresses. Information about the execution is written into the log file you 
specified in the Execution dialog.

While execution is underway, the Execute button is replaced by a Stop 
button that can be used to halt execution. Halting execution turns the 
record in which execution is halted to yellow and launches the Processing 
dialog.

As each process is performed, the corresponding field in the record turns 
from blue to green.

If the action completes successfully, the field turns from green to blue and 
the next field turns green. When all actions on a record are completed 
successfully, the entire record turns blue. If an action fails, the entire 
record turns red or yellow according to the severity of the error.

12 If there are records to execute for Passports in another Passport group, 
go back to step 5 to select these records, re-authenticate, and execute 
them.

13 If you wish to execute the records again, select the records to be 
executed, choose Reset from the record list pop-up menu, and start back 
at step 9 to re-execute the records.
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Loading a Network Activation File
Load an existing Network Activation File (NAF) into the Network Activation 
(NA) record list to prepare the NAF for execution.

Procedure steps
1 Choose Load from the File menu in the Network Activation main 

window.

The Load NAF dialog opens. See also: “Load NAF dialog” (page 194).

If there are any records displayed in the record list, a confirmation dialog 
opens and prompts you for permission to clear entries in the record list 
before loading the NAF.

2 Specify the NAF to load in one of the two following ways:

• Enter the full path of the file in the Network Activation File field.

• In the Filter field, enter the full path of the directory to be used as the 
starting point for finding the NAF to load. In the Directories panel, 
click on the name of the appropriate subdirectory. In the Files panel, 
click on the name of the NAF to load. The name of the file you have 
selected appears in the Network Activation File field.

3 Click Load.

The Load NAF dialog closes and the records from the NAF are loaded 
into the record list.
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Modifying Passport Preferences
Use this procedure to change or set Passport Preferences, which are the 
default values that are used for a new Passport record.

Procedure steps
1 Choose Passport Preferences from the Options menu in the Network 

Activation main window.

The Passport Preference dialog opens. See “Passport Preference 
dialog” (page 201).

2 Change the appropriate preferences for the target View and the actions 
to be performed. One of the four actions must be selected for the record 
to be valid. 

• If Run pre-activation scripts is selected, you can add one or more 
pre-activation scripts to this record. See “Creating or modifying the 
script lists” (page 168).

• If Run post-activation scripts is selected, you can add one or more 
post-activation scripts to this record. “Creating or modifying the script 
lists” (page 168).

3 Click OK to close the Passport Preferences dialog.

4 If you want to save these preferences for future use, choose Save 
Preferences from the Options menu.
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Adding new Network Activation records
Add any new Network Activation (NA) records to the record list so they can 
be processed (activated and committed) for the desired modules in a network.

Procedure steps
1 If the record list is empty the Network Activation main window, go to 

step 4.

2 Click on a record.

The entire record becomes highlighted to indicate that it is selected. Any 
new record is added immediately below the record that is selected 
(highlighted). If you want to re-order the records, see “Up and down arrow 
buttons” (page 190).

3 Select Add Passport Record... from the Edit menu or from the record list 
pop-up menu.

The Passport Edit dialog opens. See also “Passport Edit dialog” 
(page 197).

4 Enter the module name and target View, and specify the actions to be 
performed.

• If Run pre-activation scripts is selected, you can add one or more 
pre-activation scripts to this record. See “Creating or modifying the 
script lists” (page 168)

• If Run post-activation scripts is selected, you can add one or more 
post-activation scripts to this record. See “Creating or modifying the 
script lists” (page 168).

5 Click OK to add the new record to the record list.

The new record appears after the currently selected record in the NAT 
window.

6 Repeat this procedure, once for each new record to be added to the 
record list.

You are now ready to save the records to a NAF or to execute the NA records 
in the record list.
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Modifying a single Network Activation record
You can modify a single Network Activation (NA) record using the Edit 
Passport dialog if you want to specify different data or actions for the record.

Procedure steps
1 Double-click on the record to be modified in the Network Activation main 

window; or, select the record and choose Edit from record list pop-up 
menu.

The Passport Edit dialog opens if the record is a Passport NA record.

2 Modify the data in the record.

For more information, see “Passport Edit dialog” (page 197).

3 Modify the target view and specify the actions. One of the four actions 
must be selected for the record to be valid.

• If Run pre-activation scripts is selected, you can add one or more 
pre-activation scripts to this record. See “Creating or modifying the 
script lists” (page 168)

• If Run post-activation scripts is selected, you can add one or more 
post-activation scripts to this record. “Creating or modifying the script 
lists” (page 168).

4 Click OK to apply the changes.

You are now ready to save the changes to a NAF or to execute the NA records 
in the record list.
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Modifying several records using the Passport Preference 
dialog

You can modify several records at once using the Passport Preference dialog. 
If you choose to modify several records by means of the Passport Preference 
dialog, you can change all the information, except the module name. If you 
wish to change the module name, you need to edit each record individually.

Procedure steps
1 Modify the Passport Preferences (see "Modifying Passport Preferences" 

on page 164).

2 In the NA record list, click on each of the records to which the preferences 
are to be applied. 

Each record becomes highlighted to indicate that it is selected.

3 From the record list pop-up menu, choose Use Preferences.

All the selected records now have the same data values as defined in the 
Passport Preference dialog. 

You are now ready to save the changes to a NAF or to execute the NA records 
in the record list.
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Creating or modifying the script lists
You can create or modify the script lists for a Passport record or for the 
Passport Preferences using the NAT Edit Script dialog. See the following 
procedures:

• “Adding scripts to the script list” (page 168)

• “Deleting scripts from the script list” (page 169)

• “Replacing scripts in the script list” (page 169)

• “Changing the order of scripts in the script list” (page 170)

Adding scripts to the script list
Add pre- or post activation scripts to a Passport record or the Passport 
Preferences to run more activation scripts.

Procedure steps
1 From the Passport Preferences or Passport Edit dialog, select the Edit 

button beside the action Run pre-activation scripts or Run post-
activation scripts to add or modify the script list.

The NAT Edit Script dialog opens. See “NAT Edit Script dialog” 
(page 202).

2 Select the Browse button and use the file dialog to select a script or enter 
the script in the Name data entry field.

3 Enter any command line options required for the script in the Options 
data entry field.

4 Select Add to add the script and options to the list of scripts in the top text 
area.

The new script appears at the end of the list.

5 Repeat the steps once for each new script to be added to the script list.

Note:  If you want to replace the script lists contained in every record in 
the NA Record list with the current script list defined in the top text area, 
select Apply to current Passport records. This is available only from the 
Passport Preferences dialog.

6 Click OK to add the script list and close the NAT Edit Script dialog.
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Deleting scripts from the script list
You can delete scripts from the pre-activation script list or post-activation 
script list if the scripts are no longer required.

Procedure steps
1 From the Passport Preferences or Passport Edit dialog, select the Edit 

button beside the action Run pre-activation scripts or Run post-
activation scripts to modify the script list.

The NAT Edit Script dialog opens.

2 Select the script to be deleted in the script list.

The entry is highlighted when selected.

3 Select the Delete button.

Note:  If you want to replace the script lists contained in every record in 
the NA Record list with the current script list defined in the top text area, 
select Apply to current Passport records. This is available only from the 
Passport Preferences dialog.

4 Click OK to delete the script list and close the NAT Edit Script dialog.

Replacing scripts in the script list
You can replace scripts in the pre-activation script list or post-activation script 
list with new scripts.

Procedure steps
1 From the Passport Preferences or Passport Edit dialog, select the Edit 

button beside the action Run pre-activation scripts or Run post-
activation scripts to modify the script list.

The NAT Edit Script dialog opens.

2 Select the script to be replaced in the script list.

The entry is highlighted when selected.

3 Modify the Name data field or Options data field as required.

4 Select the Replace button.

Note:  If you want to replace the script lists contained in every record in 
the NA Record list with the current script list defined in the top text area, 
select Apply to current Passport records. This is available only from the 
Passport Preferences dialog.

5 Click OK to replace the script list and close the NAT Edit Script dialog.
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Changing the order of scripts in the script list
You can change the order of scripts in the pre- or post-activation script list if 
you wish to run them in a different order.

Procedure steps
1 From the Passport Preferences or Passport Edit dialog, select the Edit 

button beside the action Run pre-activation scripts or Run post-
activation scripts to modify the script list.

The NAT Edit Script dialog opens.

2 Select the script to be moved in the script list.

The entry is highlighted when selected.

3 Select the Up arrow or Down arrow to move the script up or down in the 
list.

Note:  If you want to replace the script lists contained in every record in 
the NA Record list with the current script list defined in the top text area, 
select Apply to current Passport records. This is available only from the 
Passport Preferences dialog.

4 Click OK to change the order of the script list and close the NAT Edit 
Script dialog.
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Clearing all records from the record list
Clear all records from the record list in the Network Activation main window 
if you are finished with them.

Procedure steps
1 From the Edit menu, select Clear.

A dialog opens prompting you to confirm that you wish to remove all of the 
records from the record list.

2 Click OK.

The confirmation dialog closes and all records are cleared from the record 
list.
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Deleting individual records from the record list
Delete individual records from the record list in the Network Activation main 
window if there are no longer needed.

Procedure steps
1 In the record list, click on each record that you wish to delete.

Each record becomes highlighted to indicate that it is selected.

2 From the record list pop-up menu, select Delete.

A dialog opens prompting you to confirm that you wish to remove the 
selected records from the record list.

3 Click OK.

The confirmation dialog closes and the selected records are deleted from 
the record list.

You are now ready to save the changes to a NAF or to execute the NA records 
in the record list.
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Saving to a Network Activation File
Use the following procedures to save records in the record list to a Network 
Activation File (NAF). Two commands are available for saving new or 
modified records from the record list to a NAF: Save and Save As... The 
command to use depends on whether you loaded a NAF and whether you 
want to save the record list to an existing NAF or to a new NAF.

Saving records to a NAF that is loaded into the record list

Procedure steps
1 Select Save from the File Menu.

Note:  The Save command is disabled if you haven’t loaded a NAF or if 
no changes have been made to the record list.

The changes are saved to the NAF you loaded.

Saving records to a NAF when you haven’ t loaded one, or to 
a NAF other than the one you loaded

Procedure steps
1 Select Save As from the File menu.

The Save NAF dialog opens. See also: “Save NAF dialog” (page 196).

2 Specify the NAF file name in one of the two following ways:

• Enter the full path of the file in the Network Activation File field.

• In the Filter field, enter the full path of the directory to be used as the 
starting point for saving the NAF. In the Directories panel, click on 
the name of the appropriate subdirectory. In the Files panel, click on 
the name of the NAF to save the file as. The name of the file you have 
selected appears in the Network Activation File field.

3 Click OK.

The dialog closes and the contents of the record list are saved to the 
specified NAF.
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Executing a Network Activation File using the command 
line 

To execute a Network Activation File (NAF) from the command line, do the 
following:

1 Create the NAF. You can do this with the GUI of the NAT or with an editor 
such as vi. To reduce the possibility of error, we recommend that you use 
the GUI instead of an editor for performing this task. 

For information about the structure of a NAF, see “Network Activation File” 
(page 179).

2 Execute the NAF from a Unix window, by running the natcmd command 
to process the NAF.

See “NAT command line interface” (page 174) for the syntax of the 
natcmd utility.

Note 1:  The command line tool exits when a script returns an error (that 
is, returns 1). The command line tool continues when a script return 
success (that is, returns 0), or a warning (that is, returns > 1).

Note 2:  Scripts cannot invoke a GUI when using the command line.

NAT command line interface 
The NAT provides the user a command line to process the NAF. It can be 
invoked from a UNIX window. The syntax of the command is as follows:

/opt/MagellanNMS/bin/natcmd -f <NAF_filename> \
[-auth <passport_group_name> <userid> <password>] \
[-logfile [<log_filename>]] \
[-np <number_of_processes>] \
[-wd <working_dir>] \
[-quiet]
[-h]

where:

-f is the keyword to specify a Network Activation File (NAF). This 
keyword needs to be followed by the <NAF_filename> parameter.

<NAF_filename> is the full path name of the NAF file that contains the 
records to be executed.
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-auth is the keyword to specify Passport group authentication. This 
keyword needs to be specified if the NAF contains Passport NA records. 
When specified, this keyword needs to be followed by the <group_name>, 
<userid>, and <password> parameters.

<group_name> <userid> <password> is the name of the Passport 
group, the userid, and the password to log on to switches in the Passport 
group.

-logfile is the keyword to specify that log information is to be written to 
a log file. If this keyword is specified without the <log_filename> option, log 
information is written to the file 
$HOME/nat<pid>.<yy><mm><dd>_<hh><mm><ss>.log 
For example: /u/thawkes/nat106.970311_110201.log. 
See “Date Convention” (page 28) for more information on the date format.

<log_filename> specifies the full pathname of the log file.

-np is the keyword to indicate the number of processes to run. When 
specified, this keyword needs to be accompanied by the 
<number_of_processes> parameter.

<number_of_processes> specifies the number of records that can be 
executed simultaneously. The default is 1. The number to specify depends on 
the amount of memory available on the workstation. The higher the number, 
the more memory is used.

-wd is the keyword to specify the working directory for storing the default 
log file and other intermediate working files. When specified, this keyword 
needs to be accompanied by the <working_dir> parameter.

working_dir specifies the full path name of the working directory for 
storing the default log file and other intermediate working files.

-quiet specifies that records in the NAF are to be executed without 
producing messages or storing execution log information in a log file.

[-h] provides help information for the natcmd.
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Using a Cron job
Because the NAT command line starts up all the session servers (cmcfun and 
CM), you can invoke the NAT command line by using the Unix cron facility.

To set up a cron:

• You need to set a value for the EDITOR environment variable. If none is 
set, we suggest setting it to vi by entering the command setenv EDITOR 
vi.

• If file /etc/cron.d/cron.allow exists, the root user account needs to be 
listed in it.

• The root user account cannot be listed in file /etc/cron.d/cron.deny.

To set up a cron, do the following:

1 Open the crontab file for editing, with the default editor set with 
environment variable EDITOR:

crontab -e

The current crontab file opens for editing.

2 Add an entry in the following form to the file:

<minute> <hour> <day> <month> \ 
/opt/MagellanNMS/bin/natcmd <parameters>

where:

<minute> is a value from 0 to 59.

<hour> is a value from 0 to 23.

<day> is a value from 1 to 31.

<month> is a value from 1 to 12.

<parameters> are parameters of the natcmd as 
described in “NAT command line interface” (page 174).

3 Save the crontab file and exit from it. If your editor is vi, press Esc and 
enter the following command to do this:

:wq!

The file is now saved and is ready to be executed automatically.
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Example
The following entry in the crontab file executes a NAF called mynaf in the 
root (/) directory, at 0200 hours (2 AM), March 11, 1997. Because the NAF 
only contains Passport NA records applicable to a Passport group called west, 
the command includes the Passport group name, userid, and password needed 
to log on to Passport switches in the group. The command also outputs the 
logs in file /tmp/mylogfile.

00 2 11 3 /opt/MagellanNMS/bin/natcmd -f /mynaf -auth 
west

myid xys2 -logfile /tmp/mylogfile 
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The Network Activation tool
The Network Activation Tool (NAT) simplifies and automates the activation 
process for multiple modules in a network. You can use the NAT to activate a 
View and commit a View. You can perform the activation and commit 
operations interactively or in batch mode. You can also use the NAT to 
automatically run pre- or post-activation scripts. See “Pre- and Post-
activation scripts” (page 181).

There are two interfaces for the NAT:

• a graphical user interface

See “Network Activation main window” (page 184).

• a command line interface

See “NAT command line interface” (page 174).

The module type, module name or View name, and actions for network 
activation are stored in a Network Activation File (NAF). The graphical user 
interface lets you create or modify the NAF. To reduce the possibility of error, 
we strongly recommend that you use the graphical user interface for creating 
or modifying a NAF instead of using an editor like vi.

For a description of the fields in a NAF, see “Network Activation File” 
(page 179).
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Network Activation File
The Network Activation file (NAF) is used as the input file for both the 
command line and the GUI. We recommend that you use the GUI to create or 
edit the NAF, in order to ensure its syntactic and logical correctness (although 
it can be edited using any text editor).

Each NA record in the NAF is defined in a single line. Each record specifies 
the module type, module name, the target View, a set of actions, and 
associated parameters. The syntax of a record in a NAF is as follows:

-[em] <module_name> 
-sdfile <mode> <name> 
[-critical]
[-activate] 
[-commit] 
[-noPause|-pause]
[-timeout <minutes>]
[-verify_date] 
[-pre] [-pre_scr <script_list>]
[-post] [-post_scr <script_list>]
[# comments]

Note: Although we have presented the fields on different lines in this 
document, all of the fields in a NAF record are part of the same line. 

where:

-em indicates an NA record for a Passport module.

<module_name> is the name of the Passport module.

-sdfile is the keyword for specifying the View name. When specified, 
this keyword needs to be followed by the <mode> and <name> parameters.

<mode> is one of keyed, dated, or user-specified.

<name> is the name of a valid key, a valid date in the format yymmdd, or 
a View name.

-critical indicates that the View is critical.
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-activate indicates that the View is to be activated.

-commit indicates that the View is to be committed.

-pause indicates that automatic pause is to be used. When this option is 
specified, a Pause option is passed to the activate command line and a pause 
is forced before the software migration .

-noPause indicates that automatic pause will be disabled. When this 
option is specified, a no Pause option is passed to the activate command line 
and the software migration activation does not pause before migration 
switchover.

-timeout indicates the activation timeout period. When specified, this 
keyword needs to be followed by the <minutes> parameter. When not 
specified, the timeout period defaults to 50 minutes.

-verify_date specifies that date verification is to be performed. When 
this option is specified, the date of the View is verified before activation to 
ensure that the date is later than that of the current View. The current View 
also needs to be assigned the Dated mode of activation. 

-pre is the keyword for specifying to run the pre-activation script. When 
this option is specified, this keyword is usually followed by the <-pre_scr> 
parameter.

-pre_scr <script_list> is a list of “\;” terminated commands 
representing the pre-activation scripts to be invoked and their command line 
arguments.

-post is the keyword for specifying to run the post-activation script. 
When this option is specified, this keyword is usually followed by the 
<-post_scr> parameter.

-post_scr <script_list> is a list of “\;” terminated commands 
representing the post-activation scripts to be invoked and their command line 
arguments.
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<#comments> are comments applicable to the record. Anything after a 
pound (#) sign is treated as a comment.

Sample of a Network Activation File
The following is a sample NAF:

-em ROME -sdfile keyed West1 -critical -activate -
commit -timeout 50 -pause -pre -pre_scr /opt/
MagellanNMS/cfg/macros/user/scr1 opt1 opt2 opt3 \; /
opt/MagellanNMS/cfg/macros/user/scr2 opt1 opt2 \; -
post -post_scr /opt/MagellanNMS/cfg/macros/user/scr3 
\; /opt/MagellanNMS/cfg/macros/user/scr4 opt1 \;

Pre- and Post-activation scripts
Pre-activation scripts verify and modify the Passport configuration before 
activation is performed and prevent activation if an error code is returned. 
Post activation scripts, executed after the activation, allow the activation to be 
verified, and return error conditions, if necessary. 

Multiple scripts can be configured, and scripts are executed one at a time. 
Scripts are logged in a temporary file during the execution of scripts, but then 
are merged into the NAT log file once the execution is completed. 

If a fatal error occurs in one of the pre-activation scripts, the process is 
stopped and the record turns red, indicating a major error. If a warning occurs, 
the process continues and the next (if any) scripts are run. 

If a fatal error occurs in a post-activation scripts, any remaining post-
activation scripts are not run, and the records turn yellow, indicating a minor 
error. If a warning occurs, the process continues and the next record (if any) 
is run. The record turns blue even if there are warnings, since the process did 
not fail. The log file indicates if a script has completed with warnings.

If a specified script cannot be run due to permissions or does not exist, the 
process stops and the record turns red, indicating a major error. See “Color 
indicators” (page 189). 

Pre- and post-activation script rules
Pre- and post-activation scripts must follow certain rules:

• the exit code must be 0 to be considered successful by the NAT
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• the exit code must be 1 to be considered fatal by the NAT

• an exit code of anything other than 0 or 1 is a warning

• logging must be performed on stdout for information or stderr for errors 
so the NAT can capture it

• node names and view names must be retrieved through an environment 
variable if not specified on the command line ($DNAME: module name 
(format: EM ROME) and $NAT_VIEWNAME: view-type viewname 
(where view-type can be KEYED, DATED, or USER_SPECIFIED)). 
The node name and view name are set from the data available in the NA 
record.

• NAT also provides access to the session “display” 
($NAT_SESSION_DISPLAY) and the real display 
($NAT_UI_DISPLAY).

• the scripts can invoke GUIs, but only when NAT is run in graphical 
mode.

The pre-activation scripts are run PRIOR to activation while post-activation 
scripts are run after the activation and commit, if a commit is specified. If a 
commit has not been specified, the commit should be invoked within one of 
the post-activation scripts.

For each activation record, scripts are run one at a time before or after 
activation. If a post-activation scripts fails, another script is not run for that 
record and a warning is issued. If a post-activation scripts ends with a 
warning, then the next remaining post-activation script is run for that record, 
and a warning is indicated in the log file for that record.

If you are using your own scripts, it is recommended that they be stored in:
/opt/MagellanNMS/cfg/macros/user directory. This directory is added to the 
PATH prior to script execution.

For customized module access, the GROUP connection management can be 
overridden with a customized script. The customized authentication script 
must be /opt/MagellanNMS/cfg/macros/user/NAT_authenticate. If the script 
is found, it is executed and returns a 0 on success. The script establishes the 
GROUP connection so NAT does not attempt to connect again. If the 
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customized script fails, the user is prompted for authentication information as 
before. The Group authenticate selection is still available from the Security 
menu, if the script exists.

NAT logs summary
The following logs are issued when scripts are run:

• Executing <script name>. Issued when a script is launched.

• <script name> has completed successfully. Successful execution.

• <script name> has completed but errors were found. Execution failed.

• <script name> has completed successfully with warnings. Successful 
execution with warning(s).

• <script name> could not be found. Execution failed.
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Network Activation main window
The Network Activation window contains a menu bar, a working area, and a 
Messages area. See the figure “Network Activation main window” 
(page 184).

Figure 14
Network Activation main window

The working area displays a list of Network Activation (NA) records and 
contains three buttons for rearranging the order of records in the list and for 
executing them. The Messages area is used to display status or error 
information.

See the following sections for information on the parts of the Network 
Activation main window:

• “Menu bar” (page 185)

• “Working area” (page 187)

• “Messages area” (page 192)
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Menu bar
The menu bar is located at the top of the Network Activation main window. 
See the following sections for information on the menu bar entries:

• “File menu” (page 185)

• “Edit menu” (page 185)

• “Options menu” (page 186)

• “Security menu” (page 186)

• “Help menu” (page 186)

File menu 
The File menu commands are as follows:

• Load loads records from a network activation file (NAF) into the record 
list. This command opens the Load NAF dialog in which you specify the 
NAF to load. If the record list has any records displayed in it, a 
confirmation dialog opens and prompts for permission to clear the list 
before loading the NAF.

• Save saves new or modified records to a NAF. If there are no additions or 
changes in the record list to be saved, or if you have not loaded a NAF, 
this command is disabled (grayed out).

• Save As saves records to a specified NAF. This command opens the Save 
NAF dialog for specifying the full path name of the NAF. If there are no 
entries in the record list, this command is disabled.

• Exit closes all windows and closes the tool.

Edit menu 
The Edit menu commands are as follows: 

• Add DPN Record is not applicable to a Passport module.

• Add Passport Record adds a Passport record to the record list. This 
command opens the Passport Edit dialog for entering the data. The new 
record is added after the record that is being pointed at (the record 
surrounded by the box with a dashed line).
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• Clear removes all records from the record list. If the list has been 
modified but not saved, a confirmation dialog opens to obtain 
confirmation of the clear.

Options menu
The Options menu commands are as follows:

• DPN Preferences opens the DPN Preference dialog. This dialog is not 
applicable to a Passport module.

• Passport Preferences opens the Passport Preference dialog. This dialog 
is used for entering the preferred values for a new Passport record.

• Save Preferences saves, for future sessions, any changes you made in the 
Passport Preference or DPN Preference dialogs.

Security menu 
The Security menu commands are as follows:

• Group Authenticate opens the Passport Group Authentication dialog to 
perform authentication for accessing a group of Passport modules. 
Although you can authenticate with more than one group, only the last 
group you authenticated with is active. 

• NCS Authenticate opens the DPN Authentication dialog. This dialog is 
not applicable to a Passport module.

Help menu
The Help menu commands are as follows: 

• On Context lets a user obtain help information for an item in the NAT 
main window. Choosing this command changes the cursor to a question 
mark. Moving the question mark to an item in the window and clicking 
the select button provides help information about the item selected.

• On Help displays help text about how to use the help facility. 

• On Window displays help text about the application main window and its 
general contents. 
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• On Keys displays help text about the function keys, mnemonics, and 
keyboard accelerators. The accelerators are as follows:

Ctrl + L = Load

Ctrl + S = Save

Ctrl + A= Save As

Ctrl + E = Exit

Ctrl + G = Group Authenticate

Working area
The working area of the NAT contains a Network Activation (NA) record list 
that uses color indicators to indicate the status of network activation. The 
record list also supports a pop-up menu and contains three action buttons. For 
descriptions of these items, see:

• “NA record list” (page 187)

• “Color indicators” (page 189)

• “Pop-up menu” (page 190)

• “Up and down arrow buttons” (page 190)

• “Execute button” (page 191)

NA record list
The NA record list displays Network Activation (NA) records. The content of 
the records and their order in the list can be modified using commands and 
action buttons. See also:

• “Pop-up menu” (page 190)

• “Up and down arrow buttons” (page 190)

• “Execute button” (page 191)

You can select a set of records in the NA record list for execution. While 
execution is in progress, fields in the records change color to indicate the 
execution status. See also: “Color indicators” (page 189). 
Preside MDM Configuration Management for Passport User Guide   14.3RSUP



188   Chapter 5 Network Activation
The NA record list contains the following fields:

• CR indicates (YES|NO) whether the View is critical. 

Critical records are executed first, one at a time, in the order in which they 
appear in the list. Then the non-critical records are executed. If a critical 
record cannot be executed, the tool stops and does not execute the next 
record.

• Module displays the module name in the format EM/<Passport name>. 
Module names that begin with PM are not applicable to Passport.

• MCF/View Mode indicates the method used for accessing the View. The 
mode is one of:

K access with a key

D access by date

U access according to a user-specified information

• MCF/View Name indicates the name of the key, the date, or the View used 
for activation or committing.

• NMS Disk is not applicable to a Passport module and is always set to “-”.

• RDS/SDS is not applicable to a Passport module and is always set to “-”.

• Date Verify indicates whether date verification is to be performed on a 
View that is to be activated by date. When Date Verify is set to YES, the 
date of the View is checked against the date of the current View. If the 
View has a dated key that predates the current View, activation fails and 
the record turns red. 

• Loaders Commit is not applicable to a Passport module and is always set 
to ‘-’.

• MCF/View PreAct indicates whether pre-activation scripts are to be run.

• MCF/View Act indicates whether the View is to be activated.
241-6001-023   14.3RSUP   



Chapter 5 Network Activation   189
• MCF/View -Pause indicates whether the automatic pause is to be used. 
When -Pause has the value “-”, it means that no option is passed to the 
activate command line. When -Pause is set to YES, a -Pause option is 
passed to the activate command line. When -Pause is set to NO, a 
-noPause is passed to the activate command line.

• MCF/View Commit indicates whether the View is to be committed.

• MCF/View PostAct indicates whether post-activation scripts are to be 
run.

The NA record list is a multi-select list, which means you can select more 
than one record at a time. 

The NA record list also supports double-clicking. Double-clicking on a 
record that has not been executed selects the record and opens a dialog for 
viewing or editing the record. Double-clicking on a record that has been 
executed selects the record and opens a dialog that displays log information 
about execution of the record.

Color indicators
Different colors are used to indicate the status of the NA records. The colors 
and their meanings are as follows:

• No color means the record is ready for execution.

• Blue means the record has been executed successfully.

• Green means execution is in progress. When a specific action is being 
performed, the corresponding field turns from blue to green. If the action 
completes successfully, the field turns from green to blue and the next 
field turns green. When all actions on a record are completed 
successfully, the entire record turns blue. If an action fails, the entire 
record turns red or yellow, according to the severity of the error.

• Yellow means that a minor error was found during execution or that 
execution was interrupted by the user.

• Red means a major error was found during execution. This record can 
only be re-executed if the user resets the state manually. 
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After execution is complete, a user can reset the color of the records back to 
no color in preparation for re-execution by means of the Reset command. This 
command is available in the record list pop-up menu.

Pop-up menu
The record list is equipped with a pop-up menu that contains the following 
commands:

• Edit opens the Passport Edit dialog for viewing or editing a record that is 
selected in the record list. The module name cannot be changed during 
the edit.

• Use Preferences applies values that were pre-defined in the Passport 
Preference dialog to records that are selected in the record list.

• Add DPN Record is not applicable to a Passport module.

• Add Passport Record opens the Passport Edit dialog for entering a new 
Passport record. The new record is added after the highlighted record. 

• Delete deletes records that are selected from the NA record list. A 
confirmation dialog opens and prompts for permission to perform the 
deletion.

• Show Status opens a dialog that shows execution information for a record 
that is selected in the NA record list. This command is only enabled if the 
record has been executed.

• Reset changes the state of selected records bask to their initial state then 
deselects the records. This allows the records to be re-selected and re-
executed, regardless of their previous state.

• Select All selects all records in the NA record list.

• Deselect All deselects all selected records.

Up and down arrow buttons
The up arrow button moves records that are selected in the NA records list 
upwards towards the top of the list. The down arrow button moves them 
downwards. You can select more than one record at a time to move up or 
down.
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The up and down arrows are especially useful for rearranging records to 
change their execution order, or for reducing the number of times you need to 
authenticate to execute all of the records in the record list.

Critical records in the record list are always executed first, one at a time, in 
the order in which they appear in the list, followed by the non-critical records. 
You can rearrange the critical records with the arrows to specify the order in 
which the critical records, followed by the non-critical records, are executed.

With the Network Activation Tool, you can only execute records for Passports 
in one Passport group at a time. On occasion, records may apply to modules 
that belong to different Passport groups. To execute all of the records, you 
have to authenticate with the Passport groups as needed. You can use the 
arrows to group all the records for one Passport group together, minimizing 
the number of times you need to authenticate.

The up and down arrows are disabled unless at least one record is selected in 
the list.

Execute button
The Execute button executes the records that are selected in the NA record 
list.

When you click Execute, a confirmation dialog opens and displays the list of 
modules on which the actions are to be performed, prompting for 
confirmation. For more information, see “Confirmation dialog” (page 208).

Clicking OK in the confirmation dialog opens an Execution dialog for 
specifying the parameters for the execution. Once you have set up the 
execution parameters in the Execution dialog, clicking on the Execute button 
starts execution of the records. For more information, see “Execution dialog” 
(page 205). 

When execution of a record begins, the entire record turns blue. Then, as each 
step in the execution takes place, the field associated with the step turns from 
blue to green. If the step is successful, the field turns from green to blue, and 
the next field turns green. If all steps in are executed successfully for a record, 
the entire record turns blue. If a step fails, the entire record turns red or yellow, 
according to the severity of the failure.
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While execution is underway, the Execute button is replaced by a Stop button 
that can be used to halt execution. Halting execution turns the record in which 
execution was halted to yellow and launches the Processing dialog (see 
“Processing dialog” (page 207).

Records in the record list are executed as follows:

• Red, yellow, or blue color records are not executed.

• Critical records are executed first, one at a time, in the order in which they 
appear in the record list.

• Non-critical records are executed after critical records, also in the order 
in which they appear in the list.

• If execution of a critical View fails, the tool stops and does not execute 
the next record.

• Records are only executed for the Passport group whose authentication 
is currently active. That is, the group that has most recently been 
authenticated by selecting Group Authenticate... from the Security menu.

Messages area
The Messages area displays execution status information and error messages. 
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Network Activation dialogs
See the following sections for information on Network Activation dialogs:

• “Load NAF dialog” (page 194)

• “Save NAF dialog” (page 196)

• “Passport Edit dialog” (page 197)

• “Passport Preference dialog” (page 201)

• “NAT Edit Script dialog” (page 202)

• Group Authentication dialog, see “Authentication dialog” (page 31).

• “Execution dialog” (page 205)

• “Processing dialog” (page 207)

• “Confirmation dialog” (page 208)

• “Log information dialog” (page 209)

• “Error dialog” (page 209)

• “Warning dialog” (page 209)

• “Pause dialog” (page 210)

The following dialogs can be accessed from Network Activation, but are not 
applicable to Passport:

• DPN Edit dialog

• DPN Preference dialog

• NCS Authentication dialog
Preside MDM Configuration Management for Passport User Guide   14.3RSUP



194   Chapter 5 Network Activation
Load NAF dialog
The Load NAF dialog lets you specify the name of a NAF file that contains 
records to be loaded into the NA record list. See the figure “Load NAF 
dialog” (page 194).

Figure 15
Load NAF dialog

The dialog contains the following items:

• a Filter field for specifying the path to the directory that is to be used as 
a starting point for finding the NAF to load

The subdirectories of the directory specified in this field are displayed in 
the Directories panel of the dialog when you enter a carriage return in 
this field, or when you click the Filter button.

• a Directories panel for displaying the available subdirectories of the 
directory specified in the Filter field

• a Files panel for displaying the available files of the directory selected in 
the Directories panel
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• a Network Activation File field for specifying the full path name of the 
NAF to be loaded

You can specify the name of a NAF to be loaded in one of two ways: by 
entering its full path name in this field; or, by entering information in the 
Filter field, selecting a directory in the Directories panel, and selecting a 
file in the Files panel.

• a Load button for loading the NAF specified in the Network Activation 
File field into the NA record list

• a Filter button for updating the Directories panel, the Files panel, and the 
Network Activation File field according to the pathname entered in the 
Filter field

• a Cancel button for aborting the load and closing the dialog

• a Help button for displaying help information about the dialog
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Save NAF dialog
The Save NAF dialog lets you specify the full path name of a NAF in which 
to save new or modified records from the NA record list. See the figure “Save 
NAF dialog” (page 196).

Fields, panels, and buttons in the dialog are similar to those in the Load NAF 
dialog. See also: “Load NAF dialog” (page 194).

Figure 16
Save NAF dialog
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Passport Edit dialog 
The Passport Edit dialog lets you specify the information and actions for a 
new Passport record that is to be added to the NA record list, or to modify an 
existing Passport record that is selected in the NA record list. Information in 
the dialog applies to one View. See the figure “Passport Edit dialog” 
(page 197).

Figure 17
The Passport Edit dialog

Double-clicking on an existing Passport record opens the Passport Edit dialog 
that contains the data from the record. From this dialog, you can change any 
parameters and actions, except the module name displayed in the EM field.
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If you select Add Passport Record from the File menu or from the NA record 
list pop-up menu, the Passport Edit dialog opens with the data defined in the 
Passport Preference dialog and the EM field empty. If no preferences have 
been set, the following defaults are used:

EM data entry field Empty

Critical NO

Keyed NO

Dated NO

User Specified YES

Data entry field Empty

Check against current view NO

Run pre-activation scripts NO

Activate NO

-noPause NO

-pause NO

Commit NO

Run post-activation scripts NO

Confirm Retry 5

Comments Empty
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The Passport Edit dialog contains the following items:

• an EM data entry field for specifying the Passport module name 

If you are editing an existing record, the EM field displays the Passport 
module name associated with the record you are editing. You cannot 
modify this name while editing an existing record.

• a Passport View Parameters panel for specifying parameters associated 
with the target Passport View, which consists of:

— A Critical check button to indicate whether the action to be executed 
is critical or non-critical

— a set of radio buttons labelled Keyed, Dated, and User specified, and 
a data entry field, which together specify the View access mode.
If you select Keyed, the label of the data entry field changes to Key 
and you need to enter the name of a valid key for the Passport view.
If you select Dated the label changes to Date and you need to enter 
date for the Passport view in the format yymmdd. If Dated is selected 
as a preference in the Passport preference dialog, the current date 
appears in the field. However, if Date is not selected as a preference 
and you click Dated, the Date field appears but is blank. To put the 
current date into the Date field, click the Dated radio button again. 
See “Date Convention” (page 28) for more information on the date 
format.
If you select User specified, the label changes to View and you need
to enter a valid View name.

— a check button labelled Check against current view for specifying 
whether the date is to be verified against the date of the current View 
before activating or committing.
If you select this button, the date of the View is verified against the
date of the active View. 
If the date specified is earlier than that of the active View, execution 
of the record fails.
This check button is only enabled when the Dated mode is selected.

• a check button labelled Run pre-activation scripts for specifying if pre-
activation scripts will be run.

• an Edit button that opens the Edit Pre-activation scripts dialog for 
creating or editing the pre-activation scripts.
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• a check button labelled Activate for specifying if the activate action is to 
be performed

• a check button next to the Activate button, labelled -noPause. Checking 
the -noPause option disables the automatic pause that typically occurs 
before a migration switchover during a hitless software migration.

• a check button next to the noPause button, labelled -Pause. Checking the 
-Pause option enables the automatic pause that typically occurs before a 
migration switchover during a hitless software migration.

• a set of check button labelled Commit for specifying if the commit action 
is to be performed

• a check button labelled Run post-activation scripts for specifying if post-
activation scripts will be run.

• an Edit button that opens the Edit Post-activation scripts dialog for 
creating or editing the post-activation scripts.

• a data entry field labelled Confirm Retry for specifying the retry times for 
confirmation

• a text area labelled Comments for adding user comments

• a text area labelled Messages for displaying messages about attempts to 
add or modify information in the dialog

• an OK button that is used to add or replace the record in the list and close 
the dialog

If you fail to enter information in a required field, an error icon (X) 
appears beside the corresponding field in the dialog and a message 
indicating the nature of the error appears in the Messages panel. You 
need to enter the correct information in the field before the dialog will 
close and the record can be added or saved.

• a Cancel button that closes the dialog without saving any additions or 
changes

• a Help button that displays help information about the dialog
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Passport Preference dialog 
The Passport preference dialog lets you specify:

• the default data to be used for adding a new Passport NA record to the 
record list

• the values to apply to records that are selected in the record list when you 
choose the Use Preferences command from the record list pop-up menu

The Passport preference dialog is identical to the Passport Edit dialog, except 
that:

• The EM field and the Comments and Messages text fields are absent.

• The OK button sets the preferences values for the current session and 
closes the dialog.

See also: “Passport Edit dialog” (page 197).
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NAT Edit Script dialog
The NAT Edit Script dialog lets you enter script names with command-line 
arguments in a specified order in which the scripts will be executed. This 
dialog is invoked from the Passport Record dialog or the Passport Preferences 
Dialog.

For a new record, the NAT Edit Script dialog opens with the data defined in 
the Passport Preference dialog. If preferences have not been set, defaults are 
used. 

If the NAT Edit Script dialog is opened from the Passport Preferences dialog, 
then there is an additional button called Apply to current Passport records. 
When this button is selected, the script list contained in every record in the 
NA record list is replaced with the current script list defined in the top text 
area.

The NAT Edit Script dialog contains the following items:

• a text area listing the command line for each script selected to be run

• a Name data entry field for specifying the complete path name of the 
script (the default is empty)

• an Options data entry field for specifying the command line option for 
the script (default is empty)

• a Browse button that opens a File dialog for searching and selecting a 
script. You can use the Browse button to select the script name instead of 
typing it in the Name Data Entry field

• An Add button that is enabled when the Name field is not empty. The 
Add button causes the script name and options in the Option field to be 
added to the list of scripts.

• A Delete button that is enabled when a script is selected in the list of 
scripts at the top text area. The Delete button causes the script to be 
deleted from the list of scripts.

• A Replace button that is enabled when a script is selected in the list of 
scripts at the top text area and the Name field is not empty. The Replace 
button causes the selected script to be replaced by the script and options 
in the Name and Options data fields.
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• An Up arrow button that moves a script that is selected in the script list 
up towards the top of the list. The Up arrow button is disabled unless a 
script is selected that is not at the top of the list.

• An Down arrow button that moves a script that is selected in the script 
list downwards to the bottom of the list. The Down arrow button is 
disabled unless a script is selected that is not at the bottom of the list.

• An Apply to current Passport records button (only available when opened 
from the Passport Preferences dialog) that is used to replace the script list 
contained in every NA record with the current script list defined in the top 
text area of the dialog.

• An OK button that is used to update the script list in the record and close 
the dialog.

• A Cancel button that closes the dialog without making any additions or 
changes.

• A Help button that displays help information about the dialog.
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Figure 18
NAT Edit Script dialog
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Execution dialog
The Execution dialog lets you specify parameters such as the working 
directory and the number of processes for executing NA records. See the 
figure “Execution dialog” (page 205).

Figure 19
Execution dialog

The Execution dialog contains the following items:

• a Working Directory field for specifying the directory for storing working 
files that are created while the tool is running. 
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• a Number of Processes field for specifying the number of non-critical 
records in the list on which execution can be performed simultaneously. 
The default is 1.

The number to specify depends on the amount of memory available on 
the workstation. The higher the number, the more memory is used.

This parameter only applies to non-critical records. For critical records, 
only one record is executed at a time, regardless of the number you 
specify for this parameter.

• a Log to File check button for specifying whether information about the 
execution is to be captured in a log file

If this button is not selected the panels, fields, and buttons in the log file 
specification area are disabled (grayed out). The default is no log file.

• a Log File specification area that is used to specify the full path name of 
a log file for log messages that are produced during the execution. 

The log file specification area consists of the following items:

— a Filter field for specifying the path to the directory that is the 
starting point for choosing the directory in which to store the log file 
The subdirectories of the directory specified in this field are 
displayed in the Directories panel when you enter a carriage return 
in this field or when you click the Filter button.

— a Directories panel for displaying the available subdirectories of the 
directory specified in the Filter field

— a Files panel for displaying the available files of the directory 
selected in the Directories panel

— a Log File Name field for specifying the full path name of the log file 
to be stored
You can specify the name of a log file in two ways: by entering its 
full path name in this field; or, by entering information in the Filter 
field, selecting a directory in the Directories panel, and selecting a 
file in the Files panel. The default is nat.log in the user’s home 
directory.
241-6001-023   14.3RSUP   



Chapter 5 Network Activation   207
— a Filter button for updating the Directories panel, the Files panel, 
and the Log File field according to the pathname entered in the Filter 
field

• an Execute button for executing the action based on the information

• a Defaults button that resets all items in the dialog back to their default 
values

• a Cancel button that closes the dialog without performing the execution 
or saving the execution parameters

• a Help button that displays help information about the dialog

Processing dialog
The Processing dialog opens if you click on the Stop button in the Network 
Activation Tool window while execution is underway. This dialog displays 
the message Stopping all execution processes, please wait to indicate that no 
further user action is permitted until all execution software processes are 
terminated, at which time the dialog closes.
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Confirmation dialog
The confirmation dialog prompts you for confirmation before the software 
takes the next step:

• When you click Execute in the NAT window, the dialog displays 
information about the records to be processed and asks you for 
permission to continue.

• When you select Delete from the record list pop-up menu, the dialog 
prompts for confirmation to remove the selected record.

• When you select Exit without saving new Passport records to a NAF, the 
dialog asks if you really want to exit without saving.

Buttons in the dialog are as follows:

• OK continues the execution.

• Cancel closes the dialog without performing the execution.

• Help displays information about the dialog.

See the figure “Sample confirmation dialog for confirming execution” 
(page 208).

Figure 20
Sample confirmation dialog for confirming execution
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Log information dialog
The log information dialog displays status information for a record that has 
been executed. To display the information, double-click on an executed 
record in the record list; or, select the log in the record list and choose Show 
Status from the record list pop-up menu.

For an illustration of the Log information dialog, see the window “Sample log 
information dialog” (page 209).

Figure 21
Sample log information dialog

Error dialog
The Network Activation error dialog displays a message to indicate why an 
action cannot be performed. Once you have read the message, click OK to 
close the dialog. Then, correct the source of the error and try the action again.

Warning dialog
The Network Activation warning dialog displays a message to indicate the 
consequences of the action you are about to take. This dialog also prompts 
you for confirmation of the action.

Buttons in the dialog are as follows:

• OK closes the dialog continues the action.

• Cancel closes the dialog without performing the action.

• Help displays information about the dialog.
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Pause dialog
The Pause dialog displays a message to indicate why the software migration 
has been paused. This dialog also prompts you to confirm one of the 
following actions:

• Continue continues the software migration.

• Stop stops the software migration.
241-6001-023   14.3RSUP   



211
Chapter 6
Global Data Manager

This section describes the Global Data Manager command line tool and the 
procedures for using it. In this section, you can find the following 
information:

• “The Global Data Manager tool for Passport Devices (pgdm)” 
(page 211)

• “Starting the Global Data Manager tool” (page 212)

• “Pgdm input files and operations” (page 212)

• “The Global Data Manager command line” (page 218)

• “Cron job” (page 219)

• “Global Data Manager procedures” (page 220)

The Global Data Manager tool for Passport Devices (pgdm)
You can use the Global Data Manager tool to propagate global data 
components from a Passport switch to other selected Passports. Pgdm also 
replaces the attribute values for those components during propagation. In 
addition, pgdm can be used to replace the attribute values for selected 
Passports in the network.

By allowing data to be copied and propogated, pgdm enables you to provision 
global data and to replace attribute values globally. Pgdm performs these 
operations more quickly than Component Provisioning. Pgdm also reduces 
the risk of errors due to mistakes in keying in service data.
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Starting the Global Data Manager tool
Pgdm is started from a UNIX window. You can also invoke the pgdm 
command line directly through a cron job.

See also...

• “The Global Data Manager command line” (page 218)

• “Cron job” (page 219)

Pgdm input files and operations
When you use pgdm, the first thing you should do is create the two main input 
files, the component file and the module name file. The module name file 
contains the source and target Passports, and associated provisioning view to 
be loaded and saved. The component file specifies the data components to be 
propagated (such as Userid, Voice Networking Call Server [Vncs], and Voice 
Profiles [Vp]) and the attributes to be replaced. Based on information 
provided in both input files, pgdm determines the operation that needs to be 
performed.

See the table “Pgdm input files and operations” (page 212).

Table 2
Pgdm input files and operations

Module name 
file

Component file Operation

Source and 
target(s) 

Components 
only

Propagate the specified components 
from the source to the targets

 (Sheet 1 of 2)
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Also, an optional pre-propagate input file contains the on-switch add/set/
delete commands that are sent down to the target Passport before the 
propagation.

Module name file
The module name file specifies the source Passport where the data 
components are retrieved and the target Passports for propagating. You can 
use any type of NMS-supported upload (User specified, Commited, Current, 
Keyed, Dated) or download (User specified, Keyed, Dated) to determine the 
provisioning filename. The module name file consists of at least one target 
record. You do not need to specify the source record; otherwise, specify only 
one source record at a time. 

A record can span more than one line; a \ character is used as a line 
continuation indicator. You can also use comment lines (lines beginning with 
‘#’) in the module name file. 

Source Passport
The source Passport record is specified using the following format:

Source and 
target(s) 

Components 
and attributes

Propagate the specified components 
from the source to the targets. During 
propagation, the attribute values are 
replaced by the new values specified in 
the component file.

Target(s) only Components 
and attributes

Replace the attribute values for 
specified components. Save the 
modified view on the same Passport.

As result, the attribute values of 
specified component are the same for 
all selected targets.

Table 2  (continued)
Pgdm input files and operations

Module name 
file

Component file Operation

 (Sheet 2 of 2)
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-source <passport_name> -uploadmode [Current | Committed\ 

| Keyed <key> | Dated <date_key> | User_specified\ 

<view_filename>]

where:

-source uses <passport_name> to specify the name of the Passport where 
the global data is obtained.

-uploadmode specifies, by the keyword that follows, how to construct the 
name of the provisioning view to be loaded.

Note: If the source Passport is not specified, pgdm uploads the 
provisioning view from the target, applies the changes specified in the 
component file, and downloads the modified view back to the same 
target.

Target Passport
The target Passport records are specified using the following format:

-target <passport_1>...<passport_n> -uploadmode [Current\ 

| Committed | Keyed <key> | Dated <date_key> \

| User_specified <view_filename>] -downloadmode \

[Keyed <key>| Dated <date_key> | User_specified \ 

<view_filename>]

where:

-target uses the variables <passport_1>...<passport_n> to specify the 
names of Passports to which the global data are populated.

-uploadmode specifies, by the keyword that follows, how to construct the 
name of the provisioning view to be loaded.

-downloadmode specifies, by the keyword that follows, how to construct 
the name of the new provisioning view to be saved.
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Example
The following is an example of a module name file that can be used to 
propagate the global components from a source Passport to other selected 
Passports.

# Upload the Committed view from noder10.
-source noder10 -uploadmode Committed
# Propagate the specified components to noder16,
# noder17, noder18, node19, node20, and node21 using 
# the “myviewfile”. 
# The modified view is then saved using the NMS key.
-target noder16 noder17 noder18 node19 node20 node21 \
-uploadmode user_specified myviewfile -downloadmode
 Key NMS
# Also, propagate the specified components to noder10,
# noder11 using the NMS key.
-target noder10 noder11 -uploadmode Key NMS 
-downloadmode Key NMS

Component file
The component file specifies the components and their new attribute values. 
In general, a component and the attributes to be replaced can be specified 
using the following format:

<comp_1>{/<key>}... <comp_n>{/<key>} @<attr_1> 

<value>,...,<attr_n> <value>

where:

<comp_n> is the name of the component, for example, Vncs or Vp.

<key> is the component instance value. A wildcard (*) can be use to 
specify all   instances.

<attr_n> is the name of the attribute to be replaced.

<value> is the new attribute value of a specified attribute.
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The component file rules are as follows:

• If pgdm is used to replace attribute values globally (that is, no source is 
specified in the module name file), you need to specify the attribute name 
and its new value. 

• If pgdm is used to propagate a global data component, you can omit the 
attribute part.

• If the ancestors of Comp_n do not exist on the target Passport, an error 
message is generated during loading of the partial file by the target 
Passport.

• You need to enter the component and associated attribute values on one 
line.

Example
The figure “Vncs hierarchy” (page 216) shows the hierarchy of the 
VoiceNetworkingCallServer (Vncs) and VoiceProfile (Vp) components.

Figure 22
Vncs hierarchy

AC - Access Code
Dn - Data Network
Prof - Profiles
Vcns - Voice networking Call Server
Vp - Voice Profile

Root

Vncs/1 Prof

Vp/1
Ac/noAccessCode Ac/AccessCode 1 Ac/AccessCode 2

Dn/<n> Dn/<n>
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To propagate all Vncs components, type the following line in the component  
input file:

 Vncs/*

To propagate Vp/1, type the following line in the component input file:

Prof Vp/1

To propagate all Vp components, you can specify the following line in the 
component input file:

Prof Vp/*

Example
The component file contains the following three lines:

FrNni/* Dna @outDefaultPathReliability  
high,numberingPlanIndicator x121

FrNni/10 Dna @numberingPlanIndicator e164

Trk/* UnAcked @maximumErroredInterval 0

In this example the outDefaultPathReliability attribute value is set to high and 
the numberingPlanIndicator is set to x121 for all FrNni components. The 
exception is FrNni/10 where the numberingPlanIndicator is set to e164. Also, 
the maximumErroredInterval attribute of all Unacked Trk is set to 0.

Example
The component file contains the following line:

Ac Userid/newUser

In this example, the newUser data is retrieved from a source Passport. This 
data is then added to all target Passport provisioning views specified in the 
module name file.

Pre-propagate command file (optional)
The global data propagation can require some changes to the components 
before loading the new partial file on the Passport.  The changes can be 
adding components, deleting components, or setting components to a 
particular value. The on-switch provisioning add/set/delete commands can be 
specified in an input file. In the input file, one command is entered on one 
line. The pgdm tool then sends all the commands to the target Passport before 
loading the new partial file. 
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Example
delete Vncs/1

The Global Data Manager command line
Pgdm is invoked from a UNIX window. (See “Accessing UNIX” (page 30) 
for more information.)  Pgdm uses the NMS provisioning view naming 
convention (that is, UserSpecified, Key, Dated, Current, Committed, and so 
on). This convention is used to determine the provisioning view to be 
uploaded and saved.

The format of the pgdm command and the description of its parameters and 
options are as follows:

pgdm -auth <group_name> <user_id> <password> \

[-modf <module_fn>] \

[-compf <component_fn>] \

[-pcmdf <pre-propagate_fn>] \

[-logfile [log_fn] \

[-wd <working_dir>] \

[-quiet] \

[-np <number of processes>]

where:

-auth is the authentication flag. The following parameters are used to log 
in to the source and target Passports:

<passport_group_name> Mnemonic of the group to log on to.
<userId> Passport user id to log on with.
<password> Password for the userId.

-modf is the module name file flag. The following variable is the name of 
the module name file:

< module_filename> The name of the file that specifies the Passports and 
associated view filename for uploading and downloading. The filename is 
case sensitive.

-compf is the component file flag. The following variable is the name of the 
component file:
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<component_filename> The name of the file that specifies the components to 
be propagated. The filename is case-sensitive.

-pcmdf is the pre-propagate command file flag. The following variable is 
the name of the pre-propagate command filename:

<pre_propagate_filename> The name of the file that contains the on-switch 
commands to be applied to the target Passport before loading the new partial 
file.

-logfile indicates that a log file other than the default is to be used. The 
following parameter is optional:

<log_fn> The name of the log file to use if other than the default.

Note: A log file is always generated. The default is ‘$HOME/
pgdm<pid>.<yymmdd>_<hhmmss>.log’, where:
<pid> is the process id.
<yymmdd> is the date.
<hhmmss> is the time.

-wd is a flag that shows that a specified directory is used to store the default 
log file and other intermediate files.

<working_dir> The working directory name.

-quiet indicates no log file messages are generated. Error messages are 
output to stderr.

-np is a flag used to indicate the number of target Passports to be processed 
in parallel. By default, the target Passports are processed sequentially. The 
following parameter is used for processing Passports in parallel:

<number of processes> Number of target Passports to be processed in 
parallel.

Cron job
Since pgdm starts up all the session servers (cmcfun and CM), you can invoke 
the pgdm command line directly by using the UNIX cron facility.
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See 241-6001-304 Preside MDM Configuration Management for DPN 
Administrator Guide, for more  information on running a cron job.

Global Data Manager procedures
See the following sections for information on procedures you can perform 
using pgdm:

• “Propagating components” (page 220)

• “Removing components during propagation” (page 223)

• “Globally replacing attribute values” (page 223)

Propagating components
Pgdm is used to propagate global data components or to replace the attribute 
values for those components during propagation. The procedure involves the 
following four steps, which are illustrated by specific examples.

1 Create the components on a Passport. See, “Component Provisioning” 
(page 83) or on-switch provisioning capability.

2 Create a module name file (see “Module name file” (page 213)). This file 
contains one source Passport record and a number of target Passport 
records and is set up in the following format.

-source <passport_name> -uploadmode [Current |
Committed\ | Keyed <key> | Dated <date_key> |
User_specified <view_filename>]

-target <passport_1>...<passport_n> 
-uploadmode [Current | Committed | Keyed <key> |
Dated <date_key> | User_specified <view_filename>]
-downloadmode [Keyed <key> | Dated <date_key> |
User_specified <view_filename>]

3 Create a component file (see “Component file” (page 215)). This file 
contains the components that you wish to propagate. You can specify the 
component’s attribute values if they need to be changed. The file has the 
following format:

<comp_1>{/<key>}... <comp_n>{/<key>} @<attr_1> 
<value>,...,<attr_n> <value>

4 Invoke pgdm (see “The Global Data Manager command line” (page 218)) 
by using the following format:
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pgdm -auth <group_name> <user_id> <password> \
[-modf <module_fn>] \
[-compf <component_fn>] \
[-pcmdf <pre-propagate_fn>] \
[-logfile [log_fn] \
[-wd <working_dir>] \
[-quiet] \
[-np <number of processes>]

Example 1: Adding a new user for Passports in the network
Add a new user as follows:

1 Add a new user, GUEST, into a Passport view using the 
Downloadprovisioning tool. This Passport is referred to as the source 
where the new user data is obtained.

2 Create a module file. In this file, specify the source  switch (NODE1) and 
the targets. Use the uploadmode DATED for both uploading and 
downloading.

-source NODE1 -uploadmode DATED 960520

-target NODE2 NODE3 -uploadmode DATED 960520 -
downloadmode DATED 960521

3 Create a component file that contains the following line:

Ac Userid/GUEST

 Where GUEST is the <newUser> created in step 1.

4 Type the following command to capture the output messages into the 
logfile mylog:

pgdm -auth PPgroup myId myPasswd -modf modules -compf
comps -logfile mylog

5 The log output is as follows:

08:53:48 NOTE:  The Passport GDM is starting for myId (Date: 1996-06-03).
08:53:48 NOTE:  Command line: pgdm -auth PP_GROUP myId XXXX -modf modules 
-compf comps -logfile mylog
08:54:02 NOTE:  The PGDM Uploading is starting. Date: 1996-06-03.
08:54:21 NOTE:  Upload provisioning file 96052001.full.100 on EM NODE1.
08:54:25 NOTE:  The following component(s) will be propagated:
                Ac Userid/GUEST
08:54:25 NOTE:  The PGDM Uploading has completed successfully.
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******** NODER2 - Processing/Error messages ********
08:54:28 NOTE:  The PGDM Propagation is starting for NODER2. Date: 1996-
06-03.
08:54:30 NOTE:  Preparing for provisioning.
08:54:52 NOTE:  Loading file 96052001.full.470 in the edit view on EM 
NODE2.
08:55:06 NOTE:  Checking the configuration.
08:56:10 NOTE:  Saving the configuration.
08:56:33 NOTE:  Changes saved in file 96052100.full.473 on EM NODE2.
08:56:42 NOTE:  The PGDM Propagation has completed successfully.

******** NODE3 - Processing/Error messages ********
08:56:44 NOTE:  The PGDM Propagation is starting for NODE3. Date: 1996-
06-03.
08:56:46 ERROR: EM NODE3 is not accessible under group PP_GROUP
08:56:46 NOTE:  The PGDM Propagation has completed but errors were found.

******** LOG SUMMARY ********
   NODE2                         - Completed successfully.
   NODE3                         - Error found.
   08:57:45 NOTE:  Passport GDM has completed but errors
   were found.
========================================================================

Example 2: Propagating components
Propagate all Vncs components (see “Vncs hierarchy” (page 216) for the 
Vncs hierarchy) specified in the Committed view from Passport NODER10 
to NODER20 and NODER21. Use the Keyed NMS provisioning view. The 
pgdm command is as follows:

pgdm -auth <Group name> <UserId> <password> \

   -modf modules -compf vncs -logfile vncs_log

where:

modules is the name of the module name file. The file contains the 
following lines:

-source NODER10 -uploadmode COM
-target NODER20 NODER21 -uploadmode K NMS \
-downloadmode K NMS
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vncs is the name of the component file. The file contains the following line:

Vncs/*

Processing and error messages are captured in the vncs_log log file.

Removing components during propagation
The components on a target Passport can be deleted during global data 
propagation. The on-switch provisioning delete commands are specified in 
the pre-propagate command file.

1 Follow steps 1 to 3 of “Propagating components” (page 220).

2 Create a pre-propagate command file (see “Pre-propagate command file 
(optional)” (page 217)).

3 Invoke pgdm with the -pcmdf option (see “The Global Data Manager 
command line” (page 218)).

For example, Passport NODER20 and NODE21 both have Vncs/11 and 
Vncs/12, but the source Passport (NODE10) does not have these components. 
You can remove the Vncs/11 and Vncs/12 from the target’s provisioning 
view by using the command file and the -pcmdf option. This command file 
contains the following lines:

del Vncs/11

del Vncs/12

Globally replacing attribute values
You can use  pgdm to replace the attribute values for selected Passports in the 
network.

1 Create a module name file. This file contains only target Passport records 
(see “Module name file” (page 213)).

2 Create a component file. This file contains the components and attribute 
values that you need to replace (see “Component file” (page 215)).

3 Invoke pgdm (see “The Global Data Manager command line” (page 218)).
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Using HP OpenView NNM desktop

This section describes how to access Configuration tools from the HP 
OpenView NNM desktop application. In this section, you can find the 
following information:

• “About HP OpenView NNM desktop” (page 225)

• “Passport configuration tools available from HP OpenView NNM 
desktop” (page 226)

• “Accessing HP OpenView NNM desktop from MDM” (page 226)

• “Accessing Configuration tools from HP OpenView NNM desktop” 
(page 226)

• “How HP OpenView NNM desktop displays Passport device names” 
(page 229)

• “Exiting HP OpenView NNM desktop” (page 229)

About HP OpenView NNM desktop
HP OpenView NNM desktop is an optional feature of Preside Multiservice 
Data Manager (MDM) that runs on an HP OpenView platform. With this 
feature you can launch, from the HP OpenView NNM desktop, tools from the 
Configuration for Passport Devices toolset. Or, you can use the surveillance 
and configuration tools in the HP OpenView NNM desktop toolset.
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Passport configuration tools available from HP OpenView 
NNM desktop

See the following sections for information on the configuration tools that you 
can launch from HP OpenView NNM desktop:

• Nodal Provisioning. See 241-6001-610 Preside MDM Nodal 
Provisioning User Guide.

• Software Distribution and Configuration. See “Software Download and 
Configuration” (page 37).

• Service Integrity Simplification. See 241-6001-022 Preside MDM 
Network Reporting System User Guide.

• “Network Activation” (page 157).

• Passport/SNMP Devices Backup And Restore. See 241-6001-807 
Preside MDM Passport/SNMP Devices Backup and Restore User Guide.

Accessing HP OpenView NNM desktop from MDM
Access HP OpenView NNM desktop from the Preside MDM Fault menu.

Accessing Configuration tools from HP OpenView NNM 
desktop

See the following procedures for information on how to start HP OpenView 
NNM desktop and access the Configuration tools:

• “Starting HP OpenView NNM desktop” (page 226)

• “Starting tools from the Configuration menu” (page 228)

• “Starting tools from the pop-up menu” (page 228)

Starting HP OpenView NNM desktop
1 In a UNIX window start HP OpenView:

/opt/OV/bin/ovw &

The About HP OpenView window opens. Click Close to close the window 
or wait for it to close on its own.

The Root map opens, displaying the Nortel Networks symbol and the IP 
Internet symbol. These symbols indicate the state of their respective 
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networks through color. The standard HP OpenView color scheme is 
used, as shown in the HP OpenView Display Legend.

The Event Categories window opens. It may display a status message at 
the bottom, stating the percentage of the trapd.log file that has been 
loaded.

2 To view your network on the Root map, double-click the Nortel Networks 
symbol.

The Nortel Networks submap opens and displays the devices in your 
network. The color of the icon indicates the states of the network devices. 
For Passport nodes, the icons let you distinguish between Passport 
nodes belonging to the 6000, 7000 and 15000 series. 

• Icons depicting Passport legacy and 6000 nodes contains P6 or 6.

• Icons depicting Passport 7000 nodes contains P7 or 7.

• Icons depicting Passport 15000 nodes contains P15 or 15.

• Icons depicting unknown Passport nodes contain P? or ?. Although 
the devices are in the database, it has not yet been configured to 
identify these devices. To change these icons to identify the Passport 
type, use the Make Configuration Data File (MCDF) utility. See 
241-6001-015 Preside MDM Network Model Administrator Guide for 
additional information on the MCDF utility.
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DPN devices are identified by a D or O.

3 Access the Configuration for Passport tools. There are two methods: see 
“Starting tools from the Configuration menu” (page 228) or “Starting tools 
from the pop-up menu” (page 228).

Starting tools from the Configuration menu
1 At the OVW submap, select a Passport device by clicking the left mouse 

button.

2 Select Passport from the Configuration menu.

3 Select the tool that you want to open. 

Starting tools from the pop-up menu
1 At the OVW submap, select a Passport node by clicking the left mouse 

button.
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2 Press the mouse menu button to display the node pop-up menu, and 
select Passport Configuration.

3 Select the tool that you want to open. 

How HP OpenView NNM desktop displays Passport device 
names

Passport device names are displayed on the Nortel Networks submap as EM/
<device_name>. For example, EM/EMDEV1

Note: The device name that appears on the Nortel Networks submap is 
the name with which the device is configured. Lowercase letters in a 
configured name appear as uppercase letters in the submap display.

Exiting HP OpenView NNM desktop
1 From the Root map or any submap, select Map -> Exit.

An OpenView Windows warning dialog opens.

2 To continue the exit process, click OK.

The dialog closes along with the Event Categories window and any open 
submaps.
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